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Benim iman dolu gégsiim gibi serhaddim var.
Ulusun, korkma! Nasil boyle bir iman1 bogar,
Medeniyyet dedigin tek disi kalmis canavar?

Arkadas, yurduma alg¢aklart ugratma sakin;
Siper et govdeni, dursun bu hayasizca akin.
Dogacaktir sana va’dettigi giinler Hakk’1n;

Kim bilir, belki yarm, belki yarindan da yakin.
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Her cerihamdan [1ahi, bosanip kanl yasim,
Fiskirir rub-1 miicerret gibi yerden na’sim;
O zaman yiikselerek arsa deger belki basim.

Dalgalan sen de safaklar gibi ey sanli hilal!
Olsun artik dokiilen kanlarimin hepsi helal.
Ebediyyen sana yok, irkima yok izmihlal;
Hakkidir hiir yasamis bayragimin hiirriyyet;
Hakkidir Hakk’a tapan milletimin istiklal!

Mehmet Akif Ersoy



GENCLIGE HITABE

Ey Turk gengligi! Birinci vazifen, Tirk istiklalini, Tirk Cumhuriyetint,
ilelebet muhafaza ve miidafaa etmektir.

Mevcudiyetinin ve istikbalinin yegane temeli budur. Bu temel, senin en
kiymetli hazinendir. Istikbalde dahi, seni bu hazineden mahrum etmek
isteyecek dahili ve harici bedhahlarin olacaktir. Bir giin, istiklal ve cumhuriyeti
midafaa mecburiyetine diisersen, vazifeye atilmak i¢in, i¢inde bulunacagin
vaziyetin imkan ve seraitini diisinmeyeceksin! Bu imkan ve serait, c¢ok
namiisait bir mahiyette tezahiir edebilir. Istiklal ve cumhuriyetine kastedecek
dismanlar, biitin diinyada emsali goriilmemis bir galibiyetin miimessili
olabilirler. Cebren ve hile ile aziz vatanin biitiin kaleler1 zapt edilmis, biitiin
tersanelerine girilmis, biitiin ordulart dagitilmis ve memleketin her kosesi bilfiil
1sgal edilmis olabilir. Biitiin bu seraitten daha elim ve daha vahim olmak tizere,
memleketin dahilinde iktidara sahip olanlar gaflet ve dalalet ve hattad hiyanet
iginde bulunabilirler. Hatta bu iktidar sahipleri sahsi menfaatlerini,
mustevlilerin siyasi emelleriyle tevhit edebilirler. Millet, fakr u zaruret i¢inde
harap ve bitap diismiis olabilir.

Ey Tiirk istikbalinin evladi! iste, bu ahval ve serait i¢inde dahi vazifen,
Turk 1stiklal ve cumhuriyetini  kurtarmaktir.  Muhta¢ oldugun kudret,
damarlarindaki asil kanda mevcuttur.

Mustafa Kemal Atatiirk
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Etkilesimli kitap, video, ses, animasyon,
uygulama, oyun, soru vb. ilave kaynaklara
ulasabilecediniz karekodu gésterir.

Ogrenme biriminin
numarasini gésterir.

. Ogrenme biriminin
- kavramlarini gésteri

¢ Derse baslamadan
. énce yapilacak olan ..
hazirliklari

gosterir.

- Ogrenme biriminin
i bélimlerini gésterir.

i Ogrenme biriminin

. adini gosterir.

gésterir.

' Sayfa numarasini
; gésterir.

Bu ders materyalinde 6l¢u birimlerinin uluslararasi kisaltmalari kullanilmistir.

Konu basligini
gosterir.




¢ Konu icinde dikkat - Odrenme biriminin -
- edilmesi gereken . adini gbsterir.
yerleri :
gdsterir.

{ Etkilesimli kitap,

A Uygulama  video, ses, animasyon, |
 faaliyetlerini gésterir. . uygulama, oyun,
. soru vb. kaynaklara
- ulasabileceginiz link ve |
. karekodu gésterir.

Konu igindeki
6grenci
calismalarini

gosterir.

Olcme ve '
degerlendirme

sayfasini :

gosterir.

Bu ders materyalinde 6l¢i birimlerinin uluslararasi kisaltmalari kullanilmistir.




+ KAVRAMLAR
Teknik Resim, Norm Yazi
Uc Boyutlu Gortinus

IzdUstm, Perspekif



- OGRENME BiRiMi BOLUMLERI
Temel Geometrik Cizimler

IzdUstm Gorinuslerini Cizme ve Olgeklendirme




1. TEMEL TEKNiK RESIiM

g Hazirhk Caligmalar: |

1. Teknik resim kavramini ve norm yazi standartlarini arastiriniz.

2. izdlsiim ve perspektif kavramlarini arastiriniz.

1.1. Temel Geometrik Cizimler

1.1.1. Cizgi ve Norm Yazi

Teknik resim gizimleri; teknik resim standartlarina gore olusturulan gizgiler, geometrik sekiller ve
yazilardan olusmaktadir. Bu ¢izimler yapilirken kullanilan gesitli ¢izim arag gerecleri vardir.

1.1.1.1. Teknik Resimde Kullanilan Arag Geregler

Cizim Masasi: Resim cizilecek kagidin tutturuldugu masadir. Cizim masasinin koseleri 90 derece,

kenarlari ve ylzeyi plrizsiz olmalidir. Bu masalar genellikle egimi ayarlanabilir sekilde Gretilir.

Gorsel 1.1: Teknik resim masalari

T Cetveli: Teknik resimde en ¢ok kullanilan araglardan biridir. T cetveli genellikle paralel, egik ve diiz

cizgilerin cizilmesinde kullanilir. Gonyelerle yapilacak cizimlerde gényelere kilavuzluk yapar.

Gorsel 1.2: T cetveli

Gonyeler: Genellikle T cetveli tizerinde kaydirilarak dikey ve egik gizgiler gcizmek ve agi olugturmak igin
kullanilir. Standart goényelerin agilari 45°x45°x90° ve 30°x60°x90°dir.
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TEMEL TEKNiK RESIM

iletki (Agilger): Acilarin dlgiilmesi ve gdnyelerle cizilmesi imkansiz agilarin isaretlenmesi igin kullanilan

Olgii Cetvelleri: Uzunluklarin élgiilmesinde kullanilir.

bir aractir. iletkinin 0°-180°lik ve 0°-360°lik olmak iizere iki ¢esidi mevcuttur.

Gorsel 1.3: Gonye, dl¢ii cetveli, agidlger
Pergel: Daire ¢izimi, yay cizimi, bir 6lcinin bir yerden baska bir yere tasinmasi ve belli bir 6l¢linin birkag
defa tekrarlanarak isaretlenmesi icin kullanihr.
Sablonlar: Cesitli hazir sekillerin ¢izilebildigi araglardir. Daire ve yay sablonu, yazi sablonu, elips sablonu
ve sembol sablonlari seklinde gesitleri vardir.

Gorsel 1.4: Daire sablonu
Kalemler: Kursun kalemler, takma uglu kalemler ve teknik gizim kalemleri olmak Uzere gesitleri vardir.

e Kursun kalemler: Teknik resmin gizilmesinde ve yazilarinin yazilmasinda kullanilan siyah kursun
kalemler, sertlik derecelerine gore lice ayrilir. Kursun kalemlerin sertlik dereceleri, tzerlerine yazilan

harf ve rakamlar ile belirtilir. Bu kalemler sert, yumusak ve orta sertlikte olmak tzere gruplandirihir.

0 Sert Kalemler: ingilizce hard (sert) kelimesinin ilk harfi ile ifade edilir. Kursun kalemlerin sertlik
derecesini ifade eden rakamlar harfin soluna konur (2H, 3H, 4H).

0 Yumusak Kalemler: ingilizce black (siyah) kelimesinin ilk harfi ile ifade edilir. Harfin soluna konulan
rakamlar buyudikce kalemin yumusakligi artar (2B, 3B, 4B...).

0 Orta Sertlikte Kalemler: HB ve ingilizce firm (dolgun) kelimesinin ilk harfi ile ifade edilir.

1. OGRENME BIRIMi ‘17



e Takma Uglu (Versatil) Kalemler: 0,3 - 0,5 - 0,7 - 0,9 mm kalinhgindaki grafit uclarin bir boru icinden
gecirilmesiyle olusturulan kalemlerdir. Cizimin 6zelligine gore uglari B, HB ve F sertliginde takma uglu
kalemler tercih edilmelidir.

e Teknik Cizim Kalemleri: Genellikle proje galismalarinda bu kalemlere 6zel mirekkep ile kullanilan,
aydinger kagida ayni kalinlkta yazip cizebilen kalemlerdir.

Gorsel 1.5: Teknik gizim kalem takimi
1.1.1.2. Standart Kagit Olgiileri

Teknik resimde kullanilan kagitlar, cizilecek resmin cinsine ve kullanilacagi yere gore secilir. Genel olarak
teknik resimde kullanilan kagitlar bes gruba ayrilr.

e Saydam Olmayan Resim Kagidi: Beyaz renkte, sert ve yirtilmaya karsi dayanikh kagitlardir. Kursun
kalemle iyi ¢izim yapilmasina imkan veren, iz birakmadan silinebilen kagitlardir.

e Aydinger: Bu kagitlara genellikle kopyasi ¢ikarilarak ¢ogaltilacak resimler gizilir. Bu ylzden aydinger
kagitlari, alttaki resmi en ince ayrintisina kadar gosterecek saydamliktadir.

e Ozalit Kagidi: Aydingere cizilmis resimlerin en ucuz ¢ogaltma metodu, ozalit kagidina cikarilan
kopyalardir. Ozalit kagitlari, bir yliziine 1s18a karsi hassas 6zel madde siirlilmis kagitlardir.

e Fotokopi Kagitlari: Teknik resimler fotokopileri alinarak da g¢ogaltilabilir. Fotokopinin ozalit kopyaya
Gstlinltga, resimlerin aydinger kagidina cizilme zorunlulugunun olmamasidir.

e Milimetrik Kagit: Uzerlerine herhangi bir renkte milimetrik taksimat basilmis kagitlardir. Milimetrik

kagitlar genel olarak grafiklerin veya krokilerin gizilmesinde kullanilir.

Teknik resimde kullanilan standart kagit 6l¢lisu, A serisi kagitlardir. Resim kagitlari, tam olgctsinde veya
resim masalarina yapistirma payi ilaveli olarak kesilir.
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TEMEL TEKNiK RESIM

Gorsel 1.6: A serisi kagit él¢giileri
1.1.1.3. Cizgi Cesitleri ve Cizgilerin Kullanildigi Yerler

Bir noktadan baslayip noktanin yiritilmesiile olusan, uzunlugu belli olan bigime gizgi adi verilir. Cizgiler,
teknik resmin ayrilmaz unsurlaridir. Teknik resmin dogru okunmasi igin ¢izgilerin dogru okunmasi gereklidir.

Makine pargalarinin ve endustriyel gizimlerin kagit Gzerindeki anlatimi gesitli ¢izgilerle olusturulur.
Teknik resimde kullanilan cizgilere standart gizgiler denir.

Tablo 1.1: Cizgi Cesitleri ve Cizgilerin Kullanildigi Yerler

Goriinlimii Tiirli ve Kullanim Yeri
Surekli Kalin Cizgi (0,5 mm)

e  Gorunen Kenarlar

e  Gorinen Gevreler

e  Vida Sonu Cizgisi

Siirekli ince Cizgi (0,25 mm)
o Olgli Cizgileri
e ¢ Sinir Gizgileri
e  Kesit Taramalari

W Siirekli ince Serbest El Cizgisi (0,25 mm)
[

Bolgesel Kesit Siniri
ince Kesik Cizgi (0,25 mm)

e  Gorinmeyen Kenarlar ve Cevreler
Kalin Kesik Cizgi (0,5 mm)

e Islenmis Yiizey Sinirlarinin Gésterilmesi

Noktali Kesik ince Cizgi (0,25 mm)
e  Daire ve Yay Eksenleri

Noktali Kesik Kalin Cizgi (0,5 mm)

o Ozelislemli Yiizeylerin Sinirlarinin Gosterilmesi
iki Noktali Kesik Cizgi (0,25 mm)

e  Hareketli Pargalarin Sinir Konumlari

e Agirhk Merkezi Cizgileri
e Komsu Pargalarin Cevreleri

Sira Sizde 1

Tablo 1.1'de verilen gizgi gesitlerini teknik resim defterinize sayfa kenar gizgilerinin
. 1 cm uzagindan baslayip 1 cm uzaginda bitirerek lger tane giziniz.
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1.1.1.4. Standart Yazi Tipleri ve Norm Yazi

Teknik resimde yazilar, karisikhgl 6nlemek icin Tirk Standartlar Enstitlisi tarafindan yazi tipi A ve yaz
tipi B olmak Uzere iki ayri standarda baglanmistir. Bu iki yazi tipi arasindaki fark, yazi kalinhgidir. A tipi yaz,
B yazi tipine gore incedir. Teknik resimde B yazi tipi tercih edilir. Yazi ayrica teknik resimde bigimlerine gére
dik norm yazi ve egik norm yazi olmak tzere ikiye ayrilr.

Dik norm yazilar, insaat ve mimari teknik resminde kullanilir. Harfler ve rakamlar, satir ¢izgisine dik yazilir.

Gorsel 1.7: Dik norm yazi

Sira Sizde 2

Gorsel 1.7’de verilen alfabe, rakam ve sembolleri teknik resim defterinize dik norm
yazi kurallarina uygun olarak yaziniz.
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Egik norm yazilar; makine, elektrik ve elektronik teknik resminde kullanilir. Harfler ve rakamlar, satir
gizgisine 75° saga egik olacak sekilde yazilr.

Gorsel 1.8: Egik norm yazi

Sira Sizde 3

istiklal Marsi metnini teknik resim defterinize egik norm yazi kurallarina uygun olarak
yaziniz.

—————

1.1.2. Temel Geometrik Cizimler

1.1.2.1. Dogru Cizimi

Cetvel yardimiyla belirlenen uzunlukta bir dogru pargasi ¢izilir ve dogru pargasinin ug noktalari A ve B
olarak adlandirilir. Gonye kullanilarak kaydirma yontemi ile AB dogru pargasina paralel dogrular gizilebilir.

Gorsel 1.9: AB dogru pargasi
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Uygulama: Paralel Cizgiler Cizme

Paralel cizgi cizmek icin asagidaki yonergeleri uygulayiniz.

e 30°x60°x90°lik ve 45°x45°x90°lik gonyeleriniziteknik resim defterinizin calisma sayfasina Gorsel 1.10’daki
gibi yerlestiriniz.

e Gonyelerinizi sabit tutarak 45°x45°x90°lik gényenizin Ust kenari ile bir gizgi ¢iziniz.

Gorsel 1.10: ilk dogruyu cizme

e 45°%45°x90°lik gbnyenizi diger gonyenizi sabit tutarak asagi veya yukariya kaydirip tekrar bir ¢izgi ¢iziniz.

Gorsel 1.11: ik dogruya paralel dogruyu cizme

e Son islemi tekrarlayarak istediginiz kadar paralel gizgi ¢iziniz. Bu islemi diger ¢izgi cesitleriyle de
tekrarlayiniz.

Gorsel 1.12: Cesitli tiirlerde paralel dogrular ¢izme
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Uygulama: Dogrunun Uzerindeki Herhangi Bir Noktadan Dikme Cikma

Dogrunun Uzerindeki herhangi bir noktadan dikme ¢ikmak icin asagidaki yonergeleri uygulayiniz.
e Teknik resim defterinize AB dogrusunu giziniz.

e O noktasindan dogruya A ve B yoniinde iki yay giziniz, bu noktalari C ve D olarak adlandiriniz.

Gorsel 1.13: Dogru lizerinde C ve D noktalarini bulma

e Cve D noktalari merkez olmak tizere dogru Uizerinde kesisecek sekilde iki yay giziniz ve kesisen noktay!
E olarak adlandiriniz.

Gorsel 1.14: E noktasini bulma

e E noktasliile O noktasini bir dogru ile birlestiriniz. Boylece AB dogru pargasina dikme ¢ikmis olacaksiniz.

Gorsel 1.15: E ve O noktasini birlestirme
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Dik a¢i olusturmak icin asagidaki ydnergeleri uygulayiniz.

e Teknik resim defterine BA dogrusunu ciziniz.
e A noktasi merkez olacak sekilde pergeli istenilen degerde acarak AB dogrusunu kesen bir yay ciziniz ve

dogruyu kesen noktayi C olarak adlandiriniz.

Gorsel 1.16: Dogru lizerinde C noktasini bulma

e Cmerkezli dnceki yayi kesecek bir yay ciziniz ve yayi kesen noktayi D olarak adlandiriniz.

Gorsel 1.17: Yay lzerinde D noktasini bulma

e Cve D noktasindan gegecek sekilde bir dogru ¢iziniz.
e D noktasini merkez alarak cizilen dogruyu kesecek sekilde bir yay ¢iziniz ve kesisen noktayi E olarak

adlandiriniz.

Gorsel 1.18: D ve E noktalarini bulma
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e Ave E noktalarini birlegtiriniz.

Gorsel 1.19: A ve E noktalarinin birlestirilmesi

Uygulama: Dogru Pargasini Dort Esit Pargaya Bolme

Dogru pargasini dort esit parcaya bélmek icin asagidaki yonergeleri uygulayiniz.
e Teknik resim defterine AB dogrusu giziniz.
e AB dogru parcasinin altinda veya Ustlinde olacak sekilde, istenilen agida yardimci bir x dogrusu ciziniz.

Gorsel 1.20: Yardimci x dogrusunu ¢izme

e xdogrusu Uzerine pergel yardimiyla dort yay kadar isaret koyunuz.

Gorsel 1.21: x dogrusu lizerine esit aralikli yay ¢izimi

e saretlenen Cile B noktasini birlestiriniz.

Gorsel 1.22: C ve B noktalarinin birlestirilmesi

1. OGRENME BIRIMi Was



e GoOnye yardimiyla CB dogru parcasina paralel dogrular cizerek AB dogrusunu dort esit parcaya boliniz.

Gorsel 1.23: CB dogru pargasina paralel gizgilerin gizimi

Sira Sizde 4

1.1.2.2. Cokgenlerin Cizimi

Uygulama: Daire igine Eskenar Uggen Cizme

Daire icine eskenar liggen cizmek icin asagidaki yonergeleri uygulayiniz.
Teknik resim defterinize ilk 5nce O merkezli, birbirine dik iki eksen ¢iziniz. Pergel yardimiyla da O merkezli
bir daire giziniz.

Dairenin eksen cizgilerini kestigi noktalari A, B, C ve D olarak adlandiriniz.

Gorsel 1.24: Koordinat diizlemi lizerine daire ¢izimi

¢ D noktasini merkez alarak O noktasindan gececek ve daireyi kesecek sekilde bir yay ciziniz.

Yayin daireyi kestigi noktalari E ve F olarak adlandiriniz. E ve F noktalarini cetvel yardimiyla birlestiriniz.

Gorsel 1.25: E ve F noktalarini bulma ve birlestirme
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e Cetvel yardimiyla B ve E ile B ve F noktalarini birlestiriniz. Bylece eskenar tiggen olusturacaksiniz.

Gorsel 1.26: B ve E ile B ve F noktalarini birlestirme

Uygulama: Daire igine Eskenar Dértgen Cizme

Daire icine eskenar dortgen gizmek icin asagidaki yonergeleri uygulayiniz.

e Teknik resim defterinize ilk nce O merkezli birbirine dik iki eksen ¢iziniz. Pergel yardimiyla da O merkezli
bir daire giziniz.

e Dairenin eksen cizgilerini kestigi noktalari A, B, C ve D olarak adlandiriniz.

e Pergeli B-C araligi kadar aginiz.

e Bve Cnoktalarindan dairenin disina birer yay giziniz.

e Yaylarin birbirini kestigi noktayi E olarak adlandiriniz.

¢ Ave B noktalarindan dairenin disina birer yay ciziniz.

e Yaylarin birbirini kestigi noktayi F olarak adlandiriniz.

Gorsel 1.27: E ve F noktalarini bulma

e Eve O noktalarindan gececek, daire kenarlarini kesecek bir dogru giziniz.
¢ Fve O noktalarindan gegecek, daire kenarlarini kesecek bir dogru daha ciziniz.
e Dogrularin daireleyi kestigi noktalari k, I, m, n olarak adlandiriniz.

Gorsel 1.28: k, |, m ve n noktalarini bulma
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e k-l, I-m, m-n ve n-k noktalarini birlestirdiginizde eskenar dortgen ortaya ¢ikacaktir.

Gorsel 1.29: Eskenar dértgeni olusturma

Uygulama: Daire icine Eskenar Besgen Cizme

Daire icine eskenar besgen gizmek icin asagidaki yonergeleri uygulayiniz.

e Teknik resim defterinize birbirine dik gizilen iki eksen lizerine istenilen yarigapta pergel agarak O merkezli
bir daire ciziniz.

¢ Dairenin eksen lizerinde kesistigi noktalari A, B, C, D olarak adlandiriniz.

e Cnoktasini merkez alarak O noktasindan gecgecek ve daireyi kesecek bir yay ¢iziniz.

* Yayin daireyi kestigi noktalari E ve F olarak adlandiriniz.

e E ve F noktalarini birlestiren bir dogru ciziniz.

e Dogrunun ekseni kestigi noktayi S olarak adlandiriniz.

Gorsel 1.30: £ ve F noktalarini bulma ve birlestirme

e Pergeli S-B aralig1 kadar agarak S merkezli bir yay ¢iziniz.
e Yayin ekseni kestigi noktayi T olarak adlandiriniz.

e Pergeli T-B araligi kadar agarak B merkezli bir yay giziniz.
* Yayin daireyi kestigi noktalari | ve K olarak adlandiriniz.

Gorsel 1.31: T ve K noktalarini bulma
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e B, I, M, N ve K noktalarini birlestirdiginizde eskenar bir besgen ortaya ¢ikacaktir.

e | ve K merkezli, daireyi kesen birer yay c¢iziniz.
e Yaylarin daireyi kestigi noktalari M ve N olarak adlandiriniz.

Gorsel 1.32: M ile N noktalarini bulma ve eskenar besgeni olusturma

Uygulama: Daire igine Eskenar Altigen Gizme

Daire icine eskenar altigen cizmek icin asagidaki yonergeleri uygulayiniz.

Teknik resim defterinize birbirine dik ¢izilen iki eksen lzerine pergel acarak istenilen yaricapta O merkezli
bir daire giziniz.
e Dairenin eksen lizerinde kesistigi noktalari A, B, C, D olarak adlandiriniz.

C noktasi merkezli, O noktasindan gececek ve daireyi kesecek bir yay ciziniz.

Yayin daireyi kestigi noktalari E ve F olarak adlandiriniz.
¢ A noktasi merkezli, O noktasindan gececek ve daireyi kesecek bir yay giziniz.

Yayin daireyi kestigi noktalari G ve H olarak adlandiriniz.

Gorsel 1.33: £, F, G ve H noktalarini bulma

e G, A H, E, C ve F noktalarini cetvel yardimiyla birlestirdiginizde daire icinde diizglin bir altigen elde
edeceksiniz.

Gorsel 1.34: Diizgtin altigeni ¢izme
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1.2. izdiisiim Goriiniislerini Cizme ve Ol¢eklendirme

1.2.1. izdiisiim Tanimi ve Siniflandiriimasi

izdiisim, cismin bir diizlem Gzerine ¢izilmis sekli veya izdiisiim diizlemine diisen gériintisiidir. Ornegin,
bir 151k kaynagindan (odak noktasi) ¢ikan isinlarla (izdlsim 1sinlari) bir cismin duvara disen gorintisa bir
izdUsumddr.
iki cesit izdiistim vardir.
e Merkezi (Konik) izdiisiim: Isik kaynaginin yakin mesafede olmasi, cismin boyutlarinin kiigiilerek
veya blylyerek izdlisim dizlemine dismesiyle olusan izdlisimdur. Bu izdlisim; mimari, reklam ve
dekorasyon teknik resimlerinin cizimlerinde kullanilir.

Gorsel 1.35: Konik izdiisiim

e Paralel izdiisiim: Isik kaynaginin sonsuzda olmasi, cismin boyutlarinin izdiisiim diizlemine biiyiime veya
kicillme gostermeden diismesiyle elde edilen izdistimdur. Paralel izdistim, egik ve dik izdlisim olmak
Uzere ikiye ayrilir.

Gorsel 1.36: Paralel izdiisiim
1.2.2. izdiisiim Diizlemleri

Uretimi yapilacak bir parcanin sadece bir yiizeyinin goriintiisii o parcayl tanimlamaya yetmez. Cismin
tek yonden goriinisii o cisim hakkinda yeterli bilgiyi vermez. Bu nedenle cisimlerin goérintileri birden fazla
izdlisim diizlemine dusirilir. Uzerine izdiisim cizilecek olan diizlemler birbirine bitisik ve dik kabul edilir.
Diedri, temel izdlsiim dizlemlerini bir arada bulunduran kapali sekildir.
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Uygulama: Noktanin izdiisiimii

Uzaydaki bir noktanin diizlem ylizeylerine dik gelen isinlarinin degme noktalari, o noktanin izdlisimun
verir. Bir a noktasinin uzaydaki yerini belirlemek icin aralik, kot ve uzaklk degerleri olmak tzere li¢ elemana
ihtiyag vardir. Teknik resimde bir a noktasinin izdisimu ¢ikarilirken Aralik (noktanin profil izdlisiimlne
olan mesafesi), Kot (noktanin yatay izdisimine olan mesafesi), Uzaklik (noktanin alin izdistimiine olan
mesafesi) degerleri bilinmelidir.

Diedri Gzerinde bulunan izdlisim dizlemleri sunlardir:

1. Alin izdiisiim diizlemi: Onden goriiniim igin kullanilir.

2. Yatay izdiisiim diizlemi: Yandan goriinim igin kullanilir.

3. Profil izdiisiim diizlemi: Ustten gériiniim igin kullanilir.

Gorsel 1.37: Diedri gizimi
a noktasinin (Aralik: 3, Kot: 5, Uzaklik: 5) izdisiimlerini bulmak icin asagidaki yonergeleri uygulayiniz.
e Teknik resim defterinize bos bir koordinat diizlemi giziniz.

e Kot: 5 ve Aralik: 3 degerlerine bakarak alin bolgesine y ekseni kot, x ekseni aralik olacak sekilde noktay!

yerlestiriniz.

Gorsel 1.38: Noktanin alin izdiisiim diizlemindeki gértintiisii
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e Kot: 5 ve Uzaklik: 5 degerlerine bakarak profil bolgesine y ekseni kot, x ekseni uzaklik olacak sekilde
noktay! yerlestiriniz.

Gorsel 1.39: Noktanin profil izdiisiim diizlemindeki goriintiisi

e Alin bolgesindeki a noktasinin x eksenini kestigi cizgiyi yatay bolgesine kadar uzatiniz.

e Pergeli profil bolgesindeki a noktasinin uzaklik degeri kadar acarak y eksenine dek O merkezli bir yay
Giziniz.

e Yayin kestigi noktadan kesik cizgi ile yatay bolgesine bir dogru ciziniz. iki dogrunun yatay bélgesinde
kesistigi nokta, ¢izdiginiz noktanin son izdistimuddr.

Gorsel 1.40: Noktanin yatay izdiistiim diizlemindeki gériintiisi

Uzayda iki nokta birlestirildiginde bir dogru pargasi meydana gelir. Dogru pargasinin u¢ noktalarina ait
izdUstumleri ayri ayri cizilip birlestirilirse dogrunun izdtisimleri elde edilir.

iki ug noktasi a (Aralik: 3, Kot: 5, Uzaklik: 5) ve b (Aralik: 5, Kot: 2, Uzaklik: 6) olan dogru pargasinin
izdUstmlerini bulmak icin asagidaki yonergeleri uygulayiniz.
e Teknik resim defterinize bos bir koordinat diizlemi giziniz.

e ave b noktasinin kot ve aralik degerlerine bakarak alin bdlgesine iki noktayi yerlestirip birlestiriniz.
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Gorsel 1.41: Dogru pargasinin alin izdiisiim diizlemindeki gériintisi

e ave b noktasinin kot ve uzaklik degerlerine bakarak profil bélgesine iki noktayi yerlestirip birlestiriniz.

Gorsel 1.42: Dogru pargasinin profil izdiisiim diizlemindeki gériintiisii

e Alin bolgesindeki a ve b noktasinin x eksenini kestigi gizgileri yatay bolgesine kadar uzatiniz.

e Pergeli profil bolgesindeki a ve b noktalarinin uzaklik degeri kadar acarak y eksenine kadar O merkezli
yaylar ¢iziniz.

e Yaylarin kestigi noktalardan kesik cizgi ile yatay bélgesine iki dogru ciziniz. iki dogrunun yatay bélgesinde
kesistigi noktalar, a ve b noktasinin son izdtsimudur.

e Yataydaolusan ave b noktalarini birlestirdiginizde ab dogru parcasinin son izdisimiind olusturacaksiniz.

Gorsel 1.43: Dogru pargasinin yatay izdiisiim diizlemindeki gériintiisii
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Uygulama: Diizlemin izdiisiimii

Uzayda bulunan bir dogru pargasinin yon degistirmeden ve kendi dogrultusunda olmayan hareketiyle
meydana getirdigi ylzeylere diizlem denir. Dizlemler uzayda temel izdislim dizlemlerine gore cesitli
konumlarda bulunur.

Ug kdse noktasi a (Aralik: 3, Kot: 5, Uzaklik: 5), b (Aralik: 5, Kot: 2, Uzaklik: 6) ve c (Aralik: 1, Kot: 2, Uzaklik:
4) olan dizlemin izdistmlerini bulmak icin asagidaki yonergeleri uygulayiniz.

e Teknik resim defterinize bos bir koordinat diizlemi giziniz.
e 3, b ve ¢ noktalarinin kot ve aralik degerlerine bakarak alin bolgesine bu li¢ noktayi yerlestirip abc
dizlemini olugturunuz.

Gorsel 1.44: Diizlemin alin izdiisiim diizlemindeki gériintiisii

e 3, b ve c noktasinin kot ve uzakhk degerlerine bakarak profil bolgesine bu U¢ noktayi yerlestirip abc

dizleminin profil izdisimini olusturunuz.

Gorsel 1.45: Diizlemin profil izdiisiim diizlemindeki gériintiisi

e Alin bolgesindeki a, b ve c noktasinin x eksenini kestigi cizgileri yatay bolgesine kadar uzatiniz.

e Pergeli profil bolgesindeki a, b ve c noktalarinin uzakhk degeri kadar aginiz. Y eksenine kadar O merkezli
yaylar giziniz.

e Yaylarin kestigi noktalardan kesik ¢izgi ile yatay bdlgesine birer dogru ciziniz. U¢ dogrunun yatay

bolgesinde kesistigi noktalar, a, b ve c noktalarinin son izdislimleridir.
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Gorsel 1.46: Diizlemin profil izdiisiim diizlemindeki goriintiisii

Sira Sizde 5 |
Uc noktalarinin degerleri a (Aralik: 4, Kot: 4, Uzakhk: 3), b (Aralik: 4, Kot: 1, Uzaklik: 3),

c (Aralik: 1, Kot: 1, Uzaklk: 1) ve d (Aralik: 1, Kot: 4, Uzaklik: 1) olan abcd diizleminin
izdlslimlerini koordinat diizlemi lizerine giziniz.

1.2.3. Goriiniis Cikarma

Temel izdUsim dizlemlerine (alin, profil ve yatay), dik izdlsim yontemiyle cizilen izdlisimlere goriiniis

adi verilir. Temel izdlUisim diizlemlerine parcalarin gériintslerinin gizilmesine de goriiniis ¢ikarma adi verilir.
Her parcanin yikseklik, genislik ve derinlik olmak lizere tg¢ boyutu vardir. Bir parganin gorinisleri
cizilmeden Once gorinUslerin isimleri ve konumlari belirlenir. Parcaya bakarak parca boyutlar ve

gorinuslerin birbirleriyle iliskileri bulunur. Gériintslerde delikler veya kesik cizgiler (gériinmeyen kisimlar)
varsa ifade ettikleri yerler belirlenerek inceleme tamamlanir.

Gorsel 1.47: Par¢anin énden, listten ve yandan gériiniisi

Gorlinlsler diizleme yerlestirilirken her bir gériintsiin diizlem eksenlerine uzakliklari esit
1
olmalidir.
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Gorsel 1.48: Gériintslerin diedri lizerine yerlestirilmesi

Uygulama: Perspektifi Verilen Parganin Ug Goriiniisiinii Koordinat Diizlemine Cikarma

Perspektifi verilen parganin li¢ gérinisini koordinat dizlemine ¢ikarmak icin asagidaki yonergeleri
uygulayiniz.

Gorsel 1.49: Ug gériiniisii gizilecek parca

e Koordinat diizlemini giziniz ve cismi inceleyiniz.

e Parcanin 6n, yan ve Ust gérintsinin nasil olabilecegini diistiniip bos bir yere kabaca cizerek oranli bir
sekilde olgllerini planlayiniz.

e Kenarlar igin ince ¢izgi, gériinmeyen kenarlar igin ince kesik ¢izgi ve eksenler igin noktali ince kesik gizgi
kullaniniz.

e Parcganin gorlinlisiintin dizgin yerlestirilmesi icin y ve x ekseninde bulunan esit araliklari kullanarak
orantili bir sekilde tasima cizgileri ciziniz.

e Koordinat diizlemi Uzerine parganin 6n goriinlsini ¢iziniz.

36. 1. OGRENME BIRIMi



TEMEL TEKNiK RESIM

Gorsel 1.50: Parganin 6n gériiniistiniin diedri tizerine yerlestirilmesi

e Parganin yan gorliinlsini koordinat diizlemine yerlestirmek icin her dogrunun ug¢ noktalarinin
izdUstmlerini profil bolgesinde bulunuz.

e Tasima cizgilerinizi profil bolgesine uzatarak parganin yan gorindsind ciziniz.

Gorsel 1.51: Parcanin yan goriintsiiniin diedri lizerine yerlestirilmesi

Goriinugler ile eksenler arasinda 1 birim bosluk birakmayi unutmayiniz. Eksenlerden
cizdiginiz tasima gizgilerini kolayca silinebilecek sekilde hafif giziniz. !
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e Parganin st gérinisini koordinat diizleminde yerlestiriniz.

Gorsel 1.52: Parganin ist gériiniisiiniin diedri lizerine yerlestirilmesi

e Tasima cizgilerinizi dikkatli bir sekilde siliniz.

Gorsel 1.53: Goriintislerin son gérinimi
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Sira Sizde 6

Asagida perspektifi verilen parganin gorinUslerini teknik resim kurallarina goére
koordinat diizlemi lizerine giziniz.

Gorsel 1.54: Gortindis ¢ikarilacak parganin perspektifi

1.2.4. Olgeklendirme ve Olgekler

istenilen pargalarin yapimi icin gerekli élciilerin belirli kurallara gére parca veya goriinislerin {izerine
yazilmasi islemine 6lgeklendirme adi verilir.

Teknik resim kurallarina gore ¢izilmis parcanin goriintsleri sadece parcanin sekli hakkinda bilgi verebilir.
Bu nedenle parganin boyutlarinin olglilerine ihtiyag vardir. Ayri ayri yapilan pargalar birlestirildiginde
sorunsuz ¢alismalidir. Bu pargalarin Uretimi ancak eksiksiz ve kurallara uygun olgilendirilmis gizimlerle
mumkinddar.

Teknik resmi cizilen parcanin resim lzerindeki ¢izim Ol¢lsinin o parganin gercek 6lclsline oranina
olgek adi verilir.

Gergek olgek, kigliltme 6lgegi ve buyiltme 6lgcegi olmak lizere (g tiir 6lgek vardir.

o Gergek Olgek: Parcanin gergek 6lciileri ile yapilan dlceklendirme cesididir. Olcek 1:1 olarak belirtilir.
e Kiigiiltme Olgegi: Parcanin dlcilerinin kiiciltiilerek cizildigi 6lgeklendirme cesididir. 1:10, 1:20, 1:30 ...
olarak belirtilir.

e Bilyiiltme Olgegi: Parcanin dlcilerinin biyiltilerek cizildigi dlceklendirme gesididir. 2:1, 5:1, 10:1 ...
olarak belirtilir.

Olgeklendirme ¢izim elemanlari ve gizim kurallari sunlardir:

o Olgii Sinir Gizgisi: Cizgi kalinhig 0,25 mm olan, strekli ve duiz gizgidir. Bu cizgiler mutlaka birbirine
paralel olmalidir. Olceklendirme yapilacak yiizeylerin kenar noktalarindan uzatilarak kullanilmahdir.
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o Olgii Cizgisi: Cizgi kalinhig1 0,25 mm olan, strekli ve her iki ucunda ok sekli bulunan diiz ¢izgidir. Oklarin
ug agisi 15 derece ve ikizkenar liggen seklinde olmalidir. Olgeklendirilen yiizeyin kenarindan yaklasik
7-10 mm uzaklhkta, 6l¢llendirilecek kenara paralel ve birbirini kesmeyecek sekilde cizilmelidir.

o Olgii Rakamlar: Olgii gizgisinin tam ortasina ve 0,5 mm Ustiine yazilan rakamdir.

Gorsel 1.55: Olceklendirme cizim elemanlari

Uygulama: Goriiniis Olgiilendirme

Gorinls olgeklendirme igin asagidaki yonergeleri uygulayiniz.
e Asagida verilen gorlnisl teknik resim kurallarina gore cetvelle dlgerek teknik resim defterinize giziniz.

Gérsel 1.56: Olceklendirilecek gériiniis

e Olgi sinir gizgilerini ¢iziniz.

Gorsel 1.57: Goriiniisiin 6l¢i sinir gizgilerinin gizilmesi
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o Olgii gizgilerini giziniz.

Gorsel 1.58: Gortiniisiin 6l gizgilerinin gizilmesi

Resimler hangi 6lgekle gizilirse gizilsin, GUzerine parcanin gergek blyukligini gdsteren Y

Olculer yazilmalidir. !

e Norm yazi kurallarina gore 6l¢li rakamlarini yaziniz.

Gorsel 1.59: Goriintisiin 6l¢i rakamlarinin yazilmasi
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Asagida perspektifi verilen parcanin t¢ gorinasiini cikarip 6lgtilendiriniz.

Gorsel 1.60: Parga perspektifi

42. 1. OGRENME BIRIMi



TEMEL TEKNiK RESIM

a— .
gadl | Olcme ve Degerlendirme
®©

1. Teknik resimde goriinmeyen kenarlar ve ¢evreler asagidakilerden hangisi ile gizilir?

A) Sirekli ince cizgi B) Surekli kahn cizgi C) Kesik orta ¢izgi
D) ince kesik cizgi E) Noktali kesik ince cizgi

2. Teknik resimde kullanilan kursun kalemlerden orta sertlikteki kalemlerin kodu asagidakilerden

hangisidir?

A) 2H B) 2B C) HB D) 3H E) 3B

3. Asagidaki yazi tiplerinden hangisinin yazi kalinligi daha incedir?

A) Yazi tipi A B) Yazi tipi B C) Yazi tipi C
D) Egik yaz E) Dik yazi

4. 45-30-60 derecelik gonyeler ile agagidaki agilardan hangisi cizilemez?

A) 45 B) 75 C) 105 D) 90 E) 20

5. Teknik resimde agagidaki kagitlardan hangisi kullaniimaz?

A) Aydinger B) Kraft kagidi C) Ozalit kagidi
D) Milimetrik kagit E) Saydam olmayan resim kagidi

6. | Pergel
1. 45°lik gonye
I1l. 30°-60°lik gbnye
IV. iletki
Birbirine paralel gizgiler ¢cizmek igin yukaridaki araglarin hangisi ya da hangilerinin kullanilmasi
yeterlidir?

A)lvell B) Il ve IV Q) llvelll
D) Il ve IV E)1, 1lve lll
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7. Bir cismin izdiisiim diizlemine diisen goriintiisiine verilen ad agagidakilerden hangisidir?

A) izdiisim B) izdiistim 1sin C) izdiistim noktasi

D) Odak noktasi E) Bakis agisi

8. Teknik resimde en ¢ok kullanilan izdiisiim sekli asagidakilerden hangisidir?

A) Konik izdlsiim B) Egik izdlUslim C) Dik izdUstim

D) Paralel izdlsiim E) Capraz izdlisim

9. izdiisiim isinlarinin giktigi varsayilan noktaya verilen ad asagidakilerden hangisidir?

A) izdiisiim noktasi B) izdiisiim 1511 noktasi C) izdiistim noktasi
D) Odak noktasi E) Paralel izdlisiim noktasi
10.

y
A

1.Bolge + 2.Bolge

3.Bolge :
v

Yukaridaki koordinat diizleminde 1.Bolge, 2.Bélge ve 3.Bolge olarak tanimlanan bolgelerin
siralanigi agsagidakilerden hangisinde dogru verilmistir?

A) Alin-Profil-Yatay B) Yatay-Alin-Profil C) Profil-Alin-Yatay
D) Alin- Yatay-Profil E) Profil-Yatay-Alin
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11. Alin bolgesine yerlestirilen goriiniis asagidakilerden hangisidir?

A) Arka B) Yan C) Alt
D) Ust E) On

12. Noktaninizdiisiimii gcikarilirken noktanin alinizdiisiimiine olan mesafesine verilen ad asagidakilerden

hangisidir?
A) Uzakhk B) Aralik C) Kot
D) Deger E) izdiistim

13. Cisimlerin goriiniislerinin temel izdiisiim diizlemlerine gizilmesine verilen ad asagidakilerden

hangisidir?
A) Gorilinls B) Goriunus ¢cikarma C) On gériinis

D) Ust goriiniis E) izdlisiim

14. Parca Olgiilerinin kendisi veya goériunislerinin lizerine yazilmasina verilen ad asagidakilerden

hangisidir?

A) Olcii cizgisi B) Olceklendirme C) Ol¢ii
D) izdiisiim E) Ol¢ii alma

15. Olgii gizgisinin gizgi kalinhgi asagidakilerden hangisidir?

A) 0,5 mm B) 0,75 mm C) 0,25 mm
D) 0,1 mm E) 0,4 mm
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f OGRENME BiRiMi BOLUMLERI
Cizim Programi Araydzu

Uc Boyutlu Modelleme
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2.BILGISAYARLI Cizim

g Hazirhk Caligmalari |

1. Ug boyutlu gizim programlarini arastiriniz.

E 2. Ug boyutlu yazicilari arastiriniz.

____________________________________________________________________

2.1. Cizim Programi Arayiizii

2.1.1. Hesap Olusturma

Web arayizll gizim programinin en 6nemli 6zelligi, tek kullanici hesabiyla tim ortamlardan kullanicinin
olusturdugu tasarimlara ulasilabiliyor olmasidir. Cizim programinin Tirkge destegi bulunmaktadir. Tasarim
yapilabilmesi icin kayit islemi gerekmektedir. Cizim programina herkes kayit yaptirabilir. 12 yasindan kigik
bir kullanici kayit yaptiysa ebeveyninin mail adresine bir aktivasyon bilgisi gitmektedir. Kullanici, ebeveyni
onayladiktan sonra sisteme giris yapabilmektedir.

Uygulama: Hesap Olusturma

Hesap olusturma islemi icin asagidaki yonergeleri uygulayiniz.
e (Cizim programi web sitesine giriniz.

e Sag st kosede yer alan Hemen Katil linkine tiklayiniz.

Gorsel 2.1: Cizim programina giris

e Kisisel Hesap Olustur linkine tiklayiniz.

e Hesapolusturmayodntemleriigin birdenfazlasegeneksunulmaktadir. Diger oturumagmasecgeneklerinde
OAuth yontemi ile oturum acabilirsiniz. E-posta yontemi ile devam etmek icin E-postayla Kaydol
linkine tiklayiniz.

Ulke ve dogum tarihi seceneklerini uygun sekilde isaretleyiniz.

Sonraki linkine tiklayiniz.

OAuth, kullanicilarin kendi hesaplarina ait sifreleri paylasmadan (glincl taraf web
sitelerine erismek icin kullanilan agik standarth bir yetkilendirme protokoltddr. '

E-posta adresinizi giriniz.

Sifrenizi giriniz.

Sifre belirlerken giiclii sifre dlgiitlerine uygun bir sifre olusturulmalidir. Sifre élcitleri;en

az 1 harf, en az 1 sayi, en az 8 karakter, en az 3 benzersiz karakter girilmesidir. '
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e Hizmet sartlarini ve gizlilik beyanini kabul ediniz.
e Hesap olustur linkine tiklayiniz.

Gorsel 2.2: Hesap olusturma
2.1.2. Cizim Programi Ortami

Cizim programi, kolay anlasilabilir bir araylize sahiptir. Cizim programina giris yapildiktan sonra
asagidaki arayiiz ekrana gelecektir.

Gorsel 2.3: Cizim programi araylizii
Sol meniden;

e Uc boyutlu tasarim yapilmak isteniyorsa 3D Tasarimlar meniisi,

e Arduinoile sanal devreler kurulmak isteniyorsa Circuits menusd,

e Kod bloklari ile ¢ boyutlu tasarim yapiimak isteniyorsa Kod
Bloklari menus,

e Daha oOnceden tamamlanmis egitimler gorintilenmek

isteniyorsa Dersler menisu segilmelidir.
Ust meniiden;

e Cizim programina kayith kullanicilarin paylasimlarini incelemek
ve kullanmak icin Galeri mensdi,

e Cizim programi ile ilgili calismalar incelenmek istenirse Blog

menusu,
Gorsel 2.4: Cizim programi sol mendisii
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Gorsel 2.5: Cizim programi list mendisii

e Cizim programina yeni baslayanlarin kendi kendilerine 6grenme saglayabilmeleri icin Ogren meniisi,

e Ogretmenlerin 8grenci gruplari olusturup takip edebilmesi icin Ogret meniisd,

e Kullanici profili ile ilgili islem yapilmak isteniyorsa profil resmi segilmelidir.

e Son olarak arayliziin orta alani ise kullanici tarafindan daha 6nceden olusturulmus tasarimlarin yer
aldigi bolumdadr.

Cizim programinda daha dnceden tasarlanmis bir tasarim (izerinde degisiklik yapildiginda

cevrimici olarak degisiklik yapildigi icin tim ortamlarda degisiklik uygulanacaktir. :

2.1.3. Yeni Tasarim Olusturma

Cizim programi yeni olusturulan her tasarima otomatik olarak isim vermektedir. Kullanici, bu ismi
degistirerek tasarimlara istedigi adi verebilmektedir. Yeni bir tasarim olusturmak igin Yeni Tasarim Olustur
digmesine tiklanmasi yeterli olacaktir.

Kayith tasarimlar (zerinde calismak icin tasarim secilerek Bunu diizenle diigmesine
: tiklanmahdir.

2.1.4. Calisma Diizlemi Kontrolleri

Cizim programi tasarim ortami, kullanicilara kolaylik saglayacak sekilde tasarlanmistir.

Uygulama: Temel Kontroller

Calisma diizleminde yer alan kontrolleri kullanmak icin asagidaki yonergeleri uygulayiniz.

e Yeni bir tasarim olusturunuz.
e Cizim programinin tasarima verdigi ismi degistirmek icin tasarim ismini tiklayiniz.
e Tasarimin adini ilk Tasarim olarak degistiriniz.

Gorsel 2.6: ilk Tasarim

50. 2. OGRENME BIRIMi



BiLGISAYARLI Gizim

Uygulama: Temel islem Kontrolleri

Calisma diizleminde yer alan kontrolleri kullanmak icin asagidaki yonergeleri uygulayiniz.

e Yeni bir tasarim olusturunuz.
e Tasarimin adini Temel islem Kontrolleri olarak degistiriniz.
akteyime

Gorsel 2.7: Sekillerin ¢alisma diizlemine eklenmesi

e Calisma dizleminde secili sekli kopyalamak icin Kopyala (Ctrl+C) digmesine tiklayiniz.

e Kopyalanan sekli yapistirmak icin Yapistir (Ctrl+V) digmesine tiklayiniz.

e (Calisma dizleminde segili sekli cogaltmak icin Duplicate and repeat (Ctrl+D) diigmesine tiklayiniz.
e Calisma dizleminde segili sekli silmek icin Sil (Delete) digmesine tiklayiniz.

e Son yapilan islemleri geri almak icin Geri Al (Ctrl+Z) digmesine tiklayiniz.

e Son yapilan islemleri yinelemek icin Yinele (Ctrl+Y) digmesine tiklayiniz.

Gorsel 2.8: Temel islem kontrolleri

Tasarima farkh agilardan bakmak, tasarimi kolaylastiracaktir. Tasarimlara farkh agidan bakmak igin

goriinim kontrolleri kullanilir.
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Uygulama: Goriiniim Kontrolleri 1

Calisma duzleminde yer alan kontrolleri kullanarak gorinimu degistirmek icin asagidaki yonergeleri
uygulayiniz.

e Yeni bir tasarim olusturunuz.

e Tasarimin adini Gériiniim Kontrolleri 1 olarak degistiriniz.

e Calisma dizlemine kutu ekleyiniz.

e Calisma dizleminin sol tarafinda yer alan goérinim klpUnQ fare (mouse) ile yonlendirerek tasarim
ortaminin bakis agisini degistiriniz.

Gorsel 2.9: Goriiniim degistirme

e Calisma dizleminin tamamini gérmek icin Ana Ekran gériiniimii digmesine tiklayiniz.
e (Cizilen sekli ekrana sigdirmak icin Tiiminii gériiniime sigdir (F) digmesine tiklayiniz.
e Calisma dizleminin gérindmind yakinlastirmak icin Yakinlastir (+) diigmesine tiklayiniz.

e Calisma dizleminin gériinimini uzaklastirmak icin Uzaklastir (-) digmesine tiklayiniz.

e Cizilen seklin iki boyutlu gériiniimine gecmek icin Diiz gériiniime ge¢ diigmesine tiklayiniz.

Gorsel 2.10: Diiz gériiniime geg¢ diigmesi
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Uygulama: Goriiniim Kontrolleri 2

Calisma diizleminin boyutunu degistirmek icin asagidaki yonergeleri uygulayiniz.
e Yeni bir tasarim olusturunuz.
e Tasarimin adini Gériiniim Kontrolleri 2 olarak degistiriniz.

Calisma dizleminin boyutunu degistirmek icin Calisma diizlemi 6lcimleri digmesine tiklayiniz.

Gorsel 2.11: Calisma alani élgiimleri diigmesi

e Birimler bolimini segerek olgl birimini degistiriniz.
e Genislik ve uzunluk degerlerini degistiriniz.

Cizim programi, calisma dizleminde genislik ve uzunluk icin maksimum 1000 mm
Olclsund desteklemektedir.

Izgarayi Giincelle linkine tiklayarak calisma duzlemi élgillerini degistiriniz.

Sekillerin tasinmasi sirasinda kilavuz cizgilerine tutunma aralklarini degistirmek icin Izgarayi Tuttur
segenegini isaretleyiniz.

Gorsel 2.12: Izgarayi tuttur diigmesi

Sira Sizde 2

Ana sayfaya donerek dnceden olusturdugunuz baska bir tasarimi aginiz.
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2.2. U¢ Boyutlu Modelleme

Nesneler gercek diinyada ii¢ boyutlu olarak algilanir. U¢ boyut; bir nesneye ait yiikseklik, genislik
ve derinlik algisidir. Cesitli programlar araciligiyla bir nesnenin ¢iziminde genislik, yikseklik ve derinlik
ozelliklerinin kullanilmasi ti¢ boyutlu modelleme olarak tanimlanir. istenilen seklin modelini hazirlamak
icin hangi teknigin kullanildigindan ¢ok gercege ne kadar yaklasildigi 6nemlidir (Gller, 2014).

Uc boyutlu modelleme yapilirken nesnenin énden, yandan ve tistten gériiniisleri cikartilir. Bu gériintsler
Uzerinde nesnenin modeli olusturulur. Modelleme islemi gesitli yontemlerle yapilabilir: Bir nesneye ait Ug¢
boyutlu model tek bir gorintiide hazirlanabilir veya nesnenin her bir parcasi ayri ayri modellenerek bu
parcalarin birlestirilmesiyle de olusturulabilir.

2.2.1. Temel Sekiller

Sekiller, gizim programinin temel yapi nesneleridir. Cizim programi, li¢ boyutlu nesnelerin hemen
hemen hepsini kullanicilarin hizmetine sunmaktadir. Calisma dizlemine eklenerek bu sekiller tzerinde
islem yapilabilir, birden fazla sekille yeni sekiller tasarlanabilir.

Temel sekiller menisi altinda geometrik sekillerin ¢ boyutlu modelleri yer almaktadir. Metin ve
sayllar menisu altinda t¢ boyutlu metin yazilmak istendiginde kullanilabilecek modeller vardir. Karakterler
menisi altinda tasarimlarda kullanilabilecek basit karakter tasarimlari bulunmaktadir. Sekil olusturucular
altinda ise tasarlanmis sekiller yer almaktadir.

Uygulama: Sekil Yerlestirme

Calisma dizlemine bir sekil yerlestirmek ve seklin gorlinimiini degistirmek icin asagidaki yonergeleri
uygulayiniz.
e Yeni bir tasarim olusturunuz.
e Tasarimin adini Sekil Yerlestirme olarak degistiriniz.

e Calisma diizlemine bir kutu ekleyiniz.

Sekil 6zelliklerinden kutunun rengini mavi olarak degistiriniz.

Gorsel 2.13: Sekil renk 6zelligi

e Calisma dlzlemine bir piramit ekleyiniz.
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Piramidin kose sayisini sekil taraflar 6zelliginden 10 olarak degistiriniz.

Sekil 6zelliklerinden piramidin rengini kirmizi olarak degistiriniz.

Gorsel 2.14: Sekil taraflar ézelligi

Calisma dizlemine bir B harfi ekleyiniz.

B harfinin rengini yesil olarak degistiriniz.

Gorsel 2.15: Harf ekleme

Karakter menisiini seginiz.
Calisma diizlemine Scuba Maskesi (dalis maskesi) karakterini ekleyiniz.

Gorsel 2.16: Karakter ekleme
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Uygulama: Sekil Tasima

Calisma diizlemine eklenen seklin yerini degistirmek icin asagidaki yonergeleri uygulayiniz.

e Yeni bir tasarim olusturunuz.
e Tasarimin adini Sekil Tagima olarak degistiriniz.

e Calisma dlzlemine yan yana doért tane kutu ekleyiniz.

Gorsel 2.17: Tasinacak sekillerin eklenmesi

e Farenin sol tusunu tiklayarak her kutuyu galisma diizleminin kdselerine tasiyiniz.

Gorsel 2.18: Tasima islemi

Uygulama: Sekil Dondiirme

Calisma dizlemine eklenen sekli dondirmek icin asagidaki yonergeleri uygulayiniz.

e Yeni bir tasarim olusturunuz.
e Tasarimin adini Sekil Déndiirme olarak degistiriniz.

¢ Calsma dizlemine yan yana ¢ tane kutu ekleyiniz.

Gorsel 2.19: Déndiiriilecek sekillerin eklenmesi
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Dondirmek istediginiz sekli seciniz. Sekli dondirmek icin tutamaclari kullanabilirsiniz.

Dondirme isleminde en iyi goriinim elde etmek icin calisma diizlemini dondiriiniz.

Her sekli gorselde gorildigu gibi 45 derece dondirmek icin egri oklari kullaniniz.

Gorsel 2.20: Sekil déndiirme

Uygulama: Sekil Boyutlandirma

Calisma diizlemine eklenen sekli boyutlandirmak icin asagidaki yonergeleri uygulayiniz.

e Yeni bir tasarim olusturunuz.
e Tasarimin adini Sekil Boyutlandirma olarak degistiriniz.
e Calisma diizlemine Ug¢ tane kutu ekleyiniz.

Gorsel 2.21: Boyutlandirilacak sekillerin eklenmesi

e Boyutlandirma isleminde en iyi gérinimu elde etmek igin ¢alisma dizlemini dondiriiniz.
e Her sekli gorselde goraldugi gibi bir kenari 50 mm olacak sekilde boyutlandiriniz.

Gorsel 2.22: Sekillerin boyutlandiriimasi
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Tasima degeri, dondlirme acisi ve boyut degerleri fare yardimiyla veya klavyeden degerler

AY
1
1

girilerek yapilabilir. '
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Temel sekillerle ilgili tasima, déndirme ve boyutlandirma islemini silindir Gzerinde
uygulayiniz.

\
1
1
]
1

2.2.2. Gruplama ve Grup Cozme

Temel sekillerle tasarim yapmak bazen yetersiz kalmaktadir. Temel sekiller birlestirilerek yeni sekiller
olusturulabilir.

Uygulama: Sekil Gruplama

Calisma diizlemine eklenen sekilleri gruplandirmak icin asagidaki yonergeleri uygulayiniz.

e Yeni bir tasarim olusturunuz.
e Tasarimin adini Sekil Gruplama olarak degistiriniz.
e Calisma dlzlemine iki tane kutu ekleyiniz.

Gorsel 2.23: Gruplama islemi igin birinci nesnelerin eklenmesi

Calisma dizlemine kutularin ortasina gelecek sekilde iki tane silindir ekleyiniz.

Silindirleri 10x10x30 mm olacak sekilde boyutlandiriniz.

Gorsel 2.24: Gruplama islemi igin ikinci nesnelerin eklenmesi

e Shift tusuna basili tutarak birinci kutuyu ve birinci silindiri seciniz.

e Ust meniiden Gruplandir (Ctrl+G) diigmesine tiklayiniz. Grup rengi, grubu olustururken segilen ilk sekil
ile eslesecektir.

e Shift tusuna basili tutarak ikinci silindiri ve ikinci kutuyu seginiz.

58. 2. OGRENME BIRIMi



BiLGISAYARLI Gizim

e Ust meniiden Gruplandir (Ctrl+G) diigmesine tiklayiniz. Grup rengi, grubu olustururken segilen ilk sekil

ile eslesecektir.

Gorsel 2.25: Gruplanan sekiller
e Grubu ¢dozmek igin st meniiden Grubu €6z (Ctrl+Shift+G) diigmesine tiklayiniz.
2.2.3. Eksiltme Ozelligi

Sekil birlestirme isleminde bir sekil, baska bir sekilden eksiltme yoluyla cikartilarak yeni sekiller
olusturulabilir.

Uygulama: Sekil Eksiltme

Calisma dizlemine eklenen sekillerde eksiltme islemi yapmak icin asagidaki yonergeleri uygulayiniz.

e Yeni bir tasarim olusturunuz.

e Tasarimin adini Sekil Eksiltme olarak degistiriniz.

e Calsma dizlemine bir kutu ekleyiniz.

e Calisma dlzlemine kutularin ortasina gelecek sekilde bir silindir ekleyiniz.
e Silindiri 10x10x30 mm olacak sekilde boyutlandiriniz.

e Silindir seklini seciniz ve silindirin 6zelliklerinden Delik 6zelligini seginiz.

Gorsel 2.26: Eksiltme uygulanacak sekillerin eklenmesi

e Shift tusuna basili tutarak kutuyu ve silindiri seginiz.
e Ust meniiden Gruplandir (Ctrl+G) diigmesine tiklayiniz. Béylece kutu seklinden silindir sekli eksiltilmis
olacaktir.

Gorsel 2.27: Eksiltme uygulanan sekiller
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2.2.4. Hizalama Ozelligi

Hizalama secenegi, bir sekil olustururken sekilleri siralamak icin kullanicilara yardimci olmaktadir.
Hizalama islemi, yatay ve dikey olmak lizere iki sekilde yapilabilir.

Uygulama: Sekil Hizalama

Calisma diizlemine eklenen sekilleri hizalamak i¢in asagidaki yonergeleri uygulayiniz.

¢ Yeni bir tasarim olusturunuz.
e Tasarimin adini Sekil Hizalama olarak degistiriniz.
e Calisma dizleminde farkli yerlere Gg kutu ekleyiniz.

e Birinci sekle dokunmadan ikinci sekli 5 mm, lgiinci sekli ise 10 mm yiikseltiniz.

Gorsel 2.28: Hizalanacak sekillerin eklenmesi

e Shift tusuna basili tutarak tg¢ sekli de seginiz.

e Timsekillersegiliyken tist menilide yer alan Hizala (L) digmesine tiklayiniz. Hizala digmesine tikladiktan
sonra hizala tutamaclari sekillerin cevresinde gorindr.

e Hizalamanin 6n izlemesini gérmek icin farenizi siyah hizalama tutamaglarinin her birinin Uzerine
getiriniz.

e Hizalama tutamaclarindan herhangi birine tiklayarak sekilleri tastyiniz.

e Arac cubugundaki Geri Al diigmesini kullanarak gerekirse son isleminizi geri alabilirsiniz.

e Cahsma duzlemindeki kutulari yatay hizalama tutamaclarini kullanarak birinci kutuya yatayda
hizalayiniz.

Gorsel 2.29: Yatay hizalama uygulanan sekiller

e Calismadizlemindeki kutulari dikey hizalama tutamaclarini kullanarak ikinci kutuya dikeyde hizalayiniz.
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Gorsel 2.30: Dikey hizalama yapilan sekiller

2.2.5. Ornek Uygulamalar

[ e [
http.//kitap.eba.gov.tr/KodSor. ' . I
Uygulama: Yizik Yapimi php?K0D=21370 WENELET

e Yeni bir tasarim olusturunuz.

e Tasarimin adini Yuziik Yapimi olarak degistiriniz.

e Calisma dlzlemine bir silindir ekleyiniz ve ¢api 21 mm olacak sekilde silindiri boyutlandiriniz.

e Calisma diizlemine yeni bir silindir daha ekleyiniz ve ¢api 17 mm olacak sekilde silindiri boyutlandiriniz.

e Her iki sekli de seginiz ve 4 mm yukseklige dlgeklendiriniz.

e ikinci silindiri secerek silindirin 6zelligini Delik olarak degistiriniz.

e Hizalama ozelligini kullanarak sekilleri merkezde hizalayiniz.

e Her iki 6geyi de segili tutunuz ve meni ¢ubugundaki Gruplandir (Ctrl+G) diigmesini kullanarak bunlari
gruplandiriniz.

e Calisma dizleminde dik duracak sekilde yizigu dondiriiniz.

Gorsel 2.31: Cizim programi ile yiiziik yapimi

http.//kitap.eba.gov.tr/KodSor. ¥
Uygulama: Cikolata Yapimi php?KOD=21371 g

e Yeni bir tasarim olusturunuz.

e Tasarimin adini Cikolata Yapimi olarak degistiriniz.

e Calisma dizlemine bir kutu ekleyiniz.

e Kutunun yiksekligini 10 mm olarak ol¢eklendiriniz.

e Kutunun enini ve boyunu 100x100 mm olarak ol¢eklendiriniz.
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Gorsel 2.32: Cikolata zemininin olusturulmasi

e Calisma dizlemine bir ¢ati sekli ekleyiniz.

e Catinin enini ve boyunu 20x100 mm olarak 6lceklendiriniz.

e (Cati seklini Duplicate and repeat (Ctrl+D) diigmesi ile 6 adet yan yana ¢ogaltiniz.
e (Cati sekillerini Gruplandir (Ctrl+G) digmesi ile gruplandiriniz.

Gorsel 2.33: Gruplandirilmis ¢ati sekilleri

e Cati sekillerini ters donecek sekilde 180 derece dondiriniz.

e Kutu ve cati grubunu Hizala (L) digmesi ile merkezden hizalayiniz.
e Cati grubunu 5 mm yukari kaldiriniz.

e Cati grubunun 6zelligini Delik olarak degistiriniz.

e Cati grubunu Duplicate and repeat (Ctrl+D) diigmesi ile cogaltiniz.

e Yeni ¢ati grubunu yatayda 90 derece déndiriniz.

Gorsel 2.34: Cikolata kalibinin olusturulmasi

e Tim sekilleri seginiz ve Gruplandir (Ctrl+G) digmesi ile gruplandiriniz.
e Olusturdugunuz seklin rengini kahverengi olarak degistiriniz.
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Gorsel 2.35: Tamamlanmis ¢ikolata tasarimi

° Sira Sizde 4 [

Cikolata yapimi uygulamasini farkh sekillerle yapiniz. .

http://kitap.eba.gov.tr/KodSor. 3 11'-,‘
php?KOD=21372

Uygulama: Bayrak Yapimi

e Yeni bir tasarim olusturunuz.

e Tasarimin adini Bayrak Yapimi olarak degistiriniz.
e Calisma diizlemine bir kutu ekleyiniz.

e Kutunun yiksekligini 3 mm olarak ol¢eklendiriniz.

e Kutunun enini ve boyunu 100x150 mm olarak olceklendiriniz.

Gorsel 2.36: Bayrak zemininin olusturulmasi

e Calisma dlzlemine bir silindir ekleyiniz.

e Silindirin yiksekligini 3,1 mm olarak 6lgeklendiriniz.
¢ Silindir capini 50 mm olarak ol¢eklendiriniz.

e Calisma dlzlemine yeni bir silindir ekleyiniz.

e Silindirin yiksekligini 3,5 mm olarak 6l¢eklendiriniz.
e Silindirin gapini 40 mm olarak dlgeklendiriniz.

e ki silindiri secip Hizala (L) digmesi ile merkezden hizalayiniz.
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Gorsel 2.37: Hilalin olusturulmasi igin silindirlerin kullanimi

e Kiclk silindiri merkezden saga dogru 6,25 mm kaydiriniz.
e Kiguk silindirin 6zelligini Delik olarak degistiriniz.
e ki silindiri secerek Gruplandir (Ctrl+G) diigmesi ile gruplandiriniz.

e Silindir grubunun rengini beyaz olarak degistiriniz.

Gorsel 2.38: Hilalin olusturulmasi

e Kutu ve silindir grubunu orta-solda Hizala (L) digmesi ile hizalayiniz.

e Silindir grubunu 27 mm saga kaydiriniz.

Gorsel 2.39: Hilalin yerlestirilmesi

e Calisma dlzlemine bir yildiz ekleyiniz.

e Yildizin yiiksekligini 3,10 mm olarak 6l¢eklendiriniz.

¢ Yildizi 110 derece dondiiriinlz.

e Yildizin enini ve boyunu 23x23 mm olarak 6l¢eklendiriniz.
e Yildizin rengini beyaz olarak degistiriniz.
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Gorsel 2.40: Yildizin olusturulmasi

e Kutu, yildiz ve silindir grubunu orta-sagda Hizala (L) digmesi ile hizalayiniz.
e Yildizi 73 mm saga kaydiriniz.

Gorsel 2.41: Tamamlanmis Tiirk Bayragi

¢ Yeni bir tasarim olusturunuz.

e Tasarimin adini Bardak Yapimi olarak degistiriniz.

e (Calisma dizlemine silindir ekleyiniz.

e Silindirin yiksekligini 50 mm olarak 6lceklendiriniz.

¢ Silindirin ¢capini 50 mm olarak olceklendiriniz.

e Koseli goruntliyl ortadan kaldirmak icin silindir 6zelliginde Taraflar degerini 64 olarak degistiriniz.
e Silindiri cogaltiniz ve yeni silindirin gapini 47 mm olarak giincelleyiniz.

e ikinci silindirin yiiksekligini 60 mm olarak giincelleyiniz.

e ikinci silindirin 6zelligini Delik olarak degistiriniz.
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e ikinci silindiri 3 mm yiikseltiniz.

e ki silindiri merkezde hizalayiniz.

Gorsel 2.42: Bardak gévdesinin olusturulmasi

e Calisma diizlemine metin ekleyiniz ve sekil 6zelliklerinden metni BILISIM olarak degistiriniz.
¢ Metnin enini ve boyunu 40x20 mm olarak ol¢eklendiriniz.
e Bardak gbvdesi ile ayni gérinimde olacak sekilde metni 90 derece dondiriiniz.

e Bardak ylzeyinde ortada goriinecek sekilde metni tasiyiniz.

Gorsel 2.43: Bardak metninin olusturulmasi

e Birinci silindiri cogaltiniz ve ¢capini 55 mm olarak giincelleyiniz.
e Birinci silindir ile Gglincu silindiri merkezden hizalayiniz.
e Ugtincu silindirin yiiksekligini 60 mm olarak giincelleyiniz.

e Ugiinci silindirin &zelligini Delik olarak degistiriniz.

Gorsel 2.44: Bardak metninin ovallestirilmesi

e Calisma dlzlemine bir kutu ekleyiniz ve tiim sekli kapatacak sekilde kutuyu boyutlandiriniz.
e Kutu ve Uglncu silindiri gruplandiriniz.
e Kutunun 6zelligini Delik olarak degistiriniz.

e Tim sekilleri secerek gruplandiriniz.

66. 2. OGRENME BIRIMi



BiLGISAYARLI Gizim

Gorsel 2.45: Bardak gévdesi

e Calsma dizlemine bir halka ekleyiniz.
e Halkanin ¢apini 30 mm olarak dl¢eklendiriniz.
e Halkayi dik duracak sekilde 90 derece dondiiriiniz.

e Halkayi bir kutu yardimi ile yarim halkaya donustirip kulpu olusturunuz.

Gorsel 2.46: Bardak kulpunun olusturulmasi

e Bardak gévdesine kulpu yerlestiriniz.

e Tim sekilleri secerek gruplandiriniz.

Gorsel 2.47: Bardak tasarimi

Uygulama: Kalemlik Yapimi

e Yeni bir tasarim olusturunuz.
e Tasarimin adini Kalemlik Yapimi olarak degistiriniz.
e Calsma dizlemine silindir ekleyiniz.

e Silindirin ylksekligini 50 mm olarak 6l¢eklendiriniz.

2. OGRENME BIRIMi ‘67




e Silindirin gapini 50 mm olarak élgeklendiriniz.

e Koseli goruntliyl ortadan kaldirmak icin silindir 6zelliginde Taraflar degerini 64 olarak degistiriniz.
e Silindiri gcogaltiniz ve yeni silindirin gapini 47 mm olarak giincelleyiniz.

e ikinci silindirin yiiksekligini 60 mm olarak giincelleyiniz.

e ikinci silindirin 6zelligini Delik olarak degistiriniz.

e ikinci silindiri 3 mm yikseltiniz.

e ki silindiri merkezden hizalayiniz.

e ki silindiri gruplandiriniz.

Gorsel 2.48: Kalemlik gévdesinin olusturulmasi

e Calisma diizlemine metin ekleyiniz ve sekil 6zelliklerinden metni BILISIM olarak degistiriniz.
e Metnin enini ve boyunu 20x10 mm olarak olgeklendiriniz.

e Kalemlik gbvdesi ile ayni gériinimde olacak sekilde metni 90 derece donddriiniz.

e Metnin 6zelligini Delik olarak degistiriniz.

e Kalemlik gbvdesinde ortada goriinecek sekilde metni tasiyiniz.

Gorsel 2.49: Kalemlik tizerine metin ekleme

e Calisma dlzlemine yildiz ekleyiniz.

e Yildizin enini ve boyunu 10x10 mm olarak élgeklendiriniz.

e Kalemlik gbvdesi ile ayni gériinimde olacak sekilde yildizi 90 derece déndiriniz.
e Yildizin uzunlugunu 60 mm olarak degistiriniz.

e Kalemlik gbvdesinin her iki ylizeyinde goriinecek sekilde yildizi tasiyiniz.

e Yildizi gogaltiniz ve yeni yildizi 45 derece dondiiriiniiz.

e ikinci yildizi cogaltiniz ve liglincii yildizi 45 derece déndiiriiniiz.

e Uglincii yildizi cogaltiniz ve dérdiincii yildizi 45 derece déndiiriiniiz.
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Gorsel 2.50: Kalemlik desenlerinin eklenmesi

e Yildizlari seginiz ve 6zelligini Delik olarak degistiriniz.
e Tim sekilleri seciniz ve gruplandiriniz.

Gorsel 2.51: Tamamlanmis kalemlik tasarimi

Sira Sizde 5

Yeni bir tasarim olusturunuz.

e Tasarimin adini Piyon Yapimi olarak degistiriniz.

Calisma diizlemine bir silindir ekleyiniz.

Silindirin yiksekligini 3 mm olarak degistiriniz.

Silindirin Gsttne bir Calisma Dizlemi (W) sirikleyiniz.

Gorsel 2.52: Piyon tabaninin yapilmasi

2. OGRENME BIRIMi ‘69



e Bir koni seklini silindirin Ustline ekleyiniz.

e Koninin ylksekligini 11 mm olarak degistiriniz.
e Calisma dlzlemine bir kire ekleyiniz.

e Kiireyi 18 mm ¢apinda olgeklendiriniz.

Bir sekil Uzerine galisma diizlemi eklendiginde yeni eklenen sekiller icin ¢alisma

diizlemi olarak yeni eklenen diizlem kabul edilecektir.

e Kirenin ylksekligini 5 mm olarak 6l¢ceklendiriniz.

Gorsel 2.53: Piyon yapimi tabaninin tamamlanmasi

e Calisma dizlemine bir koni sekli ekleyiniz.

e Koninin ylksekligini 28 mm olarak 6l¢eklendiriniz.
e Koninin ¢apini 14 mm olarak 6lgeklendiriniz.

e Koniyi diger sekillerin Ustline taslyiniz.

e Koniyi calisma dizleminden 3 mm yukseltiniz.

Gorsel 2.54: Piyon gévdesinin olusturulmasi

e Baska bir koniyi ¢alisma diizlemine ekleyiniz.

e Koninin gapini 12 mm olarak élgeklendiriniz.

e Koninin ylksekligini 19 mm olarak 6l¢eklendiriniz.
e Koniyi 180 derece dondiriiniz.

e Koniyi 5 mm yikseltiniz.

e Koniyi diger sekillerin tzerine tasiyiniz.

e Bir calisma dizlemini koninin Gstlne sirikleyiniz.
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Gorsel 2.55: Piyon gévdesinin tamamlanmasi

e Calisma dlzlemine bir kire ekleyiniz.

e Kirenin ¢capini 8 mm olarak dlceklendiriniz.

e Bir Calisma Diizlemini seklin disinda bir alana strtkleyerek calisma dlzleminin orijinal konumuna
getiriniz.

e Tim sekilleri merkezden hizalayiniz.

e Tim sekilleri gruplandiriniz.

Gorsel 2.56: Tamamlanmis piyon tasi

’ Sira Sizde 6 [

Piyon govdesini kullanarak kale tasini tasarlayiniz.

2.2.6. iki Boyutlu Gorseli U¢ Boyutlu Gorsele Doniistiirme

Cizim programi disindaki bir resim Ug¢ boyutlu hale getirilebilir. Resmin li¢ boyutlu hale getirilebilmesi
icin calisma dazlemine aktarilmasi gerekmektedir.
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http://kitap.eba.gov.tr/KodSor. y
Y A T php?KOD=21374 ¢,
Uygulama: Ug Boyutlu Hale Doniistlirme

e Yeni bir tasarim olusturunuz.

e Tasarimin adini Ug Boyutlu Hale Déniistiirme olarak degistiriniz.

e Ust meniden ige Aktar digmesini tiklayiniz.

e ki boyutlu resmi seginiz.

e Cevrimigi format donlstirici ile dosyanizi .svg formatina donustiriniz.
e Bir dosya se¢ diigmesine tiklayiniz.

e Resmi seciniz ve onaylayiniz.

e isterseniz Olgeklendir degerini degistirerek resmin boyutunu degistiriniz.

e ice Aktar diigmesine tiklayiniz.

e Shift tusuna basili tutup fare ile seklin genisligini 100 mm olarak degistiriniz.
e Ana Ekran goriiniimii diigmesine tiklayarak ekran gérintiisiini ortalayiniz.

Gorsel 2.57: U¢ boyuta déniistiiriilmiis sekil
2.2.7. Hareket Edebilen Bir Nesne Olusturma

Cizim programi yardimiyla birbirinden bagimsiz sekiller bir arada tasarlanabilir. Boylece hareketli
nesneler olusturulabilir.

http://kitap.eba.gov.tr/KodSor.
php?KOD=2137%

Uygulama: Disli Cark

e Yeni bir tasarim olusturunuz.

e Tasarimin adini Digli Cark olarak degistiriniz.

e Calisma diizlemine bir gati ekleyiniz.

e Catiy1 90 derece donduriniz.

e Catinin yuksekligini 10 mm olarak 6lgeklendiriniz.

e Catinin enini ve boyunu 9x9 mm olarak 6lceklendiriniz.
e Calisma diizlemine bir kutu ekleyiniz.

e Kutunun yiksekligini 4 mm olarak ol¢eklendiriniz.
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e Kutunun enini ve boyunu 1x1 mm olarak 6lgeklendiriniz.
e Kutunun o6zelligini Delik olarak degistiriniz.

e Kutu ile ¢catiyi merkezden hizalayiniz.

e Kutuyu gatinin bir kdsesine dogru 6 mm tasiyiniz.

Gorsel 2.58: Carkin disinin olusturulmasi

e (Cative kutuyu gruplandiriniz.

e Calisma dlzlemine bir kire ekleyiniz.

e Kiirenin gcapini 3 mm olarak dlgeklendiriniz.

e Kiireyi catinin tabanindan 40 mm uzaga yerlestiriniz.
e (Cative kireyi gruplandiriniz.

e Yeni sekli cogaltiniz ve 36 derece dondiriiniz.

Gorsel 2.59: Carkin dislerinin ¢ogaltiimasi

e Carkin disleri tamamlanincaya kadar bir 6nceki adimi tekrarlayiniz.

Gorsel 2.60: Carkin dislerinin tamamlanmasi
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e Disleri gruplandiriniz.

e Calisma duzlemine bir silindir ekleyiniz.

e Silindirin yiksekligini 10 mm olarak 6l¢eklendiriniz.
e Silindirin ¢apini 34 mm olarak degistiriniz.

e Disli grubunu ve silindiri merkezde hizalayiniz.

Gorsel 2.61: Disli gévdesinin olusturulmasi

e Calisma dlzlemine bir silindir ekleyiniz.

e Silindirin yiksekligini 12 mm olarak 6l¢eklendiriniz.
e Silindirin gapini 15 mm olarak dlgeklendiriniz.

¢ Silindirin 6zelligini Delik olarak degistiriniz.

e Silindiri ve ¢cark gévdesini merkezden hizalayiniz.

Gorsel 2.62: Tamamlanmus disli cark

e Disli carki cogaltiniz.
e Olusturulan disli ¢arklari, disler birbirine uygun olacak sekilde yerlestiriniz.

Gorsel 2.63: Tamamlanmus disli ¢ark grubu
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Cizim programinda li¢ boyutlu ya da iki boyutlu tasarimlar ice Aktar segenegi ile calisma diizlemine

2.2.8. Tasarimlarin ige veya Disa Aktarimi

aktarilabilir ve yeni tasarimlarda kullanilabilir. Cizim programi, ice aktarma isleminde .stl, .obj ve .svg dosya
uzantilarini desteklemektedir.

e Yeni bir tasarim olusturunuz.

e Tasarimin adini ige Aktarma olarak degistiriniz.

e Ust meniiden ige Aktar diigmesini tiklayiniz.

e Bir dosya se¢ diigmesine tiklayiniz.

e Dosyanin yerini bulunuz ve dosyayi seginiz.

e ki boyutlu ya da ii¢ boyutlu resmi seginiz.

e ice Aktar digmesini tiklayiniz.

e ice aktarilan sekli tasariminiza gére lceklendiriniz.

Uygulama: URL ile ige Aktarma

e Yeni bir tasarim olusturunuz.

e Tasarimin adini URL ile ice Aktarma olarak degistiriniz.

e ice Aktar digmesini tiklayiniz.

e Import From URL diigmesine tiklayiniz.

e URL adresini yapistiriniz ve ige Aktar diigmesini tiklayiniz.

Cizim programinda hazirlanan tasarimlar, Disa Aktar secenegi ile gizim programi disinda bir ortama
aktarilabilir.

Uygulama: Disa Aktarma

e Yeni bir tasarim olusturunuz.

e Tasarimin adini Diga Aktarma olarak degistiriniz.

e Calsma dizlemine bir kutu ekleyiniz.

e Digsa Aktar digmesini tiklayiniz.

e Ug boyutlu yazicidan ¢ikti almak igin .STL diigmesini tiklayiniz.

2.2.9. Olusturulan Uriinleri U¢ Boyutlu Yazicida Yazdirma

Ug boyutlu tasarim yapildiktan sonra érnekleri olusturulmak istendiginde geleneksel yontemlerde
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parcalar halinde Uretilip tekrar birlestirilmesi gerekir. Ancak tg¢ boyutlu yazici sayesinde tiim detaylarla tek
parca halinde 6rnek olusturulabilmektedir.

Ug boyutlu yazicilarla ile ilgili en dnemli sorulardan biri, modelleri olustururken hangi ham maddenin
kullanildigidir. Filament adi verilen bu ham maddenin PLA ve ABS olmak Gzere iki farkh tird vardir.  PLA
filament, seker kamisi ve misir nisastasi gibi maddelerden lretilen doga dostu bir plastik tiridir. ABS
filament ise petrol tlrevlerinden lretilmektedir.

Ug boyutlu yazicilardan ¢izim programi ile tasarlanan bir model, Giretiminin yapilabilmesi icin dogrudan
yaziclya gonderilebilecegi gibi .stl formatinda disa aktar 6zelligi kullanilarak yaziciya gonderilebilir. .stl
formatindaki bir tasarim dilimleme programlari yardimiyla Gi¢ boyutlu yazicinin programlama dili olan
G-code diline donusturalur. G-code dosyasl, hafiza karti ile li¢ boyutlu yaziciya tanitilir ve tasarimin g

boyutlu modeli yazdirilir.

Tasarladiginiz modeli i¢ boyutlu yazicidan yazdirmak igin asagidaki yonergeleri uygulayiniz.

e Daha 6nce tasarimini yaptiginiz Piyon Yapimi uygulamasini seginiz.
e Bunu diizenle butonuna tiklayarak tasarimi aginiz.

Gorsel 2.64: Daha 6nceden hazirlanan tasarimin agilmasi

e Diga Aktar digmesine tiklayiniz.
e Tasarimi dogrudan li¢ boyutlu yaziciya gondermek icin 3D Baski sekmesini seginiz.

e Dosyayi disa aktarmak icin indir sekmesini seginiz.

.STL diigmesini tiklayiniz.
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Gorsel 2.65: Disa aktarma dosya formatinin segilmesi

e Disa aktarilan .stl dosyasini dilimleme programi yardimiyla G-code diline donistiriinGz.

e .G-code dosyasini hafiza karti ile yaziciya aktariniz.

e Yazicida baski islemini baslatiniz.
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— Olgme ve Degerlendirme

Asagidaki sorulari dikkatlice okuyarak dogru secenegi isaretleyiniz.
1. Cizim programinda ¢ogaltma igin kullanilan kisayol kombinasyonu asagidakilerden hangisidir?

A) CTRL+C B) CTRL+D C) CTRL+V
D) CTRL+Y E) CTRL+Z

2. Gizim programinda ¢alisma diizleminin ya da segilen seklin ekrana sigdirilmasi igin kullanilan diigme
asagidakilerden hangisidir?

A) B) )

D) E)

3. (Cizim programi galisma diizlemi siniri asagidakilerden hangisidir?

A) 100 x 100 mm B) 500 x 500 mm C) 1000 x 1000 mm
D) 1500 x 1500 mm E) 2000 x 2000 mm

4. Cizim programinda iki veya daha fazla seklin birlestirilmesi ile yeni sekil olusturulmasini saglayan
ozellik asagidakilerden hangisidir?

A) Hizalama B) Cogaltma C) Kopyalama
D) Gruplama E) Eksiltme

5. Hizalama islemi icin kullanilan kisayol tusu asagidaki hangisidir?

A)D B) G L
D)Y E)Z

6. Cizim programi ice aktarma dosya boyutunun iist siniri agagidakilerden hangisidir?

A) 10 MB B) 15 MB C) 20 MB
D) 25 MB E) 30 MB
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BiLGISAYARLI Gizim

l. .obj

Il. .psd

1. st

IV. .svg

Cizim programi, ice aktarma islemi sirasinda yukaridaki dosya formatlarindan hangilerini
desteklemektedir?

A) =1l B) I—1l—1Il Q) l=1l-1V
D)1=l =1V E) =1l - IV

Hazirlanan tasarimin ili¢ boyutlu yazicida baskisini almak icin asagidaki dosya formatlarindan
hangisi kullanilir?

A) .stl B) .dxf C) .gib
D) .obj E) .svg

Ug boyutlu yazicilarin ham madde olarak kullandigi malzeme asagidakilerden hangisidir?

A) Arduino B) Filament C) Nozzle
D) Step motor E) Tabla

I. Geleneksel yontemlere gore daha kullanighdir.

Il.  Kalipgilik gibi yliksek maliyetler gerektirmez.

lll. Model ayrintilari ayri ayri olusturulur.

IV. Kullanimi igin teknik bilgi gereklidir.

Yukaridakilerden hangisi ya da hangileri li¢ boyutlu yazicilarin kullanim avantaji olarak gosterilebilir?

A) Yalniz | B) I—1I C)l=1-=1n
D)I-l—-1V E)I=11=1V
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KAVRAMLAR

Kati Modelleme, CAD, CAM, CAE
Uc Boyutlu Modelleme, 3D Yazicl
Uc Boyutlu Montaj, Dijital Uretim
Sketch, Eskiz, Montaj, Joint, Design

Tasanm, Assemble



- BGRENME BiRiMi BOLUMLERI

Dijital Uretim Programiari

Basit Parametrik Model

Taslak Cizim Komutlar

Komut Yardimiyla Objeler Olusturma
Komut Yardimiyla Nesneleri DUzenleme
Assembly (Nesnelerin Montaiji)

Tasarlanan Modelin Ug Boyutlu Baskisini Alma




3. DIJITAL URETIM

% Hazirlik Calismalar: |

1. Bolgenizdeki sanayi kuruluslarinda kullanilan bilgisayar destekli ¢izim
programlarini aragtiriniz.

. 2. Uc¢ boyutlu modelleme yaziimlarindan faydalanarak modellemenin nasil
! yapildigini arastiriniz.

3.1. Dijital Uretim Programlari

Dijital Gretim programlari; Uriin gelistirmeye yonelik, bulut tabanli, G¢ boyutlu CAD: Computer Aided
Design (Bilgisayar Destekli Tasarim), CAM: Computer Aided Manufacturing (Bilgisayar Destekli Uretim) ve
CAE: Computer Aided Engineering (Bilgisayar Destekli Mihendislik) platformudur. Programdaki araglar,
entegre konsept Uretim arag seti ile tasarim fikirlerinin hizli ve kolay kesfine imkan tanir.

3.1.1. Egitim Hesabi A¢gma ve Bireysel Kurulum Adimlari

Programi kullanmaya baslamak icin hesap olusturmak gerekmektedir.

Uygulama: Hesap Olusturma

Hesap olusturmak icin asagidaki yonergeleri takip ediniz.

e Ekranin sagindan Hesap Olus-

tur digmesini tiklayiniz.
e “Ulke” alaninda Tiirkiye seginiz.
e “Egitimdeki roli” alaninda uy-

gun profil seciniz.
e Kurumunuzun turlnu seginiz. Gorsel 3.1: Hesap olusturma
e Ad soyad bilginizi, dogum tarihinizi ve e-posta adresinizi giriniz.
e Birsifre belirleyiniz.

Kullaniclya ait bir e-posta adresi ile kaydolunur ancak program iginde Generative Design

erisimi de istenirse bu yeni teknolojiyi kullanabilmek igin Universite e-posta adresi ile

kaydolmak gerekir.

e Onay kutucugunu seginiz ve Hesap Olustur diigmesine tiklayiniz.

e Kayitta kullanilan e-posta adresine dogrulama mesaji génderilecektir. Bu mesajin icinde yer alan linke
tiklayarak e-posta adresinizi dogrulayiniz. Bu islemin ardindan ekranda Hesap Dogrulandi mesaji
gorilecektir.

e Hesap dogrulandiginda okulunuzun adini giriniz.

e (Ogrenciyseniz brans seciniz. Bu okula ne zaman basladiginizi ve tahminen okulunuzdan ne zaman
mezun olacaginizi giriniz. Egitimciyseniz Egitimci veya Okul BT Yoneticisi rolini seginiz, erismek

istediginiz lisans turind de belirtiniz.
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Lisans seciminde iki lisans tird ile karsilasilacaktir. Bunlar;

e Personal use only: Sadece bireysel egitim lisanslarina erisim,

e Personal Use and Educational Institution Deployment: Hem bireysel lisanslara hem

1

I

! . . . . . v .

: de kurumunuz icin ¢oklu kurulum lisanslarina erisim secenegidir.
1

\

e Buadimlari tamamlandiginizda ekranda Hesap Ayarlandi mesajini géreceksiniz.

Uygulama: Program Kurulum Adimlan

Dijital Gretim programini bilgisayariniza kurmak icin asagidaki yonergeleri uygulayiniz.

e Yenihesapile program lisansina erismek icin bu asamada tek adimlik erisim islemi gerceklestirilmelidir.
Bunun i¢in Erisim Elde Edin digmesine tiklayiniz.

e Programibilgisayarinizaindiriniz. Dahadnceden programkuruluise kullanicrhesabiile giris yapabilirsiniz.

e Kurulum adimlarini tamamlayiniz.

e Kurulumun ardindan program ilk defa calistirildiginda Hesabinizi Koruyun baslikli, iki adimli kimlik
dogrulama ayarlari gelecektir. Daha Sonra Hatirlat secenegine tiklayarak bu islemi daha sonra da
tamamlayabilirsiniz.

e Bulut Gzerinde projelerin yer alacagi bir takim alani olusturmak gerekmektedir. Bu asamada Create a

Team secenegini isaretleyiniz ve takim adini giriniz.

Ortak bir e-posta alanina sahip olan kurumsal kullanicilar, birbirlerinin takim alanlarini
arastirip onlara katilma istegi gonderebilirler. Herkese acik bir e-posta platformu

kullaniliyorsa bu asamada baska takimlar goriilmeyecektir.

e Anonim veri toplama segenekleriyle ilgili bir bilgilendirme ekrana gelecektir. Bu se¢enekler daha sonra

Preferences (Tercihler) meniisiinden degistirilebilir. Continue digmesine tiklayiniz.

Uygulama: Hesabi Ucretsiz Kullanim igin Aktive Etme

Yazilm ilk acihsta 30 giinliik Trial (Deneme) modunda acilacaktir. Ucretsiz kullanimi baslatmak icin

asagidaki yonergeleri uygulayiniz.

e Sag tarafta yer alan Subscribe Now diigmesine tiklayiniz.

e Buy Now (Satin Al) ekranina geginiz.

e Altta yer alan Are you a Startup, Non-commercial user or Student? (Tecriibesiz, Ticari Olmayan
Kullanici veya Ogrenci / Egitimci misiniz?) linkine tiklayiniz.

¢ Educational use (Egitim Kullanimi) secenegine tiklayiniz. Bu asamadan sonra program, egitim kullanimi
icin kaydolunmasi gerektigini size tekrar hatirlatacaktir. Yukaridaki tiim adimlari tamamladiginizda
Continue digmesine tiklayiniz.
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3.1.2. Dijital Uretim Programi Arayiizii

Program kisayoluna tiklanarak program agilir. Program arayiziinden File > New Design se¢imi yapilir.

Onceden hazirlanip kaydedilen bir dosyadan baslanmak istenirse File > New Design From File secimine

basilir. Ekrana Untitled (Adsiz) ¢izim sayfasi gelir.

Uygulama: Cizim Ekranini Tanima

Dijital Gretim programi ¢izim ekrani ile ilgili asagidaki yonergeleri uygulayiniz.

Gorsel 3.2: Cizim ekrani

Uyesi  oldugunuz  gruplan
listelemek, yeni grup kurmak
veya bir gruba katilmak icin
Team Accounts [Takim Hesabi
(1)] bolimUnd seginiz.

Data Panel [Veri Paneli (2)]
icinde yenileme islemi icin Ref-
resh digmesini, arama islemi
icin Find diigmesini ve ¢ikis igin
Exit digmesini kullaniniz.
Bulutta kayithh butiin projeleri
listelemek icin All Project (3)
bolimind kullaniniz.

Yeni proje dosyasi olusturmak
icin New Project (4) digmesini
kullaniniz.

Bulutta bulunan kitliphane dos-
yalarina ulasmak icin Libraries

(5) bolimiint kullaniniz.

e Program igindeki proje 6rneklerine ve egitim dokiimanlarina ulasmak igin Samples (6) bolimuni kul-

laniniz.

e Veri panelini gosterip gizlemek icin Show / Hide Data Panel (7) secenegini kullaniniz.

e Yeni dizayn, yeni elektronik dizayn, kiitiphane ve yeni ¢izimler olusturmak icin File [Dosya (8)]

menisind kullaniniz. Ayrica mevcut projeler agma, projelere yiiklemeler yapma, projeleri kaydetme

gibi islemler icin bu mentyi kullanabilirsiniz.
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e Kaydetme islemi icin Save [Kaydet (9)] digmesini, geri alma islemi icin Undo diigmesini ve ileri alma
islemi icin Redo digmesini kullaniniz.
Dijital Giretim programi temel olarak 6 farkli modda calisabilmektedir. Her mod, yapilacak tasarimin
Uzerinde uygulanacak islemlerle ilgilidir.
Ana calisma, Design modudur. Bumodda tasarim, tek bir parca halinde ya da montajolarak hazirlanabilir.

Uygulama: Komutlar

e Komutlarla ilgili asagidaki yonergeleri uygulayiniz.

e Ekranin Ust kisminda yer alan komut ikon gubugu aracihgiyla komutlara erisiniz.

e Calisma modunu degistirerek komutlardaki degisimi izleyiniz. Her moda 6zgli komutlar ekraniniza
gelecektir.

e Komutlari yukari dénik ok isaretine tiklayarak komut ikon cubuguna tasiyiniz.

Gorsel 3.3: Komutlar

e Fare galisma alanindayken klavyeden S kisayol tusuna basilarak sik kullanilan komutlara ve arama
ekranina erisilebilmektedir. S tusuna basarak sik kullanilan komutlari gorintileyiniz.

e Kullanilacak komut ismi, arama boélimiine bas harfleri yazilarak aratilabilir. Komutlari bas harfleri ile
arayiniz.

e Arama yaptiginiz komutlari, komutlarin yanindaki ok isareti ile sik kullanilan komutlara ekleyiniz.

e Sik kullanilan listesindeki komutlari,komutlarin yanindaki X isaretine tiklayarak listeden cikartiniz.

e Calisma sirasinda her bir gizim nesnesi olusturuldugunda ekranin sag kisminda Sketch Palette baslikh
bir menil ekrana gelir. Buradan gizim nesnelerine sinirlamalar eklenebilir. Kullanilan komutlar ve alt
komutlari bu meniiniin Gst kisminda gorintilenir. Buradan da segim yapilarak cizime devam edilebilir.

Sketch Palette menusiine goz atiniz.
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Uygulama: Cizim Ekrani Béliimleri

Cizim ekrani bolumlerine erismek icin asagidaki yonergeleri uygulayiniz.

Gorsel 3.4: Cizim ekrani béliimleri

e Hizh Erisim Meniisii (1): Burada dosya ve projelerin organize edildigi, dokuz kiiglik kare ile sembolles-
tirilmis Data Panel, siyah bir sayfa ile sembolize edilmis File acilir menisi ve ¢alismalari hizla kaydet-
meye yarayan Save ikonu bulunur. Hizli erisim menisindeki 6geleri deneyiniz.

e Dosya Sekme Cubugu (2): Birden ¢ok ¢alismanin ayni anda agik olmasi durumunda dosya adlari kar-
teks biciminde gorilir. Bunlarin Gzerine tiklanarak dosyalar arasinda gecis yapilabilir. Birden fazla ¢a-
lisma dosyasi agarak dosya sekme cubugunu deneyiniz.

e Kullanici Hesabi islemleri ve Tercihler (3): Kullanici hesabi ayarlari ve program tercihlerinin degistirile-
bilecegi kisimdir. Kullanici hesabi ayarlarini ve tercihler mentsini gorintileyiniz.

e Komut ikon Cubugu (4): Burada yer alan komutlara dogrudan tiklanarak en sik kullanilan komut ¢alisti-
rilabilir. Komut ikonlarinin altindaki asagi yonli okun Gstiine tiklandiginda o komut grubunda bulunan
alt komutlara ulasilir. Buradaki komutlardan herhangi birinin saginda bulunan yukari ok tusuyla alt
komut, komut seridine tasinabilir. Komut ikon cubugundaki komutlari gorintileyiniz.

e GOriinis Kiipti (5): Kiiplin Gzerindeki dilimlere ve ylzlere tiklayarak gorsel konumuna gore ekrani dén-
dariniz.

e Browser [(Unsur Agaci) (6)]: Calisma alaninin sol yaninda yer alir. Modelleme esnasinda yapilan
islemler, eksen takimlari, ¢alisma yizeyleri burada bulunur. Calisma alaninin solundaki Eye (G6z) sim-
gesini tiklayarak ¢alisma unsurlarini aginiz ve kapatiniz.

e  GOriiniim komutlari (7): Ekran kaydirma, zoom ve orbit gibi gorsel ayarlamalari yapiniz.

e Calisma Alani Ayarlari (8): Ekranin boliinmesi, 1zgara ve gorsellik ayarlarini yapiniz.
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e Timeline [(Zaman Cizelgesi) (9)]: Yeni bir dosya agilmasinin ardindan yapilan tim islem asamalarinin
gorsel olarak siralandigi bélimdiir. islemlerin herhangi birinin tizerinde sag tus mendileriyle diizenleme
yapilabilir. Solda yer alan oynatma tusu ile tiim islem asamalarinin ekranda tekrarlanmasi saglanabilir.
Timeline gorintileyiniz.

e 10. Zaman Cizelgesi Ayarlari (10): Sireg seridinin gorsel 6zelliklerini ayarlayiniz.

Uygulama: Ekran Rengi ve Goriiniim Ayarlari

Ekran rengi ile ilgili asagidaki yonergeleri uygulayiniz.
e Ekran rengini ayarlamak icin ¢aligma alani ayarlari kismindan yararlanabilirsiniz.

e Environment bashgi altinda bes sahne olarak hazirlanmis seceneklerden tercih yapabilirsiniz.

Gorsel 3.5: Ekran rengi ve gériinim

lzgara ayarlari ile ilgili
asagidaki yonergeleri uygu-
layiniz.
e |zgara ayarlarinda gecerli
olan Adaptive segimidir.
¢ Fixed secimi ile deger gi-
rerek 1zgara araliklarini
ayarlayiniz. Bu segimde,
Adaptive se¢iminden
farkl olarak ekrana yak-
lasilip  uzaklasildiginda
1zgara aralklarinin degis-
medigini gbzlemleyiniz.

Gorsel 3.6: Izgara ayarlari
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Uygulama: Snap (Kenetlenme Ayarlan)
Kenetlenme ayarlari ile ilgili asagidaki yonergeleri uygulayiz.
e Buizgara ayarlari icin Grid and Snaps > Snap to Grid kismindan yararlanabilirsiniz.
e Cizim esnasinda farenin belirli araliklarla sekme yaparak hareket etmesi icin Snap to Grid sec¢imini
yapiniz.

e (Cizim esnasinda imlecin izgaralarin koselerine kenetlenmesi igin Snap to Grid kutusunu isaretleyiniz.
3.2. Basit Parametrik Model

Dijital Giretim programi yazilimi, 6 hazir sekli hizli bicimde olusturmayi saglayan hizl sekil olusturma
aracini icerir. Bu araglar kullanilarak ti¢ boyutlu nesneler olusturulabilir.

Dijital Gretim programi ile U¢ boyutlu basit modelleme yapabilmek
icin Solid (Kati) komut ikonu penceresinde Create (Olustur) menusinin
altinda halihazirda kullanilabilecek basit modeller listelenmektedir.

Gorsel 3.7: Solid modelleme

Box (Kutu), Cylinder (Silindir), Sphere (Kiire), Torus (Simit Halkasi), Coil (Yay) ve Pipe (Boru) listede
hazir olarak kullanilabilecek basit modellerdir.

Cizilecek basit model secilip komut ¢a-
listirildiktan sonra ekrana gelen diizlem-
lerden gizim yapilacak dizlemin segilmesi
yeterlidir. Koordinat merkezi, i¢i capraz
olarak ceyrekleri dolu bir daire ile goste-
rilir. X ekseni kirmizi, Y ekseni yesil ve Z

ekseni de mavi renklidir.

Dizlemler, cizim alanindan veya unsur
agacindan secilebilir. Unsur agacindan XZ
[Front (On)], XY [Top (Ust)] veya YZ [Right

(Sag)] diizlemlerinden biri secilmelidir.

Gorsel 3.8: Diizlem segimi

Eklenen nesnenin daha sonra diizenlenmesi istenirse Browser > Bodies (Govdeler) icindeki ilgili nesne
secildiginde nesneye odaklanilir. Odaklanilan nesne mavi renklidir. Eklenen nesne secili iken ya da Timeline
akisinda ilgili islem (izerine sag tus tiklandiginda gelen meniiden Edit Feature (Ozelligi Diizenle) komutu
cahstirihr.

Fare kaydirma tekerleginin Uizerine basili tutularak Pan moduna gegis yapilir. Bu sayede tasarim ekra-
ninda saga, sola, ileri ve geri hareket edilebilir.

Fare kaydirma tekerleginin lzerine ve klavyeden Shift tusuna basili tutularak Constrained Orbit (Ser-
best Kamera) moduna gecis yapilir.

Fare kaydirma tekerlegi ileri hareket ettirilirse Zoom Out (Goriintiiyl Uzaklastir), geri hareket ettirilir-

se Zoom In (Goruntiiyl Yakinlastir) eylemleri gerceklesir.
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3.2.1. Box (Kutu)

E Uygulama: Box (Kutu) Ekleme

Cizim alanina Box eklemek igin asagidaki yonergeleri uygulayiniz.

¢ Create > Box komutunu seginiz.

e XY dizlemini secerek ¢izmek istediginiz Box nesnesinin taban yuzeyinin Width (Genislik) ve Length
(Uzunluk) degerlerini giriniz. Genislik ve uzunluk degerlerini belirledikten sonra klavyeden Enter tusuna
basarak Box nesnesini olusturunuz. Olusan kutunun genislik, uzunluk ve yiikseklik degerleri, asagidaki
resimde gorulen ok tuslari secilerek okun gosterdigi dogrultuda ileri veya geri hareketle artirihp azalti-
labilir. Ayni islem Box Palette (Kutu Paleti) penceresinden deger girilerek de yapilabilir.

Gorsel 3.9: Kutu ve kutu paleti

3.2.2. Cylinder (Silindir)

a—l Uygulama: Cylinder (Silindir) Ekleme

Cizim alanina Cylinder eklemek i¢in asagidaki yonergeleri uygulayiniz.
e Create > Cylinder komutunu seginiz.
e XY dizlemini secerek cizmek istediginiz Cylinder icin Diameter (Taban Capi) degerini giriniz.

e Fare kullanarak ya da Cylinder Palette meniisiinden cap ve ylkseklik degerlerini degistiriniz.

Gorsel 3.10: Silindir ve silindir paleti
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3.2.3. Sphere (Kiire)

Uygulama: Sphere (Kiire) Ekleme

Cizim alanina Sphere eklemek icin asagidaki yonergeleri uygulayiniz.
e Create > Sphere komutunu seciniz.
e XZ dlzlemini secerek gizmek istediginiz Sphere icin Diameter degerini giriniz.
e Fare kullanarak ya da Sphere Palette menisiinden ¢ap degerini degistiriniz.

Gorsel 3.11: Kiire ve kiire paleti

3.2.4. Coil (Yay)

Uygulama: Coil (Yay) Ekleme

Cizim alanina Coil eklemek icin asagidaki yonergeleri uygulayiniz.
e Create > Coil komutunu seginiz.
e XY dizlemini secerek c¢izmek

istediginiz Coil icin Diameter

ve Height degerlerini tasarim

alanina yerlestirirken giriniz.
e Farekullanarakyada Coil Palette

menisinden c¢ap ve yukseklik

degerlerini  degistiriniz.  Coil

Palette menisiinden ayarlar

degistirerek gdzlemleyiniz.

Gorsel 3.12: Yay ve yay paleti
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3.2.5. Torus (Simit Halkasi)

Uygulama: Torus (Simit Halkasi)

Cizim alanina Torus eklemek icin asagidaki yonergeleri uygulayiniz.

e Create > Torus komutunu seginiz.

e XY dizlemini segerek gizmek istediginiz Torus icin Diameter degerini tasarim alanina yerlestirirken
giriniz.

¢ Torus Palette mendisiinden ayarlari degistirerek gézlemleyiniz.

Gorsel 3.13: Simit halkasi ve simit halkasi paleti

3.2.6. Pipe (Boru)

Uygulama: Pipe (Boru) Ekleme
Pipe nesnesi cizebilmek iin bir Path (Yol) belirlenmelidir. Path, iki boyutlu bir tasarim nesnesi oldugu
icin once Sketch (Taslak) hazirlamak gereklidir.
Cizim alanina Pipe eklemek icin asagidaki yonergeleri uygulayiniz.
e Browser altinda Skectch cizilecek XZ dizlemini seginiz ve sag tus yaparak Create Sketch (Taslak
Olustur) komutuna tiklayiniz.
e Spline (Egri) komutunu seginiz.
e Dizleme noktalar yerlestirdikten sonra yesil daire icinde beliren tik isaretine tiklayiniz.
e Ust meniide en sagdaki Finish Sketch (Taslagi Sonlandir) komutuna tiklayiniz.
e Create > Pipe komutunu seginiz.
e Taslak olarak ¢izilen yolu Select (Se¢) komutuyla seginiz.
¢ Yol boyunca borunun ne kadarinin gizilecegini belirlemek icin Distance (Mesafe) degerini kullaniniz.
Distance degeri 0-1 arasindadir.

e Pipe Palette menusinden ayarlari degistirerek gézlemleyiniz.
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Gorsel 3.14: Boru ve boru paleti

3.3. Taslak Cizim Komutlar
3.3.1. Sketch (Taslak) Olusturma

CAD programlariyla li¢ boyutlu nesne modelleme yapabilmek icin dncelikle iki boyutlu model taslaginin
bir diizlem Uzerine ¢izilmesi gerekir. Bunun igin de taslak ¢izim komutlari ile gizime baslamadan 6nce bir
Sketch agilmalidir.

Uygulama: Sketch (Taslak) Olusturma

Taslak olusturmak icin asagidaki yonergeleri uygulayiniz.

e Komut ikon gubugu Uzerindeki Create > Create Sketch komutunu ¢alistiriniz ya da bir gizim komutu
seginiz.

¢ Dizlemleri ¢izim alanindan ya da Browser mentsiinden segebilirsiniz.

e Secimin ardindan ekran donerek ¢izim yapmaya hazir hale gelecektir.

¢ Finish Sketch diigmesine tiklayarak taslagi tamamlayiniz.

e ikinci bir Sketch aciniz.

e Onceden Sketch ile cizilmis nesneler, Browser altinda Sketches dalinda bulunur. Nesne {izerine sag
tiklayarak ekran paletinden Edit Sketch (Taslak Diizenle) secimi yapiniz.

3.3.2. Nesne iliskilendirme Modlari (Kisitlamalar)

Kisitlamalar, ¢izimin bozulmamasina yardimci olur ve 6gelerin parcalanmamasini ya da 6ngorilemeyen
alanlara tasmamasini saglar. Temelde ¢izimin seklini korumak igin nesne iliskilendirme modlari kullanilarak
gizimler yilzde yilz ongorilebilir hale getirilir. Kisitlamalar, gizimlerde degisiklik yapildiginda belirli
davranislarin korunmasina izin verir.

Uygulama: Nesne iliskilendirme Modlari

Nesneiliskilendirme iki bicimde gerceklestirilebilir. Nesne iliskilendirme islemi icin asagidaki yonergeleri

uygulayiniz.
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e Sketch ortamina girildiginde cizim yapma esnasinda calismaya baslar. Her cizim isleminde 6nceki

Birinci yol igin;

¢izim nesnelerinin referans olabilecek noktalarina kenetlenme saglanir. Cizim esnasinda kenetlenme
dogrultulari da kullanilabilir. Cizim bu dogrultulardan baslanarak sinirlandirilabilir. Kenetlenme
dogrultular siirekli kesik ¢izgi biciminde gorintilenir. Kesik gizginin gosterdigi dogrultular tiklayarak
iliskilendiriniz ve bir ¢izim nesnesi olusturunuz.

e Cizim komutlari g¢alistirildiginda otomatik nesne kenetlenmesi istenmiyorsa komut calisiyorken Ctrl
tusuna basili tutmak yeterlidir. Boylece herhangi bir kenetlenme gergeklesmez. Ctrl tusunu kullanarak
uygulayiniz.
ikinci yol icin;

e Cizim nesneleri olusturulduktan sonra da birbirleriyle iliskilendirilebilir. Sketch baslatildiginda ekranin
sag tarafinda otomatik olarak gériintiilenen Sketch Palette boliimiinden bu modlari seginiz ve ¢izim
nesnelerine tiklayarak iliskilendiriniz.

¢ Nesneiliskilendirme modlarinin ne ise yaradiginin bilinmesi 6nemlidir. Bu modlar, ¢izim sirasinda gizimi
kolaylastirir ve nesneler arasinda baglanti kurarak birbiri ile iliskilenmelerini saglar. Asagidaki modlari

sirasiyla uygulayiniz.

0 Endpoint: Baslangic veya son noktadir. Ayrica bir nokta yakalanacaksa Node (Diigiim), Endpoint
gibi islem gordr.

Midpoint: Orta nokta secer.

Center: Merkez nokta seger.

Intersection: Kesisim noktasi secer.

Extension: Bir cizginin hayali uzantisiyla hizali bir noktayi secer.

Perpendicular: Bir nesne (izerinde son segilen noktaya dik bir konum seger.

Tangent: Teget nokta secer.

Apparent Intersection: Kesismeyen iki nesnenin varsayilan kesisme noktalarini seger.

O O O O 0O o 0o o

Parallel: Bir ¢izgiye paralel baska bir ¢izgi cizmek icin kullanilr.

Kenetlenme komutlarinin timi otomatik olarak calisir ve cizim esnasinda her nesnede uygulanabilir.
Cizim esnasinda kenetlenme isleminin gerceklesmesi istenmiyorsa fare hareketleri yapilirken Ctrl tusuna
basili tutmak yeterlidir.

3.3.3. Line (Cizgi)

Line komutuna Sketch ara¢ cubugundan L kisayol tusu ya da Sketch Toolbox mentsiinden ulasilabilir.
Line komutu dogrudan veya bir Sketch agma islemi sonrasinda calistirilabilir. Komut dogrudan calistirilirsa

taslagin olusacagi cizim diizleminin gosterilmesi istenir.

Uygulama: Line (Cizgi) Cizme

Cizgi cizmek icin asagidaki yonergeleri uygulayiniz.

e Line komutunu isaretledikten sonra bir baslangi¢ noktasina tiklayiniz.

e Farenin hareketlendirilmesiyle birlikte ikinci bir nokta girilmesi (Specify next point) istenir. ikinci
noktayi tiklayiniz ve ¢izgi olusturunuz.

e Teget bir yay olusturmak icin son noktay tikladiktan sonra farenin sol tusuna basili tutarak bir yay
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hareketi yapiniz.

e ikinci ¢izgi icin Line komutunu isaretledikten sonra bir
baslangi¢ noktasina tiklayiniz.

e ilk noktayi tikladiktan sonra ekranda farenin hareketini
takip ederken iki adet o6lci kutucugu belirir. Bu
kutucuklara cizgi boyu ve ac¢i degerini girerek bir cizgi
olusturunuz.

Gorsel 3.15: Cizgi olusturma

7 _Uygulama: Cizginin Uzunlugunu Degistirme
Cizginin boyunu degistirmek i¢in asagidaki yonergeleri uygulayiniz.
e Bir deger girerek cizgi olusturunuz. Cizgi Gzerinde bir ol¢l gorulecektir.
e Olglyi cift tiklayiniz. Deger kutucugu goriiniir hale gelecektir.
e Olgli degerini degistiriniz. Bdylece cizgi boyu degisecektir.
ki noktay tiklayarak yeni bir ¢izgi olusturunuz.
e (D) Sketch Dimension kisayoluna basarak oOlci veriniz. Bu 6l¢u ¢ift tiklanarak degistirilebilir.

Uygulama: Line Komutuyla Yay Cizmek

Line komutuyla yay cizmek icin asagidaki yonergeleri uygulayiniz.
e Cizimin son noktasini belirleyiniz.
e Son noktayi yerlestirirken farenin sol tusuna basili tutarak bir yay hareketi olusturunuz.
e Farenin sol tusunu yayin bitis noktasinda birakiniz.
e (izilen gizgiile yayin teget olduguna dikkat ediniz.

Uygulama: Cizgiyi Construction Line Haline Getirmek

Line komutu ile gizilen gizgiyi yardimci geometriye donistiirmek icin asagidaki yonergeleri uygulayiniz.
¢ Line komutunu cahstiriniz.
e Komut yardimiyla bir ¢gizgi olusturunuz.
e Farenin sag tusu ardindan OK ya da ESC tusuna basarak Line komutundan ¢ikiniz.
e (Cizilen gizgiyi seginiz.
e Sketch Palette meniisiinden Construction secenegini isaretleyiniz ya da X kisayol tusuna basiniz.

Taslak ¢izimde herhangi bir geometri, yardimci geometri haline dontstilrilmek istenirse ayni

adimlar uygulanir.

3.3.4. Circle (Daire)

Daire komutu, komut ikon ¢ubugundan Sketch basliginin altindan c¢alistirilabilir. Klavyede C kisayolu

tusuna basildiktan sonra daire gizimi icin komutlar Sketch Palette menistinden gorintilenir.
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Uygulama: Merkez ve Yaricap Gostererek Daire Cizme

Merkez ve yarigap gostererek daire gizmek igin asagidaki yonergeleri uygulayiniz.
e C(Circle > Center Diameter

Circle komutunu calistiriniz.
e Dairenin ¢apini Olgllendirerek

olusturunuz.

Gorsel 3.16: Merkez yaricap géstererek daire ¢izme

Uygulama: iki Nokta Gostererek Yeni Daire Gizme

iki nokta gostererek yeni
daire cizmek icin asagidaki
yonergeleri uygulayiniz.
e Circle > 2-Point Circle ko-
mutunu ¢ahstiriniz.
e Ekranda iki nokta (cap ge-

nisligi kadar) gosteriniz.

Gorsel 3.17: iki nokta géstererek daire cizme
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Uygulama: U¢ Nokta Gostererek Bir Daire Cizme

U¢ nokta goste-
rerek bir daire g¢izmek
icin asagidaki yonerge-
leri uygulayiniz.

e Circle > 3-Point
Circle komutunu
cahstiriniz.

e Ekranda lg nokta

gosteriniz.

Gorsel 3.18: Ug¢ nokta géstererek daire ¢cizme
3.3.5. Arc (Yay)

Yay komutu, komut ikon gubugundan Sketch basliginin altindan ¢alistirilabilir. Komut ikon cubugundaki
Sketch menisiinde Arc komutu altinda Gg¢ ayri komut oldugu gorilebilir. Komutun {i¢c secim yontemi vardir.

Uygulama: iki Ug ve Bir Orta Nokta Gosterilerek Yay Cizme

iki ug ve bir orta nokta gosterilerek yay ¢izmek
icin asagidaki yonergeleri uygulayiniz.

e Arc > 3-Point Arc komutunu galistiriniz.

e Baslangic ve bitis noktalarini isaretleyiniz.
isterseniz  baslangic ve bitis noktalari
arasindaki kiris mesafesini giriniz.

e Yayin orta (kubbe) noktasini olusturacak
noktayi isaretleyiniz.

Gorsel 3.19: ki ug ve bir orta nokta gésterilerek yay cizme
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Uygulama: Merkez, Yarigap ve Bitis Noktalarini Gostererek Yay Cizme

Merkez, yarigcap ve bitis noktalarini gbstererek yay cizmek icin asagidaki yonergeleri uygulayiniz.
e Arc > Center Point Arc komutunu

cahistiriniz.
e Yay merkezini gosteriniz.
e Yayin vyaricapini ve bitis noktasini

gosteriniz. Istediginiz takdirde bitis

noktasina agi degeri vererek de

¢izimi gerceklestirebilirsiniz.

Gorsel 3.20: Merkez, yarigap ve bitis noktasi (agi) gbstererek yay gcizme

Uygulama: Cizgiye Teget Yay Cizme

Cizgiye teget yay c¢izmek igin

asagidaki yonergeleri uygulayiniz.

e Bir ¢izgi giziniz.

e Arc > Tangent Arc komutunu
cahstiriniz.

e (izginin ucunu teget noktasi
olarak seginiz.

e Arc bitis noktasini isaretleyiniz.

Gorsel 3.21: Cizim elemanin (teget) ucu, bitis noktas ile yay gizme
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3.3.6. Rectangle (Dikdortgen)

Dikdortgen ¢izmek icin Rectangle komutu kullanilir. R, kisayol tusudur. Dikdértgen gizimi tg yontemle
yapilabilir.

Uygulama: iki Nokta Gostererek Dikdoértgen Cizme

iki nokta gostererek dikdértgen

¢izmek icin asagidaki yonergeleri uy-

gulayiniz.

e Rectangle > 2-Point Rectangle
komutunu calistiriniz.

e Capraz iki kose noktasini
isaretleyerek dikdortgeni giziniz.

e Kenar Olgllerini cizimden son-
ra dizenleyiniz. Cizim sirasinda
TAB tusu yardimiyla kenar 6l¢i-
leri arasinda gegis yapabilirsiniz.
Klavyeden deger vererek dik-

dortgeni cizilebilirsiniz.
Gorsel 3.22: ki nokta ile dikdértgen cizme

Uygulama: Ug Nokta Gostererek Yeni Bir Dikdortgen Cizme

Ug¢ nokta gostererek yeni
bir dikdoértgen ¢izmek igin asa-
gidaki yonergeleri uygulayiniz.
e Rectangle > 3-Point Rec-

tangle alt komutunu calis-

tiriniz.
e Dikdortgenin  lic  kose
noktasini sirasiyla ekran

Uzerinde isaretleyiniz.

Gorsel 3.23: Ug nokta ile dikdértgen ¢izme
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Uygulama: Merkez Noktasiyla Yeni Bir Dikdortgen Cizme

Merkez noktasiyla yeni bir
dikdortgen gizmek icin asagidaki
yonergeleri uygulayiniz.

e Rectangle > Center Rectangle
komutunu calistiriniz.

e Ekran Uzerinde dikdortgenin
merkez noktasini segerek kose
noktasini isaretleyiniz.

e Cizim olcllerini dizenleyiniz.

Gorsel 3.24: Merkez noktasiyla dikdértgen ¢izme
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3.3.7. Slot (Kanal)

Kanal olusturmak icin birden fazla yontem vardir.

Uygulama: iki Eksen Arasi Olgiiyle Yarigap Olgiisiinii isaretleyerek Kanal Cizme

iki eksen arasi 6lclyle vyari-
cap Olclslinl isaretleyerek kanal
cizmek icin asagidaki yonergeleri
uygulayiniz.
e Slot > Center To Center Slot ko-
mutunu ¢alistiriniz.
e Eksenler arasi mesafeyi belirle-
mek i¢in noktalari isaretleyiniz.
e Kanalin yarigap 6l¢tist olan nok-
tay! (Deger penceresine oOl¢l de

yazilabilirsiniz.) isaretleyiniz.

Gorsel 3.25: ki eksen arasi 6lciiyle yaricap élciisiinii isaretleyerek kanal cizme

Uygulama: Merkez, Eksen Noktasi ve Yarigapla Kanal Cizme

Merkez, eksen nok-
tas! ve yaricapla kanal
¢izmek igin asagidaki
yonergeleri  uygulayi-
niz.

e Slot > Center Point
Slot komutunu ca-
histiriniz.

e Merkez noktayi isa-
retleyiniz.

e Eksenlerin 6lg¢Usi-
ndn yarisi olan me-
safeyi  belirlemek
icin diger noktayi
isaretleyiniz.

e Kanalin yaricap ol-

Gorsel 3.26: Merkez, eksen noktasi ve yaricapla kanal ¢izme cisii olan noktayi

isaretleyiniz.
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Uygulama: iki Ug Noktasi ve Yarigapla Kanal Cizme

iki u¢ noktasi ve yaricapla kanal
cizmek icin asagidaki yonergeleri uy-
gulayiniz.
e Slot > Overall Slot komutunu ¢a-
histiriniz.
e ki nokta ile Slot ug¢ noktalarini
isaretledikten sonra yaricap 6l¢i-
sl olan noktay! belirleyiniz.

Gorsel 3.27: iki u¢ noktasi ve yaricapla kanal ¢izme

3.3.8. Polygon (Cokgen)

Polygon, eskenar cokgenler cizmek icin kullanilan komuttur. Eskenar cokgenlerin ti¢ ¢izim yontemi vardir.

Uygulama: Daire Disina Cokgen Cizme

Daire disina cokgen cizmek igin asagidaki yénergeleri uygulaymiz. 7
e Oncelikle bir daire giziniz.
e Polygon > Circumscribed Polygon komutu-

nu ¢alistiriniz.
e Dairenin merkez noktasini isaretleyiniz.
e Acilan deger penceresine ¢okgenin kenar

saylisini yaziniz.
ki nokta ile dairenin merkezini ve yarigapi-

ni isaretleyiniz.

Gorsel 3.28: Daire disina ¢okgen ¢izme
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Uygulama: Daire igine Cokgen Gizme

Daire icine ¢cokgen ¢izmek icin asagidaki
yonergeleri uygulayiniz.
¢ Polygon > Inscribed Polygon komutunu
calistiriniz.
e Dairenin merkez noktasini isaretleyiniz.
e Acilan deger penceresine ¢okgenin ke-
nar sayisini yaziniz.
e ikinokta ile dairenin merkezini ve yarica-

pini isaretleyiniz.

Gorsel 3.29: Daire icine ¢okgen ¢izme

Uygulama: Kenar Boyutunu Vererek Cokgen Cizme

Kenar boyutunu vererek ¢cokgen cizmek icin asagidaki yonergeleri uygulayiniz.
e Polygon > Edge Polygon alt komutunu
cahstiriniz.
e Dairenin merkez noktasini isaretleyi-
niz.
e Acilan deger penceresine ¢okgenin ke-
nar sayisini yaziniz.
e iki nokta ile dairenin merkezini ve yari-

capini isaretleyiniz.

Gorsel 3.30: Kenar boyutunu vererek ¢cokgen ¢izme

3.3.9. Ellipse (Elips)

Bir merkez, dar ve genis ug Olguleri verilerek elips gizilebilir.
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Uygulama: Ellipse (Elips) Cizme

e Ellipse komutunu ¢alistiri-
niz.

e ilk nokta ile elipsin
merkezini isaretleyiniz.

e Diger iki nokta ile elipsin
dar ve genis uglarini isaret-
leyiniz.

Gorsel 3.31: Elips ¢izme

3.3.10. Conic Curve (Konik Egri)

Conic Curve, bir koninin kesit ayriti demektir. Disli ¢cark yuvarlanma yiizeylerinin, dis profillerinin
ciziminde kullanilir. Baslangig, bitis noktalarinin ve odak uzakliginin isaretlenmesiyle olusturulur.

Uygulama: Conic Curve (Konik Egri) Cizme

e Conic Curve komutunu calistiriniz.

e ki nokta ile egrinin u¢ noktalarini
isaretleyiniz.

e Egrinin u¢ noktasinin ylkselecegi
yondeki noktayi isaretleyiniz.

Gorsel 3.32: Konik egri ¢cizme
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Spline, farkli noktalar ya da dogrulardan gecen birlesik egriler cizmek igin kullanilir. isaretlenen

3.3.11. Spline (Egri)

noktalardan gecen egriler ekranda cizilebilir. Olusan isaretleme noktalari ve egri teget cizgileri
Olculendirilerek parametrik sinirlar verilebilir.

Uygulama: Spline (Egri) Cizme

Egri cizmek i¢in asagidaki yo-
nergeleri uygulayiniz.

e Spline komutunu galistiriniz.

e Onceden belirlenmis nokta-
lara ya da ekrandaki belirli
yerlere istenilen siklikta isa-
retleme yapiniz.

e Yesil daire icinde yer alan tik
semboliine tiklayarak Spline
nesnesini tamamlayiniz.

e Egri Uzerindeki noktalarin
konumu degistirilebilir.
Noktanin Ustiinde goriinen
Anchor (Capa) dogrularinin Gérsel 3.33: Egri cizme

uclarini  ¢ekerek egrinin

noktalarda yaptigi kavis hare-

ketini yeniden diizenleyiniz.

Gorsel 3.34: Egri diizenleme

Uygulama: Kontrol Noktali Egri Cizme

Secilen kontrol noktalari tarafindan yonlendirilen bir Spline olusturur. Kontrol noktal egri ¢cizmek icin
asagidaki yonergeleri uygulayiniz.
e Spline komutunu galistiriniz.
e Egriyi baslatmak icin ilk noktayi seginiz.
e Kontrol noktalari olarak ek noktalar seginiz ve gizime
devam ediniz.
e Tik semboliine tiklayarak gizimi tamamlayiniz.

Gorsel 3.35: Kontrol noktali egri
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3.3.12. Text (Metin)

Bir baslangi¢c noktasi gosterilerek istenilen 6zellikte yazi olusturulabilir.

Uygulama: Text (Metin) Olusturma

Metin olusturmak icin asagidaki yonergeleri uygulayiniz.
e Text komutunu galistiriniz.
e [saretlenen nokta ile ekranda beliren yazi alanina bir metin yaziniz.

¢ Text Palette menisiinden ayarlari degistirerek metni gézlemleyiniz.

Gorsel 3.36: Metin olusturma
3.3.13. Point (Nokta)

Point; cizim ortamina noktalar yerlestirmek, ¢izim ortaminda olusturulan noktalarin delik merkezlerini
belirlemek, egri giziminde kilavuzluk etmek gibi islemlerde kullanilabilir. Cizim elemanlari tizerine noktalar
yerlestirilebilir, dlctlendirilebilir veya parametrik sinirlamalar yapilabilir.

3.3.14. 3D Sketch (Ug¢ Boyutlu Taslak)

3D Sketch olusturmadan once Preferences (Tercihler) > Design (Tasarim) > Allow 3D Sketching of
Lines and Splines (Dogru ve Egrilerle 3D Taslak Olusturmasina izin Ver) secenegi isaretlenmelidir. 3D
Sketch; U¢ boyutlu ¢izgi, egri, daire, yay ve dikdortgen gizmek igin kullanihr.

Uygulama: 3D Sketch (Ug Boyutlu Taslak) Olusturma

Ug boyutlu taslak olusturmak icin asagidaki yo-
nergeleri uygulayiniz.
e Bir Sketch olusturarak dikdértgen giziniz.
¢  Boyu 50 mm, eni 70 mm olacak sekilde dikdortge-
ni olculendiriniz.
¢  Finish Sketch komutu ile Sketch olusturunuz.

Gorsel 3.37: Dikdértgen olusturma
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e Bu dikdortgene belli bir
uzaklikta asagi ya da yukari
yonde Offset Plane (Diizle-
mi Otele) komutu ile Plane
olusturunuz.

¢ Plane Uzerinde bir Sketch
olusturarak Project (P) ko-
mutu ile dikdortgenin ke-
narlarini izdlstriniz.

e Taslagi kapatiniz.

o  GOrUnUimu izometrik hale Gorsel 3.38: Diizlem étele
getiriniz.

e Spline komutunu c¢alsti-
riniz. Noktalari gorseldeki
gibi ilk dikdortgenin kose-
sinden baslayarak isaretle-
yiniz.

e Son noktayi isaretlediginiz-
de Enter tusu ile islemi son-

landiriniz.

Gorsel 3.39: izdiisim

Gorsel 3.40: Ug boyutlu taslak

3.3.15. Fillet (Yuvarlatma / Kavis)

Fillet daha ¢ok keskin koseleri yuvarlatmak icin kullaniimaktadir. Yuvarlatilacak nesnelerin kesismesi

sart degildir. Yuvarlatilacak kenar cizgilerinin secimi yeterlidir. iki ¢izgi secildikten sonra deger penceresine
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yaricap Ol¢lisu yazilarak ya da mavi ok tusu hareket ettirilerek yuvarlatma islemi yapilir. OK (Tamam)

butonuna tiklanarak islem tamamlanir.

Gorsel 3.41: Yuvarlatma

3.3.16. Trim (Budama)
Trim; birbirini kesen nesnelerden birini, digerine gore kirparak silme islemidir. Kisayolu T tusudur. Ug

bicimde budama yapilabilir.
e Ucg Gostererek Budama: Cakisan gizgilerin uglari gosterilir. Gosterilen bolim kirmizi renk alir.
e Fareyi Siiriikleyerek Budama: Farenin sol tusuna basili tutulur ve uzanti uclarinin tGzerinden gegilir.

Uglar ¢cakisma noktasina kadar budanir.
e Tek Bir Nesneyi Gostererek Budama: Silme islemine benzer. Herhangi bir ¢akisma yapmayan nesneye

tiklanarak nesnenin silinmesi saglanir.

Gorsel 3.42: Budama

3.3.17. Extend (Uzatma)

Extend, bir nesneyi baska bir nesnenin sinirina kadar uzatmak i¢in kullanilir. Modify komut nesnesinin
altinda yer alir. Nesneler gizgi, yay veya egri olabilir. Nesnelerin uzantisinin kesismesi gerekir. Uzatilacak
nesnenin Uzerine fare ile gelindiginde otomatik olarak uzayacagi sinira kadar kirmizi gizgi belirir, tiklaninca

¢izgi uzar. Cizginin uzantisinda kesisecegi baska nesneler varsa ayni islem devam eder.

Gorsel 3.43: Uzatma
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Offset; cizgileri, kenarlar, egrileri ve profilleri belirli bir mesafede 6teleyerek cogaltma islemidir.

3.3.18. Offset (Oteleyerek Cogaltma)

Uygulama: Offset (Oteleyerek Cogaltma)

Oteleyerek cogaltma islemi icin asagidaki ydnergeleri uygulayiniz.
e Modify>Offset komutunu calistiriniz. Ekrana Offset diyalog kutusu gelir.
¢ Nesne ya da nesneleri seginiz. Offset Position kismina 6teleme mesafesini yaziniz.

Oteleme yoniinii ekran iizerinde isaretleyiniz. imleci fare ile basili tutup kaydirarak Offset miktari ve
yonini elle degistirebilirsiniz.

Gorsel 3.44: Oteleyerek cogaltma

3. OGRENME BIRiMi ‘109




3.3.19. Mirror (Aynalama)

Mirror; cizgileri, kenarlari, egrileri ve profilleri belirli bir referans nesnesine gore aynalayarak cogaltma
islemidir. Endustriyel Griinler genellikle simetrik olarak tasarlandigi icin ¢ok sik kullanilan bir komuttur.

Uygulama: Aynalama (Mirror) Yapma

Aynalama islemi i¢in asagidaki yonergeleri uygulayiniz.
e Bir taslak olusturunuz.
e Referans alacaginiz bir nesne ¢iziniz. Referans nesnesi olarak bir dogru cizebilirsiniz.
Cizgi secili iken Sketch Panel mentsinden Construction ifadesine tiklayiniz ve ¢izdiginiz dogruyu kesik
cizgili hale donlstiriniz (Kesik ¢izgi yardimci geometridir, tasarimin bir pargasi degildir.).
¢ Komut ikon cubugu altinda Create > Mirror komutunu seciniz.

Gorsel 3.45: Aynalama

e Aynalanacak nesneyi ve Mirror Line (Aynalama Dogrusu) seciniz.
e OK tusuna basiniz.

’ Sira Sizde 4

Asagida olglleri verilen sekli dijital Gretim programinda giziniz.
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Circular Pattern, secilen nesneleri bir eksen etrafinda dairesel olarak ¢ogaltmak igin kullanilir.

3.3.20. Circular Pattern (Dairesel Cogaltma)

Uygulama: Dairesel Cogaltma

Dairesel cogaltma yapmak icin asagidaki yonergeleri uygulayiniz.

Circular Pattern komutunu galistiriniz.

Objects ile donddrilecek nesneyi seginiz.

Dondirme merkezi olarak ekranda olusturulmus bir nokta veya koordinat merkezi seginiz.

Type ile acisal, tam dairesel ya da simetrik secim yapiniz.
e Suppress secimiyapilirsa ¢cogaltilan nesnelerin yaninda onay kutucuklari gikar. Bu kutucuklarin isaretini
kaldirarak ¢ogaltilan nesneyi silebilirsiniz.

Quantity kismina ¢ogaltma adedini giriniz.

OK tusuna basarak islemi tamamlayiniz.

Gorsel 3.46: Dairesel ¢codaltma
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3.3.21. Rectangular Pattern (Dikdortgensel Cogaltma)

Rectangular Pattern, bir nesnenin verilen satir ve siitun sayisinda dikdortgensel olarak ¢ogaltiimasi
icin kullanilir. Sadece bir yon verilerek ¢ogaltma yapilirsa dogrusal ¢ogaltma, iki yon verilerek ¢ogaltma
yapilirsa dikdortgensel ¢ogaltma adini alir.

Uygulama: Dikdértgensel Cogaltma

e Rectangular Pattern komutunu galistiriniz.

e (Cogaltilacak nesneyi seciniz ya da komutu galistirdiktan sonra Objects kismini tiklayarak nesne segimini
yapiniz.

e Direction/s secimi ile ekrandaki oklar yatay ve dikey olarak siriklenebilir. Tek yonde ¢ogaltma icin
sadece o yondeki ok isaretini siirlikleyiniz.

¢ Distance Type alaninda adim ya da ¢ogaltilacak boy se¢imini yapiniz.

e Quantity kisimina ¢ogaltilan nesnelerin adedini yaziniz.

e Distance bolimiine ¢cogaltma yapilacak boyu yazabilirsiniz.

e Direction Type alaninda simetrik ya da tek yonli segim yapabilirsiniz.

Gorsel 3.47: Dikdértgensel cogaltma

3.3.22. Move / Copy (Tas! / Kopyala)

Move / Copy; cizim alani Uzerindeki nesne ya da nesneleri ve nesnelerin detaylandirmalarini bir

noktadan baska bir noktaya tasimak, kopyalamak ve déndirmek icin kullantlir.

Uygulama: Tasi / Kopyala

Tas! / Kopyala islemi icin asagidaki yonergeleri uygulayiniz.
e Komutu c¢alistiriniz. Ekrana Move / Copy diyalog kutusu gelir.

e Selection kismindan tasinacak nesneleri seginiz.
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e Move Type (Tagima Tiri) kisminda Free Move (Serbest Tasima), Translate (XYZ Eksenlerine
Donustiir), Rotate (D6ndiir), Point to Point (Noktadan Noktaya Tasi), Point to Position (Noktadan
Konuma Tasima) seceneklerini segebilirsiniz.

e Set Pivot ile yeni bir tutma noktasi belirleyiniz.

e XYZ Distance kisminda nesnenin XYZ eksenlerine olan mesafesini belirleyiniz.

e XYZ Angle kisminda nesnenin XYZ eksenleri ile arasindaki aci degerini giriniz.

e Create Copy kutucugunu isaretlerseniz nesnenin siiriiklendigi yerde bir kopyasini olusturabilirsiniz.

e Ok yonleriyle veya kiiglk bir kare bicimindeki digmeden tiklayarak stiriikleme yapabilirsiniz.

¢ Nesnenin tasinacak noktasini farenin sol tusuna basili tutarak seginiz. Bu noktadan basili tutup nesneyi

surlikleyerek istenilen yere birakiniz.

Gorsel 3.48: Tasi

3.3.23. Scale (Olgeklendirme)

Scale, cizim alani Uzerindeki nesne ya da nesneleri bir nokta merkez alinarak belirlenen dlcekte

blylltmek ya da kiigtiltmek amact ile kullanihr.

Uygulama: Olgeklendirme

Olgeklendirme yapmak icin asagidaki yonergeleri uygulayiniz.
e Komutu galistiriniz. Ekrana Sketch Scale diyalog kutusu gelir.
e Entities kismindan 6l¢eklendirilecek nesneyi seginiz.
e Point kismindan Olgeklendirme islemi igin referans noktasi seginiz.
e Scale Factor kismina dlgeklendirme faktorini (biyiltme ya da kiiglltme miktarini) yaziniz.

e OKtusuna basiniz.
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Gorsel 3.49: Olceklendirme
3.3.24. Sketch Dimension (Olgiilendirme)

Sketch Dimension, bir ya da daha ¢ok nesneyi dlgiilendirmek igin kullanilir. Cizilen nesnelerin élgulerini
dahasonradegistirmek miimkiindir. Olgiilerde yapilan degisiklikler otomatik olarak geometrinin konumuna

ve blylikligine yansir. Butlin 6l¢tlendirme gesitlerini tek 6l¢liilendirme komutu ile yapma imkani sunar.

Uygulama: Olgiilendirme

Olgiilendirme yapmak icin asagidaki ydnergeleri uygulayiniz.

e Sketch Dimension komutunu galistiriniz.

e Olciilendirilecek nesneyi seginiz. Ol gizgisini yerlestirince ekrana deger diyalog kutusu gelir.

e stenilen dlgliyii yazip Enter tusuna basiniz. Olgiilendirilecek baska bir ¢izim elemani varsa ona tiklayarak
olgllendirmeye devam ediniz.

o iki dogru arasindaki aciyi da él¢ilendirebilirsiniz.

¢ D kisayol tusuna basiniz. Sketch Dimension aktif iken birinci dogruya, ardindan ikinci dogruya tiklayiniz.

e Dogrular arasindaki agi Olgislini girerek degistiriniz.

Gorsel 3.50: Olciilendirme

3.3.25. Split Body / Split Face (Kesisim Egrisi)
Split Body / Split Face; secilen gévdeleri bir profil, yiiz veya diizlem kullanarak béler ve yeni gévdeler olusturur.
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Kesisim egrisinin kullanimi igin
asagidaki yonergeleri uygulayiniz.
e XY dizleminde bir Box olustu-

runuz.

e Construct > Midplane komutu-
nu ¢alistiriniz.

e Kutunun alt ve Ust tabanlarini
seciniz. Secilen bu iki dizlem
arasinda bir orta diizlem olus-

turulur.

Gorsel 3.51: Orta diizlem olusturma

e Maodify > Split Body komutunu
calistiriniz.

¢ Body to Split olarak béliinmesi
istenen govdeyi seginiz.

e Splitting Tool(s) olarak Cons-
truct > Midplane komutu ile
olusturulan, modeli kesen orta
dizlemi seginiz.

e OK tusuna basarak islemi

tamamlayiniz.

Gorsel 3.52: Split body

Uygulama: Split Face (Kesisim Egrisi)

Kesisim egrisinin kullanimi icin asagidaki yonergeleri uygulayiniz.
e XY diuzleminde bir kiire olusturunuz.
e XZ dizleminde bir Sketch olusturunuz.
e Spline komutu ile egri giziniz.
e (izgi ya da egri nesnelerini ylizey nesnesine ¢evirmek icin Surface (Yizey) komut ikon penceresini
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secerek altindaki Create > Extrude komutunu galistiriniz.
e OK tusuna basarak islemi tamamlayiniz.

Gorsel 3.53: Egri ile yiizey olusturma
e Nesneyi seginiz.
e Egriile olusturulan ylizeyi seginiz.
e OKtusuna basarak islemi tamamlayiniz.

Gorsel 3.54: Egri ile gbvde béime

3.4. Komut Yardimiyla Objeler Olusturma

Dijital Gretim programinda gesitli komutlar yardimiyla yeni nesneler olusturulabilir.
3.4.1. Profil Nesnelerini Dondiirerek Yeni Nesne Olusturma

Dijital Uretim programinda iki boyutlu cizimler belirli yéntemlerle bir eksen etrafinda dondurulerek
yeni nesneler olusturulabilir.
3.4.1.1. Revolve (Dondiirerek Nesne Olusturma)

Revolve, iki boyutlu nesneleri belirlenen bir eksen etrafinda dondirerek yeni bir nesne olusturma
komutudur. Dondiirme ekseni siirekli cizgi veya eksen cizgisi olabilir.
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Revolve komutunu kullanarak 80 cm ¢apinda yuvarlak masa tablasi olusturmak icin
asagidaki yonergeleri uygulayiniz.

e XY dizlemini segerek asagida dlguleri verilen iki boyutlu sekli giziniz.

e  Sekli ¢izdikten sonra Finish Skecth tiklayiniz.

Gorsel 3.55: ki boyutlu cizim

e Create > Revolve komutunu seginiz.
e Dondurulecek Profile (Profil) ve Axis (Eksen)’i seginiz.

e OK tusuna basarak islemi tamamlayiniz. Calismanizi kaydediniz.

Gorsel 3.56: Yuvarlak masa tablasi

3.4.1.2. Sweep (Yol Kullanarak Nesne Olugturma)

Sweep, secilen kapali bir geometrinin kapali ya da acik bir yolu slpirerek nesne olusturmasi igin
kullanilan komuttur.

Uygulama: Késegen Dolap Kulpu Olusturma

Sweep komutunu kullanarak 7,5 cm uzunlugunda,

1 cm genigliginde dolap kulpu
olusturmak icin asagidaki yonergeleri uygulayiniz.
e XY dizlemini secerek 25 mm yiksekligi, 75 mm
uzunlugu olan ters U bicimindeki sekli giziniz.

Gorsel 3.57: jki boyutlu cizim
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e XY dizleminde sekli cizdikten sonra Fillet komutu ile R10 olacak sekilde yuvarlayiniz. Sekli cizdikten
sonra Finish Skecth tiklayiniz.

e XZ diizlemini secerek 5 mm yaricapinda bir altigen ¢iziniz.

e Sekli ¢cizdikten sonra Finish Skecth tusuna tiklayiniz.

e Create > Sweep komutunu segerek Profile (Profil) olarak XY diizleminde ¢izdiginiz sekli ve Path (Yol)
olarak XZ diizleminde cizdiginiz sekli seginiz.

e OK tusuna basarak islemi tamamlayiniz. Calismanizi kaydediniz.

Gorsel 3.58: Sweep komutu

Yandaki resimde gorduglinlz cay fincani ve tabagini
tasarlayiniz. Cay fincani 60 mm yilksekliginde (taban
yaricapli 20 mm, agiz yaricapi 60 mm), tabagi 5 mm
yuksekliginde olmalidir.

3.4.1.3. Loft (Profiller ve Yiizeyler Arasinda Nesne Olusturma)

Loft, farkll diizlemlerde ve taslaklarda cizilmis profiller arasina malzeme atayarak nesne olusturur.
Komutun kullanilabilmesi icin profillerin kapali olmasi ve farkl diizlemlerde cizilmesi gerekir.
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http://kitap.eba.gov.tr/KodSor.
. php?KOD=21378
Uygulama: Dolap Ayagi Olusturma

Loft komutunu kullanarak taban yarigapi 3,5 cm altigen, ortasi 60 mm g¢apinda ve 90 mm uzunlugunda

dolap ayagi olusturmak icin asagidaki yonergeleri uygulayiniz.

e XY dizlemini segcerek 35 mm yaricapinda bir altigen giziniz.

e Sekli cizdikten sonra Finish Skecth tiklayiniz.

e Construct > Offset Plane seciniz ve XY diizlemine 40 mm uzaklikta yeni bir diizlem olusturunuz. Bu
dizlemde 40 mm g¢apinda bir daire giziniz.

e Construct > Offset Plane seciniz ve XY dizlemine 25 mm uzaklikta yeni bir diizlem olusturunuz. Bu
diizlemde 60 mm c¢apinda bir daire giziniz.

Gorsel 3.59: Offset Plane olusturma

e Construct > Offset Plane seciniz ve XY dlizlemine 25 mm
uzaklikta yeni bir dizlem olusturunuz. Bu dizlemde 50
mm genisliginde bir altigen ciziniz.

e Create > Loft komutunu secip ilk ¢izdiginiz profilden
baglayarak sirasiyla profil gizimlerini seginiz.

Gorsel 3.60: Cizimlerin gériinimii
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Gorsel 3.61: Loft komutu ile nesne olusturma

Profillerin secim sirasina dikkat edilmelidir. Se¢im sirasi farkli olursa istenilen nesne elde
edilemeyecektir.

Gorsel 3.62: Loft komutu ile nesne olusturma segim sirasi degisirse farkli bir nesne olusumu
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3.4.2. Profil Nesnelerinde Destek Elemani (Payanda) Olusturma

Dijital Uretim programinda gerekirse belirli yontemlerle nesnelerin (zerine destek elemanlari

olusturulabilir.

3.4.2.1. Rib (Nesneler Arasinda Diisey Tasiyici Olusturma)

Rib, nesneler Uzerinde gerekli olan yerlerde payanda (destek elemani) olusturmak icin kullanilr.
Payanda Sketch ortaminda cizilen bir gizgi, yay, egri ya da daire olabilir.

Masa ayagini gliglendirmek amacli bir payanda olusturmak igin asagidaki yonergeleri uygulayiniz.

e XY dizlemini secerek kenar uzunlugu 300 mm olan bir kare ¢iziniz. Sekli cizdikten sonra Finish Skecth
tiklayiniz.

e E kisayol tusuyla Extrude komutunu ¢alistiriniz ve gizdiginiz sekle 40 mm kalinlik veriniz.

e Create > Cylinder seginiz ve tablanin orta noktasina 150 mm gapinda, 60 cm uzunlugunda silindir
olusturunuz.

e Construct > Midplane (Orta Diizlem) komutunu kullanarak iki ylzey ortasina yeni bir dizlem

olusturunuz.

Gorsel 3.63: Midplane (orta diizlem) olusturma

e Olusturdugunuz orta dizleme L kisayol tusunu kullanarak tablanin dis ylzeyinden 20 mm uzaklikta

120° aglyla silindiri kesen bir yardimci dogru pargasi ¢iziniz.

Gorsel 3.64: Payanda igin yardimci dogru pargasi ¢izimi
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e Tablanin diger ylziine gelerek dig
ylzeyinden 20 mm uzaklikta 60°
actyla silindiri kesen bir yardimci

dogru pargasi giziniz.

Gorsel 3.65: Payanda igin nesnenin diger yanina yardimci dogru pargasi gizimi

e Create > Rib komutunu seginiz.
Curve olarak cizdiginiz yardimci
dogruyu seciniz.

e Thickness degerini 30 mm olarak

veriniz.

Gorsel 3.66: Rib komutu ile payanda olusturma
e Ayniislemi diger yardimci gizgi icin de gergeklestiriniz.

e OKtusuna basarak islemi tamamlayiniz. Calismanizi kaydediniz.

3.4.2.2. Web (Nesneler Arasinda Destek Elemani Olusturma)

Web, nesneler lizerinde gerekli olan yerlerde destek elemani olusturmak igin kullanilir. Destek elemani
Sketch ortaminda gizilen bir gizgi, yay, egri ya da daire olabilir.

http://kitap.eba.gov.tr/KodSor.

php?KOD=21380 n ks

Uygulama: Cizgi izleyen Araba Tekerlegi Cizimi

Cizgi izleyen araba tekerlegi olusturmak icin asagidaki yonergeleri uygulayiniz.
e XY diizlemini secerek asagida 50 mm c¢apinda bir daire giziniz. Sekli ¢izdikten sonra Finish Skecth
tiklayiniz.
e O kisayol tusu ile gizdiginiz daireyi 4 mm disa dogru ofsetleyiniz.

e E kisayol tusu ile gizdiginiz sekle 30 mm kalinlik veriniz.
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Gorsel 3.67: Extrude ile kalinlik verme

e XY dizleminde Sketch olusturunuz ve Line komutu ile merkezden daireye bir dogru pargasi giziniz ve
Circular Pattern komutu ile 6 adet ¢ogaltiniz.

Gorsel 3.68: Sketch ortaminda dodru pargasi ¢izimi ve ¢cogaltma
e Create > Web komutunu seginiz.
Curve olarak ¢izdiginiz dogru
parcalarini seginiz. Depth Options
olarak Depth seginiz. Thickness
degeri olarak 2 mm, Depth degeri
olarak 15 mm giriniz.

Gorsel 3.69: Web komutu ile destek elemanlarini olusturma
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e Create > Hole komutunu seginiz. Origin noktasinda bir
delik olusturunuz. Delik ¢capi olarak 2 mm giriniz ve uzun-
luk olarak All seginiz.

e OKtusuna basarak islemi tamamlayiniz. Calismanizi kay-
dediniz.

Gorsel 3.70: Hole komutu ile delik agma

3.4.3. Profil Nesnelerini Cogaltma

Dijital Gretim programinda istenilen nesneler ve 6zellikler belirli yéntemlerle ¢ogaltilabilir.

3.4.3.1. Govdeleri Tagima / Kopyalama / Déndiirme

Cizim alanindaki nesnelerin konumlarini degistirmek igin kullanilir. Modeller tasinir, kopyalanir,
dondirilar ya da diger modellerle iliskilendirilir.

Uygulama: Cizilen Bir Nesnenin Taginmasi / Kopyalanmasi

Belirlenen nesneyi tasima ve kopyalama islemlerini yapmak igin asagidaki yonergeleri uygulayiniz.
e Box komutu ile bir kutu, Cylinder komutu ile bir silindir olusturunuz.
e Modify > Move / Copy komutunu seginiz.
e Silindirik pargayi seciniz. Fare yardimiyla ya da XYZ eksenlerinden tasimak istediginiz mesafeyi giriniz
ve kutunun yanina tasiyiniz.
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Gérsel 3.71: Move / Copy komutuyla tasima islemi

e ki parcanin belirlenen noktalardan birlestiriimesi icin Move diyalog kutusundan Move Type olarak
Point to Point komutunu seciniz.

e Origin Point icin silindirin orta noktasini seginiz.

e Target Point icin kutu ylizeyinin orta noktasini seginiz.

Gorsel 3.72: Move / Copy komutuyla Point to Point tasima islemi
e Kopyalama islemi yapmak icin Move Object olarak Bodies seciniz. Kopyalanacak govde nesnesini
seginiz.
¢ Diyalog kutusundan Create Copy isaretleyiniz.
e GoOvde nesnesinin kopyalanacagl mesafeyi giriniz ya da fare yardimiyla gévdeyi istenilen yere surikleyip

birakiniz.

Kopyalama islemi icin kopyalanacak parga secildikten sonra Create Copy isaretlenmelidir

—————

yoksa tasima islemi yapilmis olur.
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Gorsel 3.73: Move / Copy komutuyla Point to Point kopyalama islemi

3.4.3.2. Rectangular Pattern (Dogrusal veya Dikdortgensel Cogaltma)

Rectangular Pattern; nesneleri, ylizeyleri ya da kati gévdeleri dogrusal olarak belirlenen mesafede ve
sayida ¢ogaltmak icin kullanilir. Tek yénde islem yapilirsa dogrusal ¢ogaltma yapar. ikinci yon segilir ve iki
yonde islem yapilirsa dikdortgensel cogaltma yapar.
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Uygulama: Cizilen Bir Nesnenin Dogrusal Olarak Cogaltilmasi
Gizilen bir nesnenin dogrusal
olarak ¢ogaltilmasi icin asagidaki
yonergeleri uygulayiniz.
e Daha o6nce ¢izdiginiz gizgi iz-
leyen araba tekerlegi mode-
lini aginiz.
e Pattern > Rectangular Pat-
tern komutunu seginiz.
¢ Rectangular Pattern diyalog
kutusundan Objects olarak
tekerlegi seginiz.
e Directions olarak X eksenini
seginiz.
e Quantity olarak her iki yon
icin de 3 degerini giriniz.
Gorsel 3.74: Rectangular Pattern diyalog kutusu

Gorsel 3.75: Rectangular Pattern komutu ile ¢odaltma islemi

e OK tusuna tiklayiniz ve islemi tamamlayiniz.
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15,8 mm genisliginde, 31,8 mm uzunlugunda, 9,6 mm
yuksekliginde, Uzerinde 8 tane 5 mm c¢apinda silindir
olan parcayi tasarlayiniz .

3.4.3.3. Circular Pattern (Dairesel Cogaltma)

Circular Pattern; nesneleri, ylizeyleri ya da nesne gévdelerini bir eksen etrafinda dondirerek belirlenen
acida dairesel olarak ¢ogaltma icin kullanilir. Dondiirme ekseni olarak parganin eksen gizgisi veya dairesel
parcanin kenar gizgisi secilebilir.

Uygulama: Cizilen Bir Nesnenin Dairesel Olarak Cogaltiimasi

Cizilen bir nesnenin dairesel olarak ¢ogaltil-

masi icin asagidaki yonergeleri uygulayiniz.

e 50 mm ¢apinda, 20 mm yuksekliginde bir si-
lindir giziniz.

e (Cizdiginiz silindirin Gstline kenar uzunlugu 5
mm olan bir kiip giziniz ve Operations olarak
New Body seciniz.

Gorsel 3.76: Box komutu ile olusturulan silindir iizerine kutu ekleme

e Pattern > Circular Pattern komutunu
seciniz. Objects olarak cizdiginiz kipu
seginiz.

e Axis olarak silindirin dairesel ylzey c¢iz-
gisini seciniz ve Quantity olarak 4 de-

gerini giriniz.

Gorsel 3.77: Circular Pattern komutu

Eksen cizmeden cogaltma yapilmak istenirse parcanin dis silindirik ylizeyi ya da kenar

e ———

cizgisi secilebilir.
3.4.3.4. Pattern on Path (Yol Uzerinde Cogaltma)

Bu yontem ile bir unsur, ylzey ya da nesnenin ¢izilen bir egri yol boyunca belirlenen sayida ¢ogaltiimasi

saglanir. Cizilecek yol, tek parca olmalidir.

128' 3. OGRENME BIRIMi



DIJITAL URETIM

Uygulama: Cizilen Bir Nesnenin Yol Boyunca Cogaltiimasi

Cizilen bir nesnenin yol boyunca g¢ogaltiimasi
icin asagidaki yonergeleri uygulayiniz.
e Dairesel Cogaltma konusunda cizdiginiz silin-
dirik parganin XY dizleminde bir Sketch aginiz.
e Spline komutu ile sekildeki gibi rastgele egri-
sel bir yol giziniz.
¢ Finish Sketch tiklayiniz.

Gorsel 3.79: Pattern on Path komutu

Gorsel 3.78: Spline komutu ile edrisel yol ¢izimi

Pattern > Pattern on Path komutunu seginiz.

Objects olarak silindirik basit modeli seginiz.

Path olarak cizdiginiz egri yolu seginiz.

Quantity olarak 5 degerini giriniz. Fare yardimiyla
¢izdiginiz yolu tarayiniz veya belirlenen Distance
degerini giriniz.

Gorsel 3.80: Pattern on Path komutuyla Distance ayari
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3.4.3.5. Mirror (Profil Nesnelerini Aynalama)

Mirror, nesnelerin ya da ylzeylerin bir eksen ile simetrigini alma islemi icin kullanilir. Simetri ekseni

olarak duizlemler veya nesnelerin ylzeyleri alinabilir.

Uygulama: Cizilen Bir Nesnenin Aynalanmasi

Cizilen bir nesnenin aynalanmasi icin asagidaki yonergeleri uygulayiniz.

e XY dizleminde Length 55 mm, Width 40 mm ve Height 15 mm olacak sekilde bir dikdortgen prizma
giziniz.

e Dikdortgen prizma Ust ylzeyinde bir Sketch olusturunuz ve
Text komutunu kullanarak MEB yaziniz.

e E kisayol tusunu kullanarak yaziya 10 mm kalinlik veriniz.

e Create > Mirror komutunu seginiz.

¢ Objects olarak olusturdugunuz nesneyi seginiz.

e Mirror Plane olarak XY dizlemini seginiz.

e OKtusuna basarak islemi tamamlayiniz. Calismanizi kaydediniz.

Gorsel 3.81: Nesnenin aynalanmis hali

3.5. Komut Yardimiyla Nesneleri Diizenleme

Dijital Gretim programinda olusturulan nesneler, komutlar yardimiyla diizenlenebilir.

3.5.1. Nesneden Baska Bir Nesne Cikarma

Dijital Gretim programinda cizilen nesneler, birbirinden ¢ikarilarak yeni nesneler olusturulabilir.

3.5.1.1. Dondiirerek Katilari Birbirinden Cikarma

Kullanilan yontemler ve parametreler Revolve komutu ile aynidir. Diyalog kutusundan Operation
bolimiinde Cut secimi yapilip keserek ¢ikarma islemi gerceklestirilir. Komutun aktif olabilmesi icin ¢izim
alaninda bir nesnenin bulunmasi gerekir.

(] ;3 [m]
http://kitap.eba.gov.tr/KodSor. 'Fa

T

php?KoD=21381 ¥

Uygulama: Vida Bagsi Olugturma

Vida basi olusturmak i¢in asagidaki yonergeleri uygulayiniz.

e XZ dlzleminde 30 mm yarigapinda bir altigen ¢iziniz.

e E kisayol tusu ile altigene 20 mm kalinlik veriniz.

e Sketch ortaminda XY dizleminde Line komutu ile
olusturdugunuz nesnenin bir kdsesini 2 mm kesen Ug¢gen ¢iziniz.
Finish Sketch tiklayiniz.

Gorsel 3.82: Ucgen cizimi
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e Create > Revolve komutunu seginiz. Ekrana gelen diyalog
kutusundan Profil olarak ¢izdiginiz Gi¢geni seginiz.

e Axis olarak X eksenini seciniz.

e Angle olarak 360° giriniz.

e Operation olarak Cut islemini seginiz.

e OK tusuna tiklayarak islemi tamamlayiniz. Galismanizi
kaydediniz.

Gorsel 3.83: Cikarma / kesme islemi sonrasi vida basi

3.5.1.2. Yol Kullanarak Nesneleri Birbirinden Cikarma

Komutun kullanimi ve ¢izim mantigi Sweep komutu ile aynidir. Operation boliminde Cut secimi
yapilip keserek gikarma islemi gerceklestirilir. Komutun aktif olabilmesi icin ¢izim alaninda bir nesnenin
bulunmasi gerekir.

Uygulama: Yol Kullanarak Nesneleri Birbirinden Cikarma
Yol kullanarak nesneleri birbirinden cikarma islemiyle sehpa tablasi olusturmak igin asagidaki yoner-
geleri uygulayiniz.
e Sketch ortaminda XY dizlemine 50 cm kenar uzunlugunda
bir kare ¢iziniz.
¢ Finish Sketch tiklayiniz.
e E kisayol tusu ile gizdiginiz kareye 36 mm kalinhk veriniz.
e Sketch ortaminda XY dizleminde olusturdugunuz nesne-
nin kbse noktasini merkez alarak 15 mm capinda bir daire
giziniz.
¢ Finish Sketch tiklayiniz.

Gorsel 3.84: Daire ¢izimi

e Create > Sweep komutunu seginiz.

¢ Diyalog kutusundan Profile olarak gizdiginiz daireyi seginiz.
e Path olarak ilk gizdiginiz karenin kenarini seciniz.

e Distance olarak 1 degerini giriniz.

e Operation olarak Cut seginiz.

Gorsel 3.85: Kenarlari ¢ikarilmis sehpa tablasi
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3.5.1.3. Profiller ve Yiizeyler Arasinda Cikarma

Loft komutu, farkli dizlemlerde ve taslaklarda cizilmis profiller arasinda ¢ikarma islemi yaparak nesne

olusturur.

Uygulama: Profiller ve Yiizeyler Arasinda Cikarma

Profiller ve ylzeyler arasinda nesneleri birbirinden ¢ikararak sehpa ayagi olusturmak icin asagidaki
yonergeleri uygulayiniz.
e XY diuzleminde 300 mm yaricapinda uzunlugunda bir altigen ciziniz.

Gorsel 3.86: Cizimlerin yukaridan ve yandan gériiniisi

e 0O kisayol tusunu kullanarak gizdiginiz altigeni 50 mm igeri dogru ofsetleyiniz. Finish Sketch tiklayiniz.
e Construct > Offset Plane seciniz ve XY dizlemine 300 mm uzaklkta yeni bir dizlem olusturunuz. Bu
dizlemde 300 mm ¢apinda bir daire giziniz.
e O kisayol tusunu kullanarak ¢izdiginiz daireyi 50 mm iceri dogru ofsetleyiniz. Finish Sketch tiklayiniz.
e Construct > Offset Plane seginiz ve (st diizleme 300 mm uzaklikta yeni bir diizlem daha olusturunuz.
e Yenidiizlem Uzerine bir Sketch aciniz ve 400 mm kenar uzunlugunda bir kare ¢iziniz.
e O kisayol tusunu kullanarak cizdiginiz kareyi 40 mm igeri dogru
ofsetleyiniz. Finish Sketch tiklayiniz.
e Create > Loft komutunu calistiriniz ve ilk gizdiginizden baslayarak
dis profilleri sirasiyla seginiz.
e Bodyl goriinimuni kapatiniz.
e Create>Loftkomutunucalistirinizve ofsetleyerek olusturdugunuz

ic profilleri ilk gizdiginizden baslayip sirasiyla seginiz.

Gorsel 3.87: Nesnenin olusturulmasi
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Gorsel 3.88: Loft komutu ile nesnenin ¢ikarilmasi

e Operation olarak Cut seciniz.

e Bodyl gérinimini aginiz.

Gorsel 3.89: Loft komutu ile nesnenin gikarilmasi

e OK tusuna tiklayarak islemi tamamlayiniz.

Gorsel 3.90: Ctkarma islemi sonrasi nesnenin listten gérinimii
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3.5.1.4. Silindirik Yiizeylere Dis Agma
Silindirik ylzeylere dis agma iki bicimde gerceklestirilebilir.
Birinci yontem, Threat komutuyla silindirik ylzeylere dis agmadir. Threat komutu, var olan standartlara

gore silindirik ylzeylere dis agilmasini saglar.

Uygulama: Threat Komutuyla Dis Agma

Threat komutuyla nesnenin ylzeyine
belirlenen uzunlukta dis acarak civata
yapmak icin asagidaki yonergeleri
uygulayiniz.

e Revolve komutu ile daha ©nce
olusturdugunuz vida bashgi nesnesini
aginiz.

e Create > Cylinder komutu ile vidanin
arka yuzune bir silindir olusturunuz.

e Oparetion olarak Join seciniz.

Gorsel 3.91: Vida baslidina silindirin eklenmesi

e Modify > Fillet komutunu seginiz.

e Silindirin baslangic ve vida basi ile
birlestigi ylzeyleri 2 mm yuvarlama
yapiniz.

e Create > Threat komutunu seginiz.

e Faces olarak silindir nesnesini
seginiz.

e Modeled secimini yapip dislerin
fiziksel olarak agilmasini saglayiniz.

e Full Length secimi ile silindirin
tamamina dis acilmasini saglayiniz.

e Full Length secimini kaldiriniz.
Baslangi¢ noktasi icin Offset olarak
0 mm, dis uzunlugu belirlemek igin

Length degeri olarak 50 mm giriniz.

Gorsel 3.92: Silindirin baslangig ve birlesim yiizeylerinin yuvarlanmasi

Disin anma 6l¢lisi, secilen ylizeyi olusturan ¢capa gore otomatik olarak belirlenecektir.

istenirse farkli bir capa gére dis profilinde vida da acilabilir.
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Gorsel 3.93: Belirlenen uzunlukta dis agiimasi

OK tusuna tiklayarak islemi tamamlayiniz. Calismanizi kaydediniz.

ikinci yéntem ise Coil komutuyla silindirik yiizeylere dis agmadir. Mevcut standartlarin disinda bir

Olglyle vida acilacagl zaman Coil komutu kullanilabilir. Komutun kullanilabilmesi icin ¢izim alaninda dis

acilacak nesnenin bulunmasi gerekir.

Uygulama: Coil Komutuyla Dis Acma

Coil komutuyla nesne ylizeyine belirlenen uzunlukta dis agarak civata yapmak icin asagidaki yonergeleri

uygulayiniz.

Threat komutu ile daha dnce olusturdugunuz civata nesnesini aginiz.

Timeline b6éliminden Threat komutunun 6ncesine geliniz.

Create > Coil komutunu seginiz.

Cizim dizlemi olarak civatanin dairesel yiizeyini seginiz.

Gizim merkez noktasi ile silindirin merkez noktasini eslestiriniz ve yay olusturunuz.

Gorsel 3.94: Coil komutuyla yay olusturma
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¢ Coil diyalog kutusundan Diameter degerini 43 mm, Height degerini -55 mm, Section Size degerini 2
mm olarak giriniz.
e Coil diyalog kutusundan Revolutions degerini 15 mm giriniz. Section olarak Triangular (Internal)

seginiz.

Gorsel 3.95: Dis tipi ve dis tur degerinin ayarlanmasi

e Operation olarak Cut seginiz.

e OK tusuna tiklayarak islemi tamamlayiniz. Calismanizi kaydediniz.

Coilile dis acilirken gizilecek yayin ¢capi dis acilacak ylizeyden ¢ok kiigiik olursa parcanin

ylzeyine degil icine dis acilir.

3.5.2. Chamfer (Nesnelerde Pah Kirdirmak)

Chamfer, nesnelerin kenar ya da kdselerine farkli sekilde pahlar kirmak igin kullanilir.

Uygulama: Pah Kirma

Pah kirdirarak nesnenin kenarlarini dizletmek igin asagi-

daki yonergeleri uygulayiniz.

e XY dizleminde Length 90 mm, Width 60 mm, Height 20
mm olacak sekilde bir kutu olusturunuz.

e Olusturdugunuz kutunun Ust ylzeyine Length 40 mm,
Width 25 mm, Height 10 mm olacak sekilde bir kutu

daha olusturunuz.

Gorsel 3.96: Box komutu ile ikinci nesnenin olusturulmasi
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Modify > Chamfer komutunu seginiz.
Edges (Kenar) olarak biliyik kutunun
uzun kenarini seginiz.

Chamfer Type olarak Equal Distance
(Esit Uzaklik) seciniz. Distance degeri

olarak 3 mm giriniz.

Gorsel 3.97: Chamfer komutu ile Equal Distance (Esit Uzaklik) pah kirma

Chamfer komutunu seginiz.
Edges olarak kiclk kutunun
uzun kenarini seginiz.

Chamfer Type olarak Two
Distance (ikili Uzaklik) seci-
niz. X ekseni Distance degeri
olarak 15 mm, Y ekseni Dis-
tance degeri olarak da 5 mm

giriniz.

Goérsel 3.98: Chamfer komutu ile Two Distance (Ikili Uzaklik) pah kirma

Modify > Chamfer komutunu seciniz.
Edges olarak biyuk
kutu ile kiiclik kutunun
birlestigi kisa kenari
seginiz.

Chamfer Type olarak
Distance and Angle
(Uzaklik ve Agl) seciniz.
Distance degeri olarak
5 mm, Angle degeri
olarak 65° giriniz.

OK tusuna tiklayarak
islemi  tamamlayiniz.

Calismanizi kaydediniz.
Gorsel 3.99: Chamfer komutu ile Distance and Angle (Uzaklik ve A¢i) pah kirma
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3.5.3. Diizenleme Komutlariyla Nesneler Olusturma

Dijital Gretim programinda dizenleme komutlari araciligiyla nesneler olusturulabilir.

3.5.3.1. Fillet (Nesnelerde Yuvarlatma)

Fillet; nesnelerin kenarlarini, koselerini, kenarlar veya ylizeyler arasini yuvarlatmak igin kullanihr.

Uygulama: Nesnelerde Yuvarlatma

Nesnelerin kenarlarini yuvarlatmak icin asagidaki yonergeleri uygulayiniz.
e Pah kirdirmada olusturdugunuz nesneyi aginiz.
e Modify > Fillet komutunu seginiz.
e Edges olarak biyuk kutunun tg¢ kenarini seginiz.

Gorsel 3.100: Fillet komutu ile kenarlarin segimi

e Radius Type olarak Constant Radius seciniz.
e Yuvarlatma yaricapi olarak 4 mm giriniz.
e OK tusuna tiklayarak islemi tamamlayiniz.

Gorsel 3.101: Fillet komutu ile sabit yarigcapli yuvarlatma

e Modify > Fillet komutunu seginiz. Edges olarak kiiglik kutunun Ug¢ kenarini seginiz.
e Radius Type olarak Chord Length seginiz. Uzunluk olarak 4 mm giriniz.

e OK tusuna tiklayarak islemi tamamlayiniz.
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Gorsel 3.102: Fillet komutu ile sabit uzunlukla yuvarlatma

¢ F kisayol tusu ile Fillet komutunu aginiz.
e Edges olarak biylk kutunun arka uzun kenarini seginiz.
¢ Radius Type olarak Variable Radius seginiz.

Gorsel 3.103: Fillet komutu ile sabit uzunlukla yuvarlatma

e Fare yardimiyla ikinci yuvarlatma noktasini belirleyiniz.

Gorsel 3.104: [kinci yuvarlatma noktasi belirleme
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e Fillet diyalog kutusu Radius Points (Yaricap Noktalari) béliminden Start degerini 2 mm, Point 1
degerini 10 mm, End degerini 0 mm olarak giriniz.

e OK tusuna tiklayarak islemi tamamlayiniz. Calismanizi kaydediniz.

Gorsel 3.105: Degisken yarigapli yuvarlatma

Silindir bash, altigen alyan anahtar oyuklu, uzunlugu
70 mm, dis uzunlugu 35 mm, vida adimi, M25x1,5 olan
civatayi olusturunuz.

3.5.3.2. Draft (Yiizeylere Egim Verme)

Draft, nesne Uzerinde segilen bir veya birden fazla ylizeye istenilen agida egim vermek igin kullanilir.

Uygulama: Nesnelerin Yiizeylerine Egim Verme

Nesnelerin ylizeylerine egim vermek igin asagidaki yonergeleri uygulayiniz.

e Box komutu ile XY dizleminde
Length 150 mm, Width 55 mm,
Height 5 mm olacak sekilde bir
kutu olusturunuz.

e Nesnenin Ust vylzeyinde bir
Sketch olusturunuz. Text ko-
mutu ile M E B yaziniz. Height
degerini 50, Angle degerini
-180° giriniz.

e E kisayol tusunu kullanarak ya-

ziniza 10 mm kalinlik veriniz. Gorsel 3.106: Yiizeylere egim verilmesi
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e Modify > Draft komutunu seginiz.

e Plane olarak “M” harfinin Ust ylize-
yini seginiz.

e Faces olarak “M” harfinin yan ylize-
yini seginiz.

e Angle olarak 30° giriniz.

e OK tusuna tiklayarak islemi tamam-
layiniz.

e Draft komutunu seciniz. Plane ola-
rak “M” harfinin Gst ylzeyini seciniz.

e Faces olarak Ctrl tusuyla birlikte
egim vermek istediginiz ylzeyleri se-
ciniz. Gorsel 3.107: Yiizeylere egim verilmesi

e Angle olarak 30° giriniz.

3.5.3.3. Shell (Nesnelere Et Kalinhgi Verme)

Shell, nesneleri belirli bir et kalinhigina bagli kabuk model haline getirmek igin kullanihr.

Uygulama: Nesnelere Et Kalinhgi Verme

Nesnelere et kalinhgl vermek icin asagidaki yonergeleri uygulayiniz.
e Bir onceki uygulamada yazdiginiz MEB
yazisini aginiz.
e Modify > Shell komutunu seginiz.
e Faces / Body olarak MEB harflerinin
hepsini seginiz.
e Direction olarak Outside seginiz. Out-
side Thickness degerini 1 mm giriniz.
e OKtusuna tiklayarak islemi tamamlayi-

niz. Calismanizi kaydediniz.

Gorsel 3.108: £t kalinligi verilecek yiizey segimi

Gorsel 3.109: Et kalinligi verilen yiizey
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3.5.3.4. Split (Nesneleri Pargalara Ayirma)

Split, bir nesneyi lizerine ¢izilmis cizgiler yardimiyla bélerek pargalara ayirmak igin kullanilir. Cizgilerin

uzantisi nesneyi kesebilecek sekilde olmalidir. islem sonunda iki ayri gévde olusur.

Uygulama: Nesneleri Pargalara Ayirma

Nesneleri pargalara ayirmak icin asagidaki yonergeleri uygulayiniz.
e XZ dizlemine bir silindir giziniz.
e Sketch ortaminda XY diizlemine bir Spline giziniz.
e Modify > Split komutunu seciniz.
e Bolinecek nesne (Body to Split) olarak olusturdugu-
nuz silindiri seginiz.
e Bolme araci (Spliting Tool) olarak ¢izdiginiz Spline segi-
niz.

Gorsel 3.110: Silindir lizerine spline ¢izme

Gorsel 3.111: Split komutu ayarlari ve nesneyi b6lme

3.5.3.5. Combine (Birlestir)

Combine, ayni ¢alisma ortaminda bulunan farkli nesnelerin birlestirilmesinde, ¢ikarilmasinda veya
kesisimlerinin alinmasinda kullanilir. Komutun uygulanabilmesi i¢in ayni ¢alisma sayfasinda birden fazla
nesne bulunmalidir.

Uygulama: Nesneleri Birlestirme

Nesneleri birlestirmek icin asagidaki yonergeleri uygulayiniz.
e Splitile iki parcaya ayirdiginiz nesneyi aginiz.

¢ Modify > Combine komutunu seciniz. Target Body olarak alttaki blylk nesneyi seginiz.
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Gorsel 3.112: Combine birlestirilecek nesne segme
¢ Tool Bodies olarak tistteki blylk nesneyi seginiz.
e Operations olarak Join seginiz.
e OK tusuna tiklayarak birlestirme islemini tamamlayiniz.
e Bu islemden sonra unsur agacindaki Bodies menusin-
de nesnelerin birleserek tek bir Body oldugu gorilir.

Gorsel 3.113: Birlestirilmis nesne

3.5.3.6. Press Pull (Yiizey Oteleme)

Press Pull, nesnelerin secilen ylzeylerini belirli bir miktar 6telemek ve tasimak icin kullanihr.

Uygulama: Yiizeyleri Oteleme

Ylzeyleri 6teleme islemi igin asagidaki yonergeleri uygulayiniz.
e Daha 6nce olusturdugunuz MEB yazi uygulamanizi aginiz.
e Modify > Press Pull komutunu seginiz.
e Selection olarak yazinin Ust ylizeyini seginiz.
e Distance degeri olarak 15 mm giriniz.
o Offset Type kisminda Automatic isaretleyip secilen ylizeyi toplam 15 mm oteleyiniz.
e Qkisayolu ile tekrar Press Pull komutunu aginiz, ayni ylizeyi seginiz.
e Distance degeri olarak 15 mm giriniz.
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o Offset Type kisminda New Offset isaretleyip secilen yizeyi 15 mm 6teleyerek toplamda 30 mm kalinhk
elde ediniz.

Gorsel 3.114: Secilen yiizeyi 6teleme
3.5.4. Align (Nesnelerin Hizalanmasi)

Align, nesnelerin secilen ylzeylerini ve noktalarini birbirlerine gére hizalamak igin kullanilr.

Uygulama: Yiizeyleri veya Noktalari Hizalama

Ylzeyleri veya noktalari hizalamak i¢in asagidaki yonergeleri uygulayiniz.
e XZ dizleminde uzunlugu 60 mm, genisligi 40 mm, yUk-

sekligi 10 mm olacak sekilde bir kutu ve 35 mm ¢apinda

50 mm yiksekliginde bir silindir olusturunuz.
¢ Modify > Align komutunu seginiz. From olarak kutunun

Ust ylizeyinin orta noktasini seginiz.
e To olarak silindirin Gst tablasinin orta noktasini seginiz.

Angle tiklayarak kutunun yonini degistiriniz.

Gorsel 3.115: Align komutu ile noktalari secme

e Ctrl+Z kisayol tusu ile yaptiginiz hizalama islemini geri
aliniz.

e Modify > Align komutunu seginiz.

e From olarak kutunun Ust ylzeyini seginiz.

Gorsel 3.116: Nesneleri hizalama
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e To olarak silindirin Ust ylizeyini seginiz.

Gorsel 3.117: Align komutuyla yiizeyleri secme . . B o
Gorsel 3.118: Align komutuyla yiizeyleri hizalama

3.6. Assembly (Nesnelerin Montaiji)

Assembly; bir makineyi, bir sistemi veya bir mekanizmayi olusturan pargalarin belirli bir siraya ya
da diizene gore bir araya getirilmesi islemidir. Montaj birkag par¢cadan olusabildigi gibi binlerce par¢adan
da olusabilir. Bu nedenle montaj sirasinda kiguk kiiglik montaj gruplari olusturularak montajlama islemi
kolaylastirilabilir. Bu sekildeki montajlama islemine alt montaj adi verilir. Nesneler, ylzlerce alt montajdan
olusabilir.

3.6.1. Montaj Sayfasinin Agilmasi

Dijital tretim programinda montaj islemi Design ortaminda dogrudan yapilabilmektedir.

3.6.2. Montaj iliskisi Ekleme ve Esleme

Dijital Giretim programinda As-Built Joint ve Joint komutlari ile yararlanilabilecek yedi farkl Joint
(Montaj iliskisi) tiirti bulunmaktadir. Her montaj iliskisinin farkli bir kullanimi vardir ve hareket tanimlamak
icin izin verilen serbestlik bicimleri farklidir. Her montaj iliskisinde, iliski degerlerinin parametrik bir sayisal
deger olusturacagina da dikkat edilmelidir. Montaj iliskileri ile ¢calisirken mimkiin olan en az serbestlik
derecesi agik tutulmalidir.

Montaja baslanacagizaman birtane temel parca olmasinda fayda vardir. Montajiliskilerinin bu parcadan
yiritilecegi dusiinilmelidir. ilk getirilecek parca bu nedenle iyi secilmelidir. Par¢ca, montaj amaciyla ¢izim
alanina getirilirse unsur agacinda parganin tizerindeyken farenin sag tusuna tiklanir ve Ground (Yer) se¢imi
yapilir. Joint (Eklem) komutu galistirildiginda program bu parcadan baslayarak montaj iliskisi olusturur.

Montajiliskisi; bir kenara, birylizeye, bir kdseye ve bir noktaya gore verilebilir. Montajiliskisi belirlenirken
parcalarin neresinin secilecegi, diger parca ile montaj iliskisine gore belirlenmeli ve kararlastiriimalidir.

Uygulama: Montaj igin Taslak Cizim Olusturma

Gorselde yer alan taslak cizimi olusturmak icin asagidaki yonergeleri uygulayiniz.
e Sketch komutu ile bir taslak olusturunuz.

e Taslak gizimleri yapiniz.
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Gorsel 3.119: Yatak nesnesi ve kayan nesne taslagi

¢ Finish Sketch komutu ile taslagi tamamlayiniz.
e Extrude komutunu her iki ¢gizim igin ayri ayri ¢alistiriniz.
e Yatak Nesnesi icin Distance degerini 300 mm, Kayan Nesne icin Distance degerini 20 mm olarak

belirleyiniz.

Gorsel 3.120: Nesneler

e Unsur agacindaki Bodies dali altinda nesneleri listeleyiniz.

e Bodyl nesnesinin adini Yatak, Body2 nesnesinin adini da Kayan Nesne olarak degistiriniz.

e Browser > Bodies altinda listelenen 6gelerin her birinin lzerine farenin sag tusu ile ayri ayri tiklayiniz.
Gelen sag tus menilsiinden Create Companents from Bodies komutuyla nesneleri bilesen haline
getiriniz.

Yatak bileseni (izerine farenin sag tusu ile tiklayip meniden Ground secenegini isaretleyiniz ve Yatak

bilesenini yere sabitleyiniz.

AY

Uzerinde calisilmak istenen Companent, Browser altindan secilmelidir. Secme islemi,
bilesen lzerine farenin sag tusu ile tiklanip gelen meniiden Activate (Etkinlestir)
i secenegiyle gerceklesir.

Bilesenin tasarim dizlemindeki yeri degistirilirse komut ikon penceresinin en saginda Position
(Konum) komutu belirir. Bilesen, Revert (Eski Haline Getir) komutu ile konumu degistiriimeden

AY
1
1
1
1
1
1

: onceki yerine geri gelir.
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Uygulama: Rigid (Sabit) Montaj iliskisi

Rigid, iki montaj bilesenini hicbir harekete olanak vermeyecek sekilde birlestirir. Sabit montaj olustur-
mak icin asagidaki yonergeleri uygulayiniz.
e Asssemble>Joint komutunu seginiz.
e Joint komut menisiinden Motion sekmesini seginiz.
e Motion Type (Hareket Tipi) olarak Ri-

gid (Sert) hareket tlrini seginiz.
e Componentl ve Component2 alan-

larini kullanarak montaj nesnelerini

seginiz.
e Secim esnasinda parcalarin monte

edilecegi Joint Origin noktalarini sira-

siyla gosteriniz.

Gorsel 3.121: Yatak pargcasi montaj noktasi belirleme

¢ Angle alanindan agisal konumu; Offset X, Off-

set Y ve Offset Z alanlarindan da dogrusal ko-

numu belirleyiniz.
e OK digmesine basarak islemi bitiriniz. Calis-

manizi kaydediniz.

Gorsel 3.122: Rigid Joint islem sonucu

Uygulama: Revolute (Déniis) Montaj iliskisi

Donls montaj iliskisinde kullanilmak Gzere 6rnek nesneleri olusturmak icin asagidaki yonergeleri

uygulayiniz.

e Genisligi ve uzunlugu 50 mm, yiksekligi 10 mm bir kutu olusturunuz.

e Kutunun ortasina Hole komutu ile 20 mm genisliginde bir delik aginiz.

e XY diuzlemine 19 mm ¢ap genisliginde bir silindir ¢iziniz ve silindire 40 mm ylkseklik degeri veriniz.

e DOnUs hareketini gorebilmek icin silindirin Gst tabaninda bir Sketch olusturup 4 mm capli bir cember
Giziniz.

e Extrude komutu ile yukari yonli 5 mm yikseklik veriniz.

e Operation turini Join olarak ayarlayiniz.

e Unsur agacindan Body1 adini Yatak, Body2 adini Dénen Nesne olarak degistiriniz.

e Create Companents from Bodies komutuyla nesneleri bilesen haline getiriniz.

e Yatak bilesenini Ground olarak seciniz ve yere sabitleyiniz.

e Asssemble > Joint komutunu seginiz.

e Joint komut menisiinden Motion sekmesini seginiz.

e Motion Type olarak Revolute (Doniig) hareket tiiriinG seginiz.
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Componentl ve Component2 alanlarini kullanarak montaj nesnelerini seginiz.

Angle alanindan agisal konumu; Offset X, Offset Y ve Offset Z alanlarindan da dogrusal konumu
belirleyiniz.

Yatak ve Donen Nesne tabanlarinin ayni hizada olmasi igin

Joint paletinde Offset Z degerini -10 mm olarak giriniz.

Motion sekmesinde bulunan Rotate kismindan donis ek-

senini belirleyiniz.

Animate digmesine tiklayarak islemin dogrulugunu kont-

rol ediniz.

OK diigmesine basarak islemi bitiriniz. Calismanizi kaydediniz.

Gorsel 3.123: Revolute Joint islem sonucu

Uygulama: Slider (Siirgii) Montaj iliskisi

Slider, iki montaj bilesenini bir eksende dogrusal hareket yapabilecek sekilde birlestirir. Strgli montaj

iliskisi icin asagidaki yonergeleri uygulayiniz.

Daha onceki taslak uygulamasini aciniz.

Yatak bilesen nesnesine Ground 6zelligi veriniz.

Asssemble > Joint komutunu seginiz.

Joint komut menisiinden Motion sekmesini seciniz. Motion Type olarak Slider (Suirgii) hareket tlirtini
seginiz.

Joint paleti Position sekmesinden Componentl ve Component2 alanlarini kullanarak montaj nesne-
lerini seginiz.

Angle alanindan acisal konumu; Offset X, Offset Y

ve Offset Z alanlarindan da dogrusal konumu belir-

leyiniz.

Motion Type olarak Slider seciniz. Slider alanindan

kaydirilacak aks (eksen) icin -Y eksenini seginiz.

Animate diigmesine tiklayarak islemin dogrulugunu

kontrol ediniz.

OK diigmesine basarak islemi bitiriniz.

Gorsel 3.124: Slider Joint islem sonucu

Uygulama: Cylindrical (Silindirik) Montaj iliskisi

Cylindrical, iki montaj bilesenini bir eksende dairesel ve dogrusal hareket yapabilecek sekilde birlestirir.
Silindirik montaj iliskisi icin asagidaki yonergeleri uygulayiniz.

Revolute montaj iliskisi konusunda kullanilan taslak ¢izimleri aginiz.

Yatak bilesen nesnesine Ground 6zelligi veriniz.

Asssemble > Joint komutunu seciniz.

Motion Type olarak Cylindirical hareket tlrini seginiz.
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e Joint paleti Position sekmesinden Componentl ve Component2 alanlarini kullanarak montaj
nesnelerini seciniz.

e Parcalarin monte edilecegi Joint Origin noktalarini sirasiyla gosteriniz.

e Angle alanindan agisal konumu; Offset X, Offset Y ve Offset Z alanlarindan da dogrusal konumu
belirleyiniz.

e Axis kismindan dogrusal ve dairesel hareketin yapilacagl mil eksenini -Z ekseni olarak belirleyiniz.

¢ Animate digmesine tiklayarak islemin dogrulugunu kontrol ediniz.

e OK digmesine basarak islemi bitiriniz.

Gorsel 3.125: Cylindirical Joint islem sonucu

Uygulama: Pin-Slot (Yuva-Kanal) Montaj iliskisi

Pin-Slot, iki montaj bilesenini bir pin yuvasi ve kanal iliskisi ile birlestirir. Bir eksende dairesel, bir ek-
sende dogrusal hareket yaptirir.
Pin-Slot montaj iliskisi icin asagi-

daki yonergeleri uygulayiniz.

e XY dizleminde genisligi ve uzunlu-
gu 50 mm, ylksekligi 10 mm olan
bir kutu olusturunuz.

e Kutunun Ust ylizeyine Sketch olus-
turarak 10 mm ¢apinda iki cember
ciziniz. Cemberlerin alt ve st nok-
talarindan 30 mm uzunlugunda
cemberlere teget olacak bigcimde
iki dogru giziniz.

Gorsel 3.126: Pin Slot Joint yatak nesnesi taslagi
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e Extrude komutunu calistirarak olusturulan kama yolunun
icini bosaltiniz.

e Bodyl nesnesinin ismini Yatak olarak degistiriniz.

Gorsel 3.127: Pin Slot Joint yatak nesnesi

e XY dizlemine taban ¢api 9 mm, yiiksekligi 40 mm olan bir silindir olusturunuz.
¢ Body2 ismini Donen Nesne olarak degistiriniz.

e Create Companents from Bodies komutuyla nesneleri bilesen haline getiriniz.
e Yatak bilesen nesnesine Ground 6zelligi veriniz.

e Asssemble > Joint komutunu seginiz.

e Joint komut menisiinden Motion sekmesini seginiz.

¢ Motion Type olarak Pin-Slot hareket tiiriini seciniz.

e Componentl ve Component2 alanlarini kullanarak montaj nesnelerini seginiz.

e Pargalarin monte edilecegi Joint Origin noktalarini sirasiyla gosteriniz.

Gorsel 3.129: Yatak pargcasi montaj noktasi belirleme
e Angle alanindan agisal konumu; Offset X, Offset Y ve Offset Z alanlarindan da dogrusal konumu
belirleyiniz.
e Rotate kismindan dairesel hareketin yapilacagi mil eksenini -Z ekseni olarak belirleyiniz.
¢ Slider kismindan dairesel hareket yapilirken izlenecek yuva eksenini -X ekseni olarak belirleyiniz.
e Animate digmesine tiklayarak islemin dogrulugunu kontrol ediniz.
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e OK digmesine basarak islemi bitiriniz.

Gorsel 3.130: Pin- Slot Joint islem sonucu

Uygulama: Planar (Diizlemsel Yoriinge) Montaj iliskisi

Planar, iki montaj bilesenini bir diizlemde dogrusal hareket yapabilecek sekilde birlestirir. Hareket
daha ¢ok bir yériinge olarak tanimlanmalidir.

Dlzlemsel yoriinge montaj iliskisi icin asagidaki yonergeleri uygulayiniz.
e XY dizlemine iki kutu ciziniz. Birinci kutu i¢in 50x50x10 mm, ikinci kutu icin 25x25x5 mm ebatlarini kullaniniz.
e Bu kutulari bilesen nesnesine donustiriindz.
e Bodyl nesnesinin adini Yatak, Body2 ismini Planar Nesne olarak degistiriniz.
e Create Companents from Bodies komutuyla nesneleri bilesen haline getiriniz.
e Asssemble > Joint komutunu seginiz.
e Joint komut menisi Motion sekmesinden Planar sec¢imini yapiniz.
e Componentl ve Component2 alanlarindan montaj nesnelerini seginiz.
e Pargalarin monte edilecegi Joint Origin noktalarini sirasiyla gosteriniz.
e Angle alanindan agisal konumu; Offset X, Offset Y ve Offset Z alanlarindan da dogrusal konumu belirleyiniz.
¢ Normal kisimdan hareketin yapilacagi ekseni -Z ekseni olarak belirleyiniz.
e Slider kismindan daire-

sel hareket vyapilirken

izlenecek yoringe ek-

senini -X ekseni olarak

belirleyiniz.
e Animate digmesine

tiklayarak islemin dog-

rulugunu kontrol edi-

niz.
e OK diigmesine basarak

islemi bitiriniz.

Gorsel 3.131: Planar Joint islem sonucu
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Uygulama: Ball (Kiire) Montaj iliskisi

Ball, iki montaj bilesenini bir eklem hareketi yapacak sekilde birlestirir. Hareket daha ¢ok bir kiresel
yatak icinde gerceklesen dirsek hareketi olarak tanimlanmalidir.

Kire montaj iliskisi icin asagidaki yonergeleri uygulayiniz.
e XZ duzleminde bir Sketch olusturunuz.

Gorsel 3.132: ici bos kiire taslak ¢izimi

e Yukarida goriildigi gibi daire ve dogru giziniz.

e Trim komutu ile gerekli yerleri budayiniz.

e Offset komutu ile iceri dogru 1 mm o6teleyiniz. Cizimin dizlem olmasi icin bosta kalan daire kesitinin
uglarini Line komutuyla birlestiriniz.

¢ Finish Sketch komutu ile gizimi sonlandiriniz.

e Revolve komutunu kullanarak gizilen diizlemi ve aks dizlemini seciniz. Ayarlari uygulayip OK tusuna
basarak ici bos bir kiire olusturunuz.

Gorsel 3.133: Revolve komutu ile i¢i bos kiire olusturma
e XZ dlzleminde 18 mm capli bir kiire ¢iziniz.
e XZduzleminde yeni bir Sketch olusturunuz ve 20 mm uzunluk, 1 mm genisliginde bir dikdortgen ¢iziniz.
Dikdortgenin sol alt kdsesinin, i¢i dolu kiirenin merkezinde olmasina dikkat ediniz.
¢ Finish Sketch komutu ile ¢izimi sonlandiriniz.
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Gorsel 3.134: Kiire ve uzantisini olusturma

Cizilen dikdortgensel dizlemi Create > Revolve komutuyla kendi uzun kenari etrafinda déondirerek
Join islemi ile kiireye bagh bir uzanti haline getiriniz.

Body1 nesnesinin adini Yatak, Body2 nesnesinin adini Ball Nesne olarak degistiriniz.

Create Companents from Bodies komutuyla nesneleri bilesen haline getiriniz.

Asssemble > Joint komutunu seginiz.

Joint komut menisiinde Motion sekmesinde yer alan Ball hareket tiirlini seginiz.

Componentl ve Component2 alanlarini kullanarak montaj nesnelerini seginiz. Pargalarin monte
edilecegi Joint Origin noktalarini gosteriniz.

Angle alanindan acisal konumu; Offset X, Offset Y ve Offset Z alanlarindan da dogrusal konumu
belirleyiniz.

Pitch kismindan dairesel eklem hareketinin yapilacagi eklem eksenini belirleyiniz.

Yaw kismindan bir pusula ylzeyinde yapilirken dairesel hareketin izlenecek yoringe eksenini
belirleyiniz.

Animate digmesine tiklayarak islemin dogrulugunu kontrol ediniz.

OK diigmesine basarak islemi bitiriniz.

Gorsel 3.135: Ball Joint islem sonucu
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Uygulama: As-Built Joint Montaj iliskisi

Montaj bilesenleri, yapilislari agisindan belli bir konumda bulunabilir veya bir alt montajda yer alabilir.
Bir montajda yer alan parcaya montaj iliskisi atanacaginda tim montajin bu iliskiye uymasi beklenir. Bir
alt montaj, diger bir alt montaja montaj iliskisi ile baglanacaginda o alt montajin tim konumlari korunarak
montaj olusturulmalidir.
As-Build Joint montaj iliskisi icin asagidaki yonergeleri uygulayiniz.
e Asssemble > As-Built Joint komutunu seginiz.
e Komut menisiinde Component alani kullanilarak montaj nesnelerini seginiz. Se¢im esnasinda
parcalarin monte edilecegi Joint Origin noktalarini sirasiyla gosteriniz.
e Motion alanindan montaj iliskisini olusturacak Joint tipini seciniz.
e Animate digmesine tiklayarak islemin dogrulugunu kontrol ediniz.

e OK digmesine basarak islemi bitiriniz.

3.6.3. Motion Link (Hareket Baglantisi) Kurmak

Motion Link, iki ya da daha fazla montaj iliskisini birbirine baglayarak hareketi saglamak icin kullanilir.

Uygulama: Hareket Baglantisi Kurma

Hareket baglantisi kurmak icin asagidaki yonergeleri uygulayiniz.
e Daha 6nceden olusturdugunuz stirgli montaj iliskisi uygulamasini aginiz.
e Yatak nesnesinin yan ylizeyinde bir Sketch olusturup 10 mm gapinda bir gember ¢iziniz.
e Extrude komutu ile cgembere 40 mm yukseklik degeri veriniz.

Gorsel 3.136: Yan yiizeyde Sketch olusturmak
¢ Herhangi bir dizlemde i¢ ice 50 mm ve 10 mm ¢apinda iki gember ciziniz. Cemberler arasinda kalan
dizlem segcili iken Extrude komutunu c¢alistiriniz ve diizleme 10 mm yikseklik degeri veriniz.
e Carkin dondiglinii gorebilmek igin ¢arkin Gzerine bir gember ¢iziniz ve Extrude komutunu galistirarak
cembere hacim kazandiriniz.
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e Create Companents from Bodies komutuyla nesneleri bilesen haline getiriniz.

e Asssemble > Joint komutunu tekrar ¢alistiriniz.

e Joint komut menisiinde Motion sekmesini seciniz. Motion Type olarak Revolute hareket tiirlini
seginiz.

e Componentl ve Component2 montaj nesnelerini seginiz.

¢ Angle alanindan agisal konumu; Offset X, Offset Y ve Offset Z alanlarindan dadogrusal konumu belirleyiniz.

¢ Joint paletinde Offset Z degerini -10 mm olarak belirleyiniz.

¢ Motion sekmesinde bulunan Rotate kismindan donis eksenini belirleyiniz.

e Flip secimine tiklayarak par¢anin konumunu degistiriniz.

e Animate digmesine tiklayarak islemin dogrulugunu kontrol ediniz.

e OK digmesine basarak islemi bitiriniz.

e Bilesenlere iki montaj tlrind ayri ayri uyguladiktan sonra Asssemble > Motion Link komutunu
¢ahistiriniz. Motion Link paleti acilir.

e Calisma sayfasinda birbirine baglanacak hareketleri seciniz.

Gorsel 3.137: Montaj islemi sonucu

3.6.4. Contact Sets (Birlestirme Seti)

Bu arag aktif oldugunda bir bilesenin hareket araligi boyunca karsilasacagi midahaleleri analiz eder.
Contact Sets araci yardimiyla bir bilesenin hareket araligi kisitlanabilir ya da tanimlanabilir.

Uygulama: Contact Sets

Contact Sets icin asagidaki yonergeleri uygulayiniz.

e Motion Link uygulamasini aginiz.

e Yatak nesnesinin her iki ucunda R kisayolu ile genisligi 70 mm, uzunlugu 10 mm olan bir dikdértgen
cizerek gerekli taslak cizimlerini olusturunuz.

e Extrude komutu ile 15 mm olacak sekilde taslagi nesneye donustiriniz.
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Gorsel 3.138: Yatak nesnesinin uglarinin kapatiimasi

e Carknesnesikendietrafindadoéndirildigiinde Kayannesneninkapatilan uglardangikip uzaklasabilecegi

gordlebilir.

Gorsel 3.139: Yatak nesnesi ve kayan nesne

e Bu durumun 6nline gegmek, Kayan nesnenin Yatak nesnesinin kapatilan uglarina gelince durmasini

saglamak icin Contact Set atamasini yapiniz.
e Assemble > Enable Contact Sets komutu ile calisma sayfasinda Contact Sets kullanimini etkinlestiriniz.
e Yatak bileseni icin New Contact Set komutunu ¢alistiriniz.
e Contact Set iliskisi kurulacak nesneleri seginiz ve OK tusuna basarak Kayan nesnenin Yatak nesnesinin

uclarindan gegmedigini goriiniiz.

Gorsel 3.140: New Contact Set paleti

3.6.5. Motion Study (Calisma Hareketi)
Motion Study, montaj iliskilerine dayali kinematik hareket analizi yapar. Eklenecek montaj iliskileri

secilir, ardindan hareket icin noktalar ve degerler belirtilir.
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Uygulama: Motion Study

Motion Study icin asagidaki yonergeleri uygulayiniz.

Assemble > Motion Study komutunu seciniz. Gelen pencerede montaj iliskisi icin Slider3 stirglsiin
seginiz.

Gorsel 3.141: Motion Study penceresi

e (izgi lUzerinde bir Key (Anahtar) seciniz. Secilen anahtarin baslangi¢c konumuna gore Distance degeri

ile 0 mesafeyi ka¢ adimda (Step) alacagini belirleyiniz.

Play (Oynat) tusuna basarak baslangic ile belirtilen anahtar arasindaki hareketi oynatiniz.

Sira Sizde 9

Sabit kisminin genisligi 20 mm, uzunlugu 90 mm, yiksekligi 3 mm olan kapi mentesesini
olusturunuz ve montaj iliskilerini belirleyiniz.

3.6.6. Montajda Yeni Parc¢a Olusturma

Assemble > New Component komutu, montaj ortamina yeni bir parca eklemek istenildiginde kullanilir.

Uygulama: Montajda Yeni Parca Olusturma

e Assemble > New Component komutunu seginiz. istenirse unsur agacinda en Ustteki montaj ikonuna
sag tiklanip New Component secimi de yapilabilir.

e Cizim yapilacak diizlemi secip Sketch aginiz ve ¢izim yapiniz. Cizim sirasinda montaj seffaflasir. Cizim
kaydedildiginde parca, montaja eklenmis olur.

Kaydedilen pargay! istediginiz gibi hareket ettirebilirsiniz. Parcanin tasarlandigi ylzeyle

bir montaj iliskisi yoktur. Parcanin montaj iliskisini burada yapabilirsiniz.

e Unsur agacinda kaydedilen yeni parcanin Ustliinde sag taraftaki daire secilirse diger montaj unsurlari
seffaflasir ve yeniden gerekli diizenleme islemleri yapabilir. Yapilan dlizenlemeler, montaj ortamina
otomatik olarak yansir.
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Gorsel 3.142: Montaj ortaminda yeni par¢a olusturmak
e Olusturdugunuz yeni pargayi Ustlne ¢izdiginiz parca ile iliskilendirebilirsiniz.
Parganin ayritlari Project komutu ile izdiistrilerek olusturulmussa o parga lGzerinde
yapilan degisiklikler, iliskili oldugu yeni parcaya da yansir.
e Olusturulan parganin galisma klasériiniin iginde ayrica kayith olarak yer almasini isterseniz unsur
agacinda lzerine sag tus tiklayip Save Copy As secerek ayri bir parga kaydi yapabilirsiniz.

3.6.7. Montaja Alt Montaj Ekleme

Ana montaja eklenen montaj gruplarina alt montaj denir. Bu islem, biyilk montaj ortamlarina kiiglk
montajlarin ¢agrilip eklenmesidir. Montaj sayfasina nesneler eklenebilir veya baska bir montaj dosyasi da

parca gibi eklenebilir. Genellikle ¢cok par¢ali montajlarda montaji rahatlatmak icin bu yéntem kullanilir.

Uygulama: Montaja Alt Montaj Ekleme

Alt montaj eklemek icin asagidaki yonergeleri uygulayiniz.

¢ New Component sec¢iminiyaparak montajin altinda yenibir montajaginiz. Assemble > New Component
komutunu secerek de ayni islemi gerceklestirebilirsiniz.

e Unsuragacinda Componentl:1 adinda olusan montajin altina bos bir parca eklediginizde yeni parganin
dogrudan Component2:1 adini aldigini gbzlemleyiniz.

e Alt montaj grubuna baska parca eklenecekse alt montaji aktiflestirmek gerekir. Bunun icin sag taraftaki
daireyi tiklayarak alt montaji aktiflestiriniz.

e Alt montaj aktif degilse birlestirmelerle eklenen parcalari veya delik islemlerini genel montaja

uygulayiniz. Bunun igin unsur agacinda alt montajin Gzerinde iken sag taraftaki daire secilmelidir.
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Montaj sayfasindan ¢ikmadan parca ya da bilesenleri dizenlemek icin kullanilir. Montaj ortaminda

3.6.8. Edit Component (Montaj iliskilerini Diizenleme)

olusturulmus pargalar dogrudan degistirilebilir. Montaj, Data Panelde ilgili klasor icindeki pargalar
slrtiklenip montaj ortamina birakilarak olusturulmussa bu parcalar izerinde degisim ancak parcanin
Uzerinde sag tusa basarak Open islemi ile gergeklestirilir. Parga tizerinde yapilan degisiklikler glincellenerek
montaj yenilenmelidir.

Surikle birak ile yerlestirilen parcalar tGzerinde bulunan zincir isaretiyle (Link) parcalarin ayri bir parca
olarakbaglandigianlasiimalidir. Parca, o montaja ait bir parcaya donistirilecekse lizerinde sag tusa basarak
Break Link komutu galistiriimalidir. Bu islem sonrasinda parga, asil parga ile olan iliskisinden kurtulur ve o

montaja ait hale gelir. Uzerinde yapilan degisiklikler artik asil (klasérde kayitli) pargayi etkilemez.

Uygulama: Montaj iliskilerini Diizenleme

e (Cizim alanindan ya da unsur agacindan diizenlenecek parca ya da montaji sag taraftaki daireyi secerek
aktif ediniz.

e Unsur agacinda segilen parc¢a oldugu gibi kalirken aktif parca disindakiler seffaflasir.

e Design sayfasinda galisiyor gibi gerekli ¢izim ve diizenlemeleri yapiniz.

e Parca Uzerinde yapilan degisiklikler unsur agacinda bilesene ait kisma yansir. Kaydetme islemi
yapildiginda ise hem montaja hem de pargaya yansir.

3.6.9. Montaja Akilli Baglanti Elemanlari Ekleme

Add-Ins, firmalar ya da programihazirlayan kurumlar tarafindan olusturulan hazir parca kittiiphanesidir.

Buradan civata gibi standart montaj elemanlari alinip montaja yerlestirilebilir.

Uygulama: Montaja Akilli Baglanti Elemanlari Ekleme

Montaja akilli baglanti elemanlari eklemek icin asagidaki yonergeleri uygulayiniz.

e Tools > Add-Ins ara¢ cubugundan Scripts and Add-Ins seciniz. Ekrana Scripts and Add-Ins diyalog
kutusu gelir.

¢ Eklenecek montaj elemanini seginiz (6rnegin bolt / civata). Run tusuna basiniz.

e Ekrana Create Bolt mensi gelir. Uygun degerleri girerek civata olusturunuz.

e Solid > Insert ara¢ cubugundan firma bilesenlerini seciniz. Ekranda firmanin Grtnleri listelenir.

e Magazadan istenilen Urin segcilir, Griin adedi belirlendikten sonra lcret 6denip Companent siparis
edilebilir.

e Uriini projeye eklemek icin Product Details (Uriin Detayi) baglantisina tiklayarak iiriin detay sayfasina
gidebilirsiniz.

e Urliniin hangi dijital Gretim programiicin indirilecegi belirlendikten sonra Save (Kaydet) tusuna basarak

bileseni projeye ekleyiniz. Bilesen unsur agacinda secili Companent altina eklenir.
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3.6.10. Show / Hidden Components (Montaj iliskilerini Goster / Gizle)

Show / Hidden Components, cok sayida parcadan olusan montajlarda secilen parganin géruntisuni
ekrandan kaldirmaya veya tekrar geri getirmeye yarar. Gergekte nesne montajdan kaldirilmaz, sadece
parcanin ekrandaki gortnirligi kalkar. Show / Hidden Components komutu ile saklanan parcanin
unsur agacindaki gbz semboli siliktir, Gzerinde sola yatik bir gizgi olur. Bu komut ile birden fazla parganin

ekrandaki gorindrltga kaldinlip geri getirilebilir.

Uygulama: Montaj iliskilerini Goster / Gizle

Montaj iliskilerini goster / gizle icin asagidaki yonergeleri uygulayiniz.

e Unsur agacindan parca secildiginde ekrana gelen pencereden Hide Component (Bilesenleri Gizle)
seciniz. Parca ekrandan gizlenir.

e Tekrar gorinir hale getirmek igin unsur agacindan pasif durumda olan pargay! seginiz.

e Acilan pencereden Show Component (Bilesenleri Goster) komutunu seginiz.

Gorsel 3.143: Montaj iliskilerini géstermek / gizlemek
3.6.11. Assembly Features (Montaja Unsur Ekleme)

Assembly Features, parcalar Gzerine bazi nesne unsurlarini eklemek igin kullanilir. Montaj sayfasina
montaj elemanlari eklendigi zaman aktif hale gelir. Montaja eklenen unsurlar parcaya da otomatik olarak

yansir.
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Montaja unsur eklemek igin asagidaki yonergeleri uygulayiniz.

e Unsur agacinda en Ustte yer alan montaj elemanina sag tiklayip New Component isaretleyiniz ya da
Assemble > New Component tiklayiniz. Unsur agacinin sonunda Component adinda yeni bir unsur
olusur.

e Calismaalanindan bir diizlem secerek yeni montaj bileseni olusturunuz. islem sonrasinda diger parcalar
seffaflasir ve calisma yeni parga lizerinde gerceklesir.

3.6.12. Hole Wizard (Delik Sihirbazi)

Hole Wizard, montaj sayfasinda iken montaj
parcalari Gzerinde belirlenen noktalardan hizli delik
agmak i¢in kullanilir. Bu komutla montaj pargalari
Uzerine acilan delikler, parcanin modeline de yansir
ve unsur agacina delik unsuru eklenir. Delme islemi,
montaji olusturan pargalara denk gelirse bu parcala-
rin timinde delik boyu kadar delik acilmis olur.

Gorsel 3.144: Delik sihirbazi ile delik agma

Uygulama: Hole Wizard (Delik Sihirbazi)

Delik sihirbazi icin asagidaki yonergeleri uygulayiniz.

e Create > Hole komutunu seginiz.

e Ekrana gelen menide Placement bolimiinden At Point (Single Hole) secimi yapiniz. Parca Uzerinde
deliklerin agilacagi kati ylizeyi (Face / Point) seciniz.

¢ Hole Type kismindan delik tipini seginiz.

¢ Depth ve Diameter kismindan delik 6l¢ilerini, Tip Angle kismindan da matkap ug agisini giriniz.

e Delik boyu ve yoninu belirleyiniz.

e OKtusuile delme islemini tamamlayiniz.

Uygulama: Delik Dizisi

Delik dizisi icin asagidaki yonergeleri uygulayiniz.

e Create > Hole komutunu seginiz.

e Ekrana gelen meniide Placement boliminden From Sketch (Multiple Hole) secimini yapiniz. Parca
Uzerinde deliklerin acilacagi kati ylizeyi (Face / Point) seciniz ve birden ¢ok delik icin taslaktaki ayrit
veya noktalari sirasiyla seginiz.

¢ Hole Type kismindan delik tipini seginiz.

e Depth ve Diameter kismindan delik 6lgilerini, Tip Angle kismindan da matkap ug agisini giriniz.
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e Delik boyu ve yonini belirleyi-
niz.

e OKtusuile delme islemini
gerceklestiriniz.

Gorsel 3.145: Delik dizisi

3.7. Tasarlanan Modelin Ug¢ Boyutlu Baskisini Alma

Dijital Gretim programinda hazirlanan modellerin baskisi, dilimleme programlari ve i¢ boyutlu yazicilar
aracihgiyla alinabilir.

3.7.1. Slicing (Dilimleme) Programi

Dilimleme programi, belirlenen parametrelere gore modeli katlara bélen ve yazici icin yapacagi her
islemitarif eden bir komut kiimesi olusturur. Bu komutlara G-code adi verilir. G-code temel olarak li¢ boyutlu
yazicinin X-Y-Z koordinatlarini, nozzle (agizlik) sicakligini, tabla sicakligini ve sogutma fani ¢alismasini igerir.
G-code komutlari CNC cihazlar igin standarttir. CNC cihazlarin buyik bélimi G-code komutlari ile gahsir.

Dilimleme yaziiminin olusturdugu G-codelar {i¢ boyutlu yaziciya hafiza karti ya da USB baglantisi
Uzerinden seri iletisimle gonderilir.

Ug boyutlu tasarim (CAD) programlari aracihgiyla cizilen ii¢ boyutlu nesnelerin ti¢ boyutlu yazicilar
tarafindan baski yapabilmesi icin dilimleme programlarinca taninan dosya formatiyla disa aktarilmasi
gereklidir.

Tasarimi Ug boyutlu yaziciya aktarmak icin asagidaki yonergeleri uygulayiniz.

e Dijital Gretim programini aginiz. Daha 6nce olusturdugunuz {i¢ boyutlu MEB yazi nesnesini aginiz.
e File > 3D Print komutunu
aginiz.
e Selection olarak dilimleme
programi igin tim nesneyi
seciniz.
e Preview Mesh secerek
mesh yapisinin gérinmesi-

ni saglayiniz.

Gorsel 3.146: Mesh yapisi goriintlisi

162' 3. OGRENME BIRIMi



DIJITAL URETIM

¢ Refinement olarak baski kalitesine uygun segenegi isaretleyiniz.

¢ Refinement Options kismindan istenirse daha detayl ayarlar yapilabilir.

e Output 6zelliklerinden Send to 3D Utility secenegini kaldiriniz ve .stl uzantili dilimleme programi icin
kaydediniz.

e Bilgisayarinizdabirdilimleme programiyikliyse Send to 3D Utility seceneginikaldirmayiniz. Application

boliminden dilimleme programini secerek dogrudan dilimleme programina gonderebilirsiniz.

3.7.2. Dilimleme Programi Yardimiyla Ug¢ Boyutlu Baski Alma

Kurulum tamamlandiktan sonra model, dilimleme yazilimiile agilarak ti¢ boyutlu yaziciya génderilebilir.

Uygulama: Dilimleme Programi Yardimiyla http://kitap.eba.gov.tr/KodSor. =il
php?KOD=21382

Ug Boyutlu Baski Alma

Dilimleme programi yardimiyla Gg¢ boyutlu baski almak icin asagidaki yonergeleri uygulayiniz.

e Ug boyutlu baskisi alinacak dosyayi aginiz.

e Baski alinacak nesneyi uygun sekilde tablaya yerlestiriniz. Gerekirse nesneyi dondiirme ve tasima
islemi yapabilirsiniz.

e Konfigiirasyon panelinden kullanilacak malzeme (filament) ve renk gibi ayarlari seginiz.

e Yazdirma Ayarlari panelinden baski icin gerekli ayarlari yapiniz.

e Gerekli ayarlari yaptiktan sonra Dilimle diigmesine tiklayiniz.

Gorsel 3.147: Dilimleme yazilimi

e Ug boyutlu yaziciya gdndermek icin G-code dosyasini kaydediniz.

¢ Modele ait G-code dosyasini yazicida ¢alistirarak yazdirma islemini baslatiniz.
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— Olgme ve Degerlendirme

Asagidaki sorulari dikkatle okuyarak dogru segenegi isaretleyiniz.

1. Tasarim gizgisi ¢cizmek icin asagidaki komutlardan hangisi kullanilir?

A) Control Point Spline B) Construction Line C) Spline
D) Fit Spline E) Line

2. Taslak gizim olusturmak igin agagidaki hangi komut kullaniimaktadir?

A) Exit Sketch B) 3D Sketch C) Sketch Xpert
D) Sketch E) Finish Sketch

3. Yatay cizgi ¢cizmek i¢in asagidaki Sketch Palette komutlarindan hangisi kullaniimahdir?

A) As Sketched B) Parallel C) Coincident
D) Vertical / Horizontal E) Angle

4. Asagidakilerden hangisinde Polygon (Cokgen) komutu ile gizilen en az kenar sayisi verilmigtir?

A)3 B) 4 Q)5
D) 6 E) 8

5. Nesne késelerine kavis vermek igin asagidaki hangi komut kullanilir?

A) Fillet B) Ellipse C) Extend
D) Trim E) Chamfer

o

Asagidaki komutlardan hangisi uzantilari kesistirmek igin kullanilir?

A) Trim B) Extend C) Corner
D) Closest E) Node
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7. Nesnelerin yiizeyler ya da diizlemler iizerine izdligiimiiniin alinmasi i¢in asagidaki hangi komut

kullanihr?

A) Intersection B) Offset C) Project
D) Entities E) Chain Selection

8. Asagidaki komutlardan hangisi bir eksen etrafinda dairesel ¢cogaltma yapar?

A) Circular Pattern B) Sketch Pattern C) Linear Pattern
D) Stretch Pattern E) Pattern on Path

9. Asagidaki geometrik iliskilerden hangisi secilen nesneleri es merkezli hale getirir?

A) Collinear B) Concentric C) Coincident

D) Equal E) Parallel

10. Asagidaki nesne kenetleme komutlarindan hangisi secilen 6biir nesneye dik olan noktadan
yakalar?

A) Quadrant B) Nearest C) Perpendicular

D) Intersection E) Tangent

11. Sketch ortaminda olusturdugunuz bir ¢izimi belirli bir eksen etrafinda dondiirerek nesne
olusturmak icin asagidaki komutlardan hangisi kullanilir?

A) Extrude B) Revolve C) Loft
D) Sweep E) Web

12. Farkh diizlemler iizerinde ¢izilmis profiller arasina malzeme atayarak nesne olusturan komut
asagidakilerden hangisidir?

A) Revolve B) Web C) Sweep
D) Extrude E) Loft

3. OGRENME BIRiMi ‘165



13. Nesneleri tagimak icin asagidaki hangi kisayol tusu kullanilir?

A)C B)D oM
D)F E) K

14. Civatanin dislerini olusturmak igin asagidaki komutlardan hangisi kullanilir?

A) Threat ve Coil B) Extrude ve Spline C) Hole
D) Loft ve Cut E) Web ve Rib

15. Circular Pattern komutunun kullanim amaci asagidakilerden hangisidir?

A) Nesnenin dairesel olarak ¢ikariimasi
B) Nesnenin dogrusal olarak ¢ikariimasi
C) Nesnenin dairesel olarak ¢ogaltiimasi
D) Nesnenin dogrusal olarak cogaltiimasi
E) Nesnenin aynalanmasi

16. Payandalar asagidaki hangi komut kullanilarak cizilir?

A) Shell B) Revolve C) Draft
D) Hole E) Rib

17. Belirli bir yol {izerinde ¢izimin siipiriilmesiyle model olugsturmak i¢in kullanilan komut
asagidakilerden hangisidir?

A) Revolve B) Sweep C) Web
D) Loft E) Coil

18. Hole komutunun gorevi asagidakilerden hangisidir?

A) Cizim alani temizler.  B) Nesnelerin ozelliklerini degistirir. ~ C) Cizimleri silerek ortadan kaldirir.

D) Nesnelerin tzerinde delik agar. E) Nesnelere vida disi acar.

19. Yiizeye paralel yeni bir diizlem olusturmak icin hangi komut kullanilir?

A) Point B) Horizantal C) Move
D) Offset Plane E) Split
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20.

21.

22.

23.

24.

25.

DIJITAL URETIM

Yuvarlatma isleminde kullanilan Variable Radius anlami agagidakilerden hangisidir?

A) Degisken yarigapl yuvarlatma B) Degisken pah kirma C)Kavis olusturma

D) Yaricapli yuvarlatma E) Degisken yaricapl vidalama

Montaj sayfasi ve yeni parga olusturulmasi igin programin agilisinda asagida verilen hangi

komutun kullanilmasi gerekir?

A) Motion Link B) New Component C) New
D) Drawing E) Motion Link

Montaj sayfasina klasérdeki bir pargayr eklemek igin asagida verilen hangi islem uygulanmalidir?

A) Edit Component komutu ile par¢a eklenmelidir.

B) Move Component komutu ile parca tasinmalidir.

C) Rotate Component komutu ile parga donustirilmelidir.

D) Data Panelden parga siriiklenerek montaj ortamina birakilmahdir.
E) Govde, Split Body komutu ile pargalara bélinmelidir.

Segilen silindirik parcalari ortak merkezli hale getirmek igin agsagida verilen hangi eslestirme

komutu kullanilir?

A) Cylindirical B) Parallel C) Width

D) Coincident E) Revolute

Asagida verilen parga iliskilendirmelerinden hangisi standart iliskilerden degildir?

A) Revolute B) Rigid C) Cylindirical
D) Pin-Slot E) Width

Asagida verilen gelismis montaj iliskilerinden hangisi ¢coklu pargalara montaj iliskisi

vermek icin kullanihr?

A) Revolute B) Path Mate C) As-Built Joint
D) Angle E) Joint Origin
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26. Asagidaki mekanik montajlardan hangisi silindirik pargalara donme iligkisi verir?

A) Hinge B) Rack Pinion C) Gear

D) Contact Sets E) Revolute

27. Bir eksen etrafinda kiiresel hareket saglayan mafsal gibi pargalari birlestirmek igin hangi yéntem

kullanthr?

A) Ball B) Gear C) Rack Pinion
D) Screw E) Pin

28. Montaj sirasinda parg¢alara montaj iliski merkezi eklemek icin asagidaki hangi komut kullanilir?

A) New Part B) Copy With Mates C) Edit Component
D) Joint Origin E) Motion Study

29. Montaj sayfasindan ¢ikmadan parga ya da bilesenleri diizenlemek icin asagida verilen

komutlardan hangisi kullanilir?

A) Rotate Component B) Linear Component Pattern C) Edit Component

D) Circular Component Pattern E) Revolute Cut

30. Asagidakilerden hangisi Add-Ins kiitiiphanesinde hazir bulunan birlestirme elemanlarini otomatik

olarak montaja ekler?

A) Bill of Materials B) Assembly Features C) Show / Hidden Components
D) Ground E) Script and Add ins

Asagidaki climleleri dikkatle okuyarak bos birakilan yerlere dogru sozciikleri yaziniz.
31. Chamfer komutu nesnelerin ........cccoveevveieneieisecese e icin kullanilir.

32. Draft komutu model lizerinde segilen bir veya birden fazla ylzeye ...

icin kullantlir.
33. Nesneleri hizalamak igin .....cccceeveveereeiieneee komutu kullanilir.
34. Olusturulan bir nesneye et kalinhgi vermek ........ccccoovvevvevevvenennen. komutu kullanilr.
35. Split KOMULU NESNEIETT c.evveeeeee e icin kullanilir.
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1. OGRENME BIRIMI / TEMEL TEKNIK RESIM

1. D Cevabiniz yanls ise Cizgi Cesitleri ve Cizgilerin Kullanildigi Yerler konusunu gézden gegiriniz.

2. C Cevabiniz yanlis ise Teknik Resimde Kullanilan Arag Geregler konusunu gézden gegciriniz.

3. A Cevabiniz yanls ise Standart Yazi Tipleri ve Norm Yazi konusunu gézden gegiriniz.

4. E Cevabiniz yanlis ise Teknik Resimde Kullanilan Arag Geregler konusunu gézden gegciriniz.

5. B Cevabiniz yanlis ise Standart Kagit Olgiileri konusunu gdzden gegiriniz.

6. C Cevabiniz yanlis ise Dogru Cizimi konusunu gézden geciriniz.

7. A Cevabiniz yanlis ise izdiisiim Tanimi ve Siniflandiriimasi konusunu gézden gegiriniz.

8. C Cevabiniz yanlis ise izdiisiim Tanimi ve Siniflandirilmasi konusunu gdzden gegiriniz.

o. D Cevabiniz yanlis ise izdiisiim Tanimi ve Siniflandiriimasi konusunu gézden gegiriniz.

10. E Cevabiniz yanlis ise Noktanin izdiisiimii konusunu gézden geciriniz.

11. A Cevabiniz yanlis ise izdiisiim Diizlemleri konusunu gézden gegiriniz.

12. A Cevabiniz yanlis ise Noktanin izdiisiimii konusunu gézden geciriniz.

13 B Cevabiniz yanlis ise Olgeklendirme konusunu goézden gegiriniz.

14. B Cevabiniz yanlis ise Olgekler konusunu gdzden gegiriniz.

15. | C Cevabiniz yanlis ise Olgekler konusunu gézden gegiriniz.

e | Sira Sizde Cevap Anahtarlar

SiraSizde1l = |
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— I Olgme ve Degerlendirme Cevap Anahtari

T 2. OGRENME BIRIMi / BILGISAYARLI GiziM
1. B Cevabiniz yanlis ise Temel islem Kontrolleri konusunu gézden gegiriniz.
2. B Cevabiniz yanlis ise Gériiniim Kontrolleri konusunu gézden gegiriniz.
3. C Cevabiniz yanlis ise Gériiniim Kontrolleri konusunu gézden gegiriniz.
4. D Cevabiniz yanlis ise Gruplama konusunu gozden gegiriniz.
5. C Cevabiniz yanls ise Hizalama konusunu gézden geciriniz.
6. D Cevabiniz yanlis ise ige Aktar konusunu gézden gegiriniz.
7. D Cevabiniz yanlis ise Diga Aktar konusunu gozden gegciriniz.
8. A Cevabiniz yanlis ise Goriiniim Kontrolleri konusunu gézden gegiriniz.
9 B Cev.a!:n.nlz yanlis ise Ug Boyutlu Yazicilarda Tasarimi Yazdirma konusunu gézden
gegiriniz.
10. C Cev‘a!m.mz yanlis ise Ug Boyutlu Yazicilarda Tasarimi Yazdirma konusunu gdzden
geciriniz.

e | Sira Sizde Cevap Anahtarlari

SiraSizdel RN

‘ikinci Tasarim adinda yeni bir tasarim olusturmak icin asagidaki yonergeleri uygulayiniz.
e Yeni bir tasarim olusturunuz.
e Cizim programinin tasarim i¢in verdigi ismi degistirmek icin tasarim ismini tiklayiniz.

e Tasarimin adini ikinci Tasarim olarak degistiriniz.

éAna sayfaya donerek onceden olusturdugunuz baska bir tasarimi agmak icin asagidaki yonergeleri
izleyiniz.

e Uygulamaniz agikken son tasarimlar digmesine tiklayiniz.
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e stediginiz uygulamayi seginiz ve Bunu diizenle diigmesine tiklayiniz.

ESiIindir Uzerinde temel islemleri yapmak icin asagidaki yonergeleri takip ediniz.
e Yeni bir tasarim olusturunuz.
e Tasarimin adini Sira Sizde 3 olarak degistiriniz.
e Calisma dizlemine bir silindir ekleyiniz.
e Silindirin yiksekligini 15 mm olarak 6l¢eklendiriniz.
e Silindirin ¢apini 35 mm olarak 6lgeklendiriniz.

e Silindiri calisma alaninin sol Gst késesine taslyiniz.
e Silindiri 15 mm yukari kaldiriniz.
e Silindiri 30 derece dondiriniz.
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ECikoIata tasarimini farkh sekillerle yapmak icin asagidaki yonergeleri uygulayiniz.

Yeni bir tasarim olusturunuz.

Tasarimin adini Sira Sizde 4 olarak degistiriniz.

Calisma diizlemine bir kutu ekleyiniz.

Kutunun yiksekligini 5 mm olarak olceklendiriniz.

Kutunun enini ve boyunu 100x100 mm olarak dl¢eklendiriniz.

Calisma diizlemine bir piramit ekleyiniz.

Piramidi 5 mm yikseltiniz.

Piramidin yiksekligini 10 mm olarak 6l¢eklendiriniz.

Piramidi Duplicate and repeat (Ctrl+D) digmesi ile 5 adet yan yana sekilde ¢ogaltiniz.

Piramit sekillerini Gruplandir (Ctrl+G) digmesi ile gruplandiriniz.
e Piramit grubu ile kutu seklini sol alt kosede hizalayiniz.
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e Piramit grubunu Duplicate and repeat (Ctrl+D) diigmesi ile cogaltiniz.

¢ Yeni piramit gruplari ile gikolata zemininin ylzeyini kaplayiniz.

e Butlin sekilleri Gruplandir (Ctrl+G) digmesi ile gruplandiriniz.
e Calisma duzlemine bir kutu ekleyiniz.

e Kutunun enini ve boyunu 100x100 mm olarak 6lgeklendiriniz.
e Kutuyu 10 mm ylkseltiniz.

e Kutunun ozelligini Delik olarak degistiriniz.

e Kutuyu ve sekil grubunu sol alt késeden hizalayiniz.

e Tim sekilleri gruplandiriniz.

e Seklin rengini 6zelliklerden kahverengi olarak degistiriniz.
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Kalemlik tasariminda yildiz sekillerini artirmak icin asagidaki yonergeleri uygulayiniz.
e Kalemlik Yapimi uygulamasini aginiz.
e Yildizlari seginiz ve gruplandiriniz.
¢ Yildiz grubunu ¢ogaltiniz.
e Yeni yildiz grubunu 10 mm yikseltiniz.

e Yildiz grubunu 22,5 derece dondiriiniiz.

e Yildiz grubunu tekrar ¢cogaltiniz.

e Yeniyildiz grubunu 10 mm yikseltiniz.

e Yildiz grubunu 22,5 derece dondiriniz.

e Yildiz grubunu tekrar ¢ogaltiniz.

e Yeniyildiz grubunu 10 mm daha yukseltiniz.
e Yildiz grubunu 22,5 derece dondiriiniiz.

e Yazl lizerine gelen yildizi, yildiz grubunu ¢ozerek tasiyiniz.

e Tim sekilleri gruplandiriniz.
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Piyon tasarimini kale tasina donustirmek icin asagidaki yonergeleri takip ediniz.

Piyon Yapimi tasarimini aginiz.

Piyon tasarimini seginiz ve Kopyala (Ctrl+C) digmesine tiklayiniz.

Son tasarimlar digmesine tiklayiniz ve yeni bir tasarim olusturunuz.

e Tasarimin adini Kale Yapimi olarak degistiriniz.

Yapistir (Ctrl+V) diigmesi ile piyon tasarimini yeni tasarima aktariniz.

Sekli seciniz ve grubu ¢ozlinliz.

En Usteki kire seklini siliniz.

Bir Calisma Diizlemini koninin Ustiine strikleyiniz.

Calisma diizlemine bir silindir ekleyiniz.

Silindirin yiksekligini 10 mm olarak dlgeklendiriniz.

Silindirin capini 12 mm olarak ol¢eklendiriniz.

Calisma diizlemine bir kutu ekleyiniz.
e Kutunun enini ve boyunu 20x3 mm olarak olceklendiriniz.

Kutuyu 8 mm yukseltiniz.

Silindir ve kutuyu merkezden hizalayiniz.
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e Kutuyu gogaltiniz.

e Kutuyu 90 derece dondiriiniz.

¢ Silindir ve kutulari gruplandiriniz.

e Kale bashigini gbvde lzerine tasiyiniz.

e Bir Calisma Diizlemini seklin disinda bir alana sirikleyerek ¢alisma dizlemini orijinal konumuna
getiriniz.

e Tum sekilleri secerek merkezden hizalayiniz.

e Tum sekilleri gruplandiriniz.
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— I Olgme ve Degerlendirme Cevap Anahtari
D e

3. OGRENME BIiRIMi / DIJITAL URETIM

1. E Cevabiniz yanlis ise Taslak Cizim Komutlari konusunu gézden gegiriniz.

2. D Cevabiniz yanls ise Taslak Cizim Komutlari konusunu gézden gegiriniz.

3. D Cevabiniz yanls ise Kisitlamalar konusunu gézden gegiriniz.

4, A Cevabiniz yanlis ise Cokgenler konusunu gézden gegiriniz.

5. A Cevabiniz yanlis ise Fillet konusunu gézden gegiriniz.

6. B Cevabiniz yanlis ise Extend konusunu gézden gegiriniz.

7. C Cevabiniz yanls ise Project konusunu gdzden gegiriniz.

8. A Cevabiniz yanlis ise Cogaltma konusunu gozden gegiriniz.

9. B Cevabiniz yanls ise Kisitlamalar konusunu gézden gegiriniz.

10. C Cevabiniz yanls ise Kisitlamalar konusunu gézden gegiriniz.

11. B Cevabiniz yanlis ise Dondiirerek Nesne Olusturma konusunu gozden gegiriniz.

12. E Cevabiniz yanlis ise Déndiirerek Nesne Olusturma konusunu gézden gegiriniz.

13. C Cevabiniz yanlis ise Profil Nesnelerini Cogaltma konusunu gézden gegiriniz.

14. A Cevabiniz yanlis ise Nesneden Bagka Bir Nesne Cikarma konusunu gdzden gegiriniz.

15. C Cevabiniz yanls ise Profil Nesnelerini Cogaltma konusunu gozden gegiriniz.

16. E Cevabiniz yanls ise Destek Elemani Olusturma konusunu gézden gegiriniz.

17. B Cevabiniz yanlis ise Déndiirerek Nesne Olusturma konusunu gézden gegiriniz.

18. D Cevabiniz yanlis ise Nesneden Baska Bir Nesne Cikarma konusunu gozden gegiriniz.

19. D Cevgplplz yanlis ise Diizenleme Komutlariyla Nesneler Olusturma konusunu gozden
gegiriniz.

20. A Cevgplplz yanlis ise Diizenleme Komutlariyla Nesneler Olusturma konusunu gozden
geciriniz.

21. B Cevabiniz yanlis ise Montajda Yeni Par¢a Olusturma konusunu gbézden gegiriniz.

22. | D Cevabiniz yanlis ise Edit Companent konusunu gdzden gegiriniz.

23. | A Cevabiniz yanls ise Joints konusunu gézden gegiriniz.

24, E Cevabiniz yanlis ise Joints konusunu gézden gegiriniz.

25. | C Cevabiniz yanlis ise As Built Joint konusunu gézden gegiriniz.

26. E Cevabiniz yanlis ise Joints konusunu gézden gegiriniz.

27. A Cevabiniz yanlis ise Joints konusunu gézden gegiriniz.

28. ' D Cevabiniz yanlis ise Joints konusunu gdzden gegiriniz.

29. C Cevabiniz yanls ise Edit Companent konusunu gbzden gegiriniz.

30. E Cev_aplplz yanlis ise Montaja Akilli Baglanti Elemanlari Ekleme konusunu gbézden
gegiriniz.
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kenar ya da
31. | koselerine pah = Cevabiniz yanhs ise Nesneden Bagka Bir Nesne Cikarma konusunu gézden gegiriniz.
kirmak igin
32 istenilen agida | Cevabiniz yanlis ise Diizenleme Komutlariyla Nesneler Olusturma konusunu goézden
* | egim vermek gegiriniz.
33. Align Cevabiniz yanlhs ise Dilizenleme Komutlariyla Nesneler Olusturma konusunu goézden
g gegiriniz.
34. Shell Cevabiniz yanlis ise Diizenleme Komutlariyla Nesneler Olusturma konusunu goézden
gegiriniz.
35. | bolerek Cevabiniz yanlhs ise Diizenleme Komutlariyla Nesneler Olusturma konusunu gozden
parcalara gegiriniz.
ayirmak
i
— I Sira Sizde Cevap Anahtarlari
WO

OICTC R, mmmmmmmmm—m——m—————n———e—e

e XY duzlemde bir taslak olusturunuz.

e -X, =Y eksenleri ve orijinden gecen Construction Line (Yardimci Geometri Cizgisi) ciziniz.

e Orijin noktasini merkez kabul eden ve ¢api 131,2 mm olan bir gember ¢iziniz.

e Orijin noktasi ile yatay dogrultuda (Horizontal / Vertical kisitlamasini kullaniniz.) ve 10 mm solunda
(Sketch Dimension komutunu kullaniniz.), cap1 168,2 mm olan bir cember ciziniz.

e (Cember gizimlerinin sag tarafinda ve ¢emberlerin arasinda kalan bolgeye orijin noktasi ile yatay
dogrultuda, cemberlerile teget, 8,5 mm capinda bir cember ¢iziniz (2-Points Circle komutunu kullanmak
daha islevsel olacaktr.).

e  Orijin noktasinin 185 mm solunda ve orijin ile yatay dogrultuda, ¢aplari sirasiyla 12 mm ve 32 mm olan
es merkezli iki cember ciziniz.

e 3-Point Arc komutunu kullanarak 32 mm ¢apli cember ile 168,2 mm capli cember arasinda, cemberlere
teget, 108 mm yaricapli yay ciziniz.

e 3-Point Arc komutunu kullanarak 32 mm c¢apli cember ile 131,2 mm ¢apli cember arasinda, cemberlere
teget, 145 mm yaricapl yay ciziniz.

e Trim komutu ile gerekli budamalari yapiniz.

e Calismanizi bulut ortaminda kaydediniz ya da File > Export komutu ile istediginiz dizine ¢ikartiniz.
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XY diizlemde bir taslak olusturunuz.

-X, =Y eksenlerinden ve orijinden gecen Construction Line giziniz.

Sol alt kdsesi orijin noktasinda olan 40 mm uzunlugunda, 95 mm genisliginde bir dikdortgen ciziniz.
Cizilen dikdortgenin icine 10 mm uzunlugunda, 75 mm genisliginde bir dikdortgen daha ciziniz.

Cizilen ikinci dikdoértgenin 75 mm’lik uzun kenarinin ilk ¢izilen dikdértgenin 95 mm olan uzun kenarina
uzakhgini Skecth Dimension komutu ile 10 mm olarak ayarlayiniz.

Cizilen ikinci dikdortgenin 10 mm’lik olan kisa kenarlarinin ilk gizilen
dikd6rtgenin 40 mm olan kisa kenarlarina uzakligini Skecth Dimension
komutu ile 10 mm olarak ayarlayiniz.

Blyuk dikdortgenin uzun kenarinin orta noktasindan gececek bicimde
uzunca bir ¢izgi ciziniz ve ¢izgiyi X kisayol tusuna basarak yardimci
geometri haline donlsturiniz.

Bulyk dikdortgenin uzun kenarinin orta noktasindan 20 mm yukarida,
capl 20 mm olan bir cember ¢iziniz.

Blylk dikdortgenin uzun kenarinin orta noktasindan 100 mm
yukarida, ¢capt 40 mm ve 80 mm olan es merkezli iki gember ciziniz.
3-Points Arc komutu ile 20 mm ve 40 mm caph cemberler arasinda,

cemberlere teget ve yarigap 6lglisii 75 mm olan bir yay giziniz.
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e 3-Points Arc komutu ile 80 mm c¢apl,
dikdortgenin sag Ust kosesi arasinda,
cembere teget ve yaricap Olclisi 115 mm
olan bir yay giziniz.

e Mirror komutunu galistiriniz. Aynalanacak
ogeler olarak yay nesnelerini, aynalama
cizgisi olarak buaylk dikdértgenin uzun
kenarinin orta noktasindan gecen kesik
cizgiyi seciniz.

e Trim komutu ile gerekli budamalar
yapiniz.  Baylk  dikdortgenin  uzun
kenarinin alt koselerine Fillet komutu ile
10 mm yaricapinda kavis veriniz.

e Cahsmanizi bulut ortaminda kaydediniz ya

da File > Export komutu ile istediginiz dizine ¢ikartiniz.

e XY dizlemde bir taslak olusturunuz.

e -X, =Y eksenlerinden ve orijinden gecen Construction Line ciziniz.

e Orijin noktasina g¢aplari sirasiyla 30 mm ve 70 mm olan es merkezli iki gember ¢iziniz. Orijin noktasi ile
yatay dogrultuda, orijin noktasinin 92 mm solunda, 50 mm ¢aph bir cember ciziniz.
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e 3-Points Arc komutu ile A ve B noktalarindan gecen ve ¢emberlere teget olan bir yay ¢iziniz. Sketch
Dimension komutu ile yayin yarigap 6l¢tisiinii 92 mm olarak belirleyiniz.

3-Points Arc komutu ile C ve D noktalarindan gecen ve cemberlere teget olan bir yay ciziniz. Sketch
Dimension komutu ile yayin yarigcap Olg¢tisini 185 mm olarak belirleyiniz.

e Trim komutu ile 50 mm ¢apindaki dairenin iceride kalan kismini budayiniz.

e Offset komutu ile igeri dogru 11 mm oteleyerek ¢ogaltma islemini gerceklestiriniz.

e Trim komutu ile gerekli budamalari yapiniz. Fillet komutu ile E ve F noktalarina 6 mm yarigapinda kavis
islemi uygulayiniz.

e Calismanizi bulut ortaminda kaydediniz ya da File > Export komutu ile istediginiz dizine ¢ikartiniz.
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e XY diuzlemde bir taslak olusturunuz.

e -X, =Y eksenlerinden ve orijinden gecen Construction Line giziniz.

e Orijin noktasina gaplari sirasiyla 20 mm ve 48 mm olan iki cember giziniz.

e  Orijin noktasindan 30 mm yukarida ve 21 mm solda bulunan noktada (A noktasi) 20 mm capli cember
giziniz.

e Circle komutunu galistiriniz. Cember ¢izmeden 6nce yakalama dogrulari ile 20 mm g¢apli gemberin alt
noktasinda (B noktasi) 48 mm capl bir gember giziniz.

e Line komutunu calistiriniz. Cizgiyi cizmeden 6nce yakalama dogrulari ile cemberin lzerindeki noktadan
(C noktasi) yukari yonli dik bir ¢izgi ciziniz.

e -Yeksenindekiyardimci geometri gizgisi Gzerinde 90 mm gapli bir gember ¢iziniz. Bu gember ile B noktasi
merkezli, 48 mm ¢apli gemberi Tangent kisitlamasi ile teget hale getiriniz.

e D noktasindan yukari yonli dik bir ¢izgi ciziniz. Cizilen ¢izginin bitis noktasinin orijin noktasina olan
uzakhgini Sketch Dimension komutu ile 83 mm olarak ayarlayiniz.
e Enoktasindan =Y eksenine dik bir ¢izgi ¢iziniz. Yine E noktasindan yukari yonlu dik bir gizgi ¢iziniz. Cizginin

Olglstnd 67 mm olarak ayarlayiniz.
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F noktasindan =Y eksenine, ekseni dik kesecek bicimde bir
cizgi ciziniz. Yine F noktasindan uzunlugu 2 mm, aci degeri 135°
olan bir ¢izgi ciziniz. Cizilen gizginin ucundan =Y eksenine dik
bir gizgi ciziniz.

e Resimde mavi renkle secili olan alan igine ¢api 8 mm
uzunlugunda bir cember ciziniz. Cizilen cemberi, C noktasindan
yukari yonlu cizilen dogru ve merkezi =Y ekseninde olan 90

mm c¢apindaki gember ile teget hale getiriniz.

e G ve H noktalarindan gecen ve cemberlere teget olan bir ¢izgi

giziniz. Gerekli budamalari Trim komutu ile yapiniz.

e  Mirror komutunu calstiriniz. Aynalanacak nesneleri seginiz.
Aynalama dogrusu olarak -Y eksenini seginiz.

e Calismanizi bulut ortaminda kaydediniz ya da File > Export
komutu ile istediginiz dizine ¢ikartiniz.

v

e XY dizlemde bir taslak olusturunuz.

e -X, =Y eksenlerinden ve orijinden gecen Construction Line ciziniz.

e Orijin noktasini merkez kabul eden, ¢aplari sirasiyla 40 mm, 50 mm ve 70 mm olan (¢ ¢ember giziniz.

e Orijin noktasindan baslayarak -Y ekseninde, yukari yonlii, 25 mm uzunlugunda bir ¢izgi ¢iziniz.

e Circular Pattern komutunu calistiriniz. Cogaltilacak nesne olarak 25 mm uzunlugundaki cizgiyi, merkez
nokta olarak da orijin noktasini seciniz. Cogaltma adedini 12 olarak belirleyiniz. Trim komutu ile gerekli

budamalari yapiniz.
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e Orijin noktasinin 46 mm solunda ve 26,80 mm
yukarisinda bulunan noktada 10 mm ve 30 mm
caph iki cember ciziniz.

e .Y ekseni Ustlinde, orijin noktasinin 85 mm
yukarisinda, 22 mm ve 42 mm ¢apl iki cember
gGiziniz.

e Merkezi orijin noktasinda olan 70 mm c¢apli
cemberden, caplari 42 mm ve 30 mm olan
¢emberlere tegetler giziniz.

e 3-Points Arc komutu ile 30 mm ve 42 mm gapli gemberlerin Uzerindeki noktalardan yay giziniz. Yayin
¢emberlere teget olmasini saglayiniz. Sketch Dimension komutu ile yayin yarigap Olgtisiinid 39,70 mm
olarak belirleyiniz.

e Calismanizi bulut ortaminda kaydediniz ya da File > Export komutu ile istediginiz dizine ¢ikartiniz.

SICRTC 0 mmmmmmmmmmmmmmmmmmmmmmmm—m—m—m

e XZ dlzlemine bir Sketch aginiz. Line ve Spline komutlari ile gérseldeki gibi ¢izim yapiniz.
e Offset komutu ile 5 mm iceri ofsetleyiniz.
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Trim komutu ile olusan fazlaliklari kesiniz ve Line komutu ile agik uglari tamamlayarak gizimi bitiriniz.

Finish Sketch komutunu tiklayiniz.

Revolve komutuyla kapali profil olarak ¢izimi ve donis icin gerekli referans eksenini seginiz.
Fincanin agiz kismindaki iki gemberi seginiz ve 2 mm yarigap degerinde Fillet komutu ile yuvarlatiniz.

Ayni islemi fincanin alt kismina da uygulayiniz.

XZ dizleminde yeni bir Sketch olusturunuz. Line ve Spline komutlarini kullanarak tabagi ¢iziniz. Finish

Sketch komutunu tiklayiniz.

Revolve komutu ile fincan tabagi elde ediniz. Fincan tabaginin kenarlarini Fillet komutuyla 1 mm
yarigapinda, alt diizlemine 2 mm yarigapinda yuvarlatiniz.

XZ dizleminde Spline komutuyla gorseldeki gibi egriler ile fincanin kulpunu olusturunuz.

Construct > Plane Tangent to Face At Point komutu ile bir noktadan bir ylize teget olan dizlem

olusturunuz.
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¢ Yeni olusan diizlemin orijin noktasinda 10 mm c¢apinda bir cember ciziniz. Finish Sketch tiklayiniz.

e Sweep komutunu seginiz. Profil olarak 10 mm ¢apli gember, Path olarak cizilen egri, Operation olarak
Join seginiz.

e Fincanin kulpa baglandigi yeri Fillet komutu ile 2 mm yaricapinda yumusatiniz.

e Tasarimi kaydediniz.

''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''

° XY diizlemine Box komutu ile 15,8 mm genisliginde, 31,8 mm uzunlugunda, 9,6 mm yuksekliginde bir

kutu olusturunuz.

Olusturdugunuz kutunun Ust ylizeyine kenardan 3,9 mm uzaklikta, 5 mm capinda, 3,9 mm yiiksekliginde
bir silindir olusturunuz.

e Rectangular Pattern komutunu c¢alistiriniz.
e Pattern Type olarak Bodies seginiz.
e Objects olarak silindirik pargayi seginiz.

e Directions olarak ¢ogaltma yonini seginiz.
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e Distance Type olarak Extent seciniz.
e Quantity ve Distance ayarlari ile 24 mm boyunca yatayda nesnenin 4 adet olmasini saglayiniz.

e Quantity ve Distance ayarlari ile 8 mm boyunca dikeyde nesnenin 2 adet olmasini saglayiniz.

e Direction Type ile cogaltma isleminin yonini belirleyiniz.

OK tusuna basarak islemi tamamlayiniz.

Olusturdugunuz nesneyi kaydediniz.

OICRTC R mmmmmmm—m——————

e XY duzlemine 5 mm ¢apinda, 5 mm yiksekliginde bir silindir olusturunuz.

e Olusturdugunuz silindirin alt ylizeyinde orijin noktalari ayni, 3 mm c¢apinda 70 mm uzunlugunda bir
silindir daha olusturunuz.

e Fillet komutu ile silindirik ylzeylerin kenarlarini ve birlesim noktalarini 0,5 mm yuvarlayiniz.

e Threat komutunu seciniz. Faces olarak dis acilacak silindir ylizeyini seginiz.

e Modeled secenegini tiklayiniz.

¢ Full Length secenegini kaldiriniz ve baslangic noktasi icin Offset olarak 0 mm, dis uzunlugunu belirlemek

icin Length degeri olarak 35 mm giriniz.

Civata basinin Ust ylzeyinde bir Sketch olusturunuz ve yarigapi 2 mm olan bir altigen c¢iziniz. Extrude
komutu ile ice dogru 3,5 mm kesme islemi yaparak civatanin basini altigen alyan anahtara uygun sekilde

olusturunuz.

OICRTC R mmmmmmmmm—m—m————m—m—nn—n—m—,——w———ws

° EXY dizlemde bir taslak olusturunuz.
e -X,-Y eksenlerinden ve orijinden gecen Construction Line ciziniz.
e Center Rectangle komutu ile merkezi orijin noktasinda olan 20 mm ve 90 mm ebatlarinda bir dikdortgen

ciziniz. Kesik ¢izgi Gzerinde ¢ap1i 4 mm ve orijine uzakligl 25 mm olan iki cember ¢iziniz.
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e Extrude komutu ile gembere 3 mm yiikseklik degeri veriniz.

e Ayritlari 3 mm ve 20 mm olan mentese yiizeyinde bir taslak olusturunuz. Nesnenin hemen bitisiginde
sola dogru 3 mm vyiksekliginde ve 1,5 mm genisliginde bir dikdortgen ciziniz. Dikdortgene teget, 3
mm c¢apinda bir cember ve bu cemberle ayni merkezli 2 mm c¢apinda bir cember daha ciziniz. Gerekli

kisitlamalari vererek nesneye Fully Constrained (Tam Cakisik) 6zelligini kazandiriniz.

e Secili dizlemleri Extrude komutuyla mentesenin diger ucuna 90 mm uzatiniz.

e Ust yiizeyde bir taslak ¢izim olusturunuz. Kesme islemi icin gerekli dikdértgenleri, her iki kdseye ayni
mesafe ve uzunlukta olacak bigimde ¢iziniz. Extrude komutu ile dikdértgensel bolgeleri segip asagl
yonde uzatarak kesme islemini gergeklestiriniz. Kesme isleminden sonra size bakan ylizeyleri Offset

Face komutu ile iceri dogru 1,3 mm oteleyiniz.
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e Timeline gizgisini geriye ¢ekiniz.

e Move komutunu calistiriniz. Tasinacak nesneyi Body olarak ayarlayip seginiz. Secilen nesnenin bir
kopyasini olusturmak icin Create Copy secenegini aktif hale getiriniz. Y Distance degerini -23 mm olarak
belirleyiniz.

e Timeline cizgisini ileri dogru uzatarak kopyalama islemini saglayiniz.

e Mentesenin gosterilen ylzeyi Uzerinde Sketch olusturunuz. Project komutunu calistiriniz. Project
paletinde yer alan Geometry nesnesini mentese milinin gececegi cember olarak seginiz.

e Circle komutu ile bir gember giziniz.

e ki cember (kirmizi ve sari renkle gosterilen) arasi mesafeyi Sketch Dimension komutu ile 0,1 mm
olarak belirleyiniz. Extrude komutu ile icteki cembere 90 mm degerinde uzunluk vererek mil nesnesini
olusturunuz.
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e Acikta kalan kisimlari kapatmak icin Sketch ortamina gidiniz. Sketch ortamina girebilmek icin Rectangle
komutunu cahlistiriniz. Dikdértgen ¢izmeden dnce Project komutunu ¢alistiriniz. Selection Filter olarak
Body, Geometry olarak da ortadan gegen mil nesnesini segcerek OK tusuna basiniz. Kapatilacak alani

Rectangle komutu ile giziniz.

e Sketch Dimension komutu ile gizilen dikdértgen ve ylizeyler arasindaki mesafeyi 1 mm olarak belirleyiniz.
Yiizeyleri secerek Extrude komutunu galistiriniz. Opeartion olarak Join seciniz ve mesafeyi 3 mm giriniz.
e Assemble > New Companent komutunu calistiriniz. From Bodies secenegini aktiflestiriniz. Dizayn

sayfasindaki govdeleri secerek OK tusuna basiniz.

e Browser altinda Companentl:1 ve Companent2:1 isminde iki bilesenin yer aldig1 gorilir. Companentl
bilesenini yere sabitlemek icin Ground komutunu c¢alistiriniz.

e Joint komutunu galistiriniz. Motion Type olarak Revolute hareket tiirlinQ seginiz.

e Componentl ve Component2 alanlarini kullanarak montaj nesnelerini seginiz. Secim esnasinda
parcalarin monte edilecegi Joint Origin noktalarini sirasiyla gosteriniz.

e Bilesen, mil etrafinda dondirilecegi icin Joint Origin noktalari milin orta noktasi olarak segcilir. OK
tusuna basarak islem bitirilir.

e Animate komutu cahlstirildiginda dénen nesnenin, sabit nesnenin icinden gectigini gézlemleyiniz. Bu
durumu engellemek icin Browser altinda Joints dalinda bulundan Revl (zerine farenin sag tusu ile
tiklayiniz. Gelen meniden Edit Joint Limits komutunu ¢alistiriniz.

e Hareketin almasini istediginiz en az ve en fazla agi degerlerini giriniz.
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